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1 Filtering, Linear Systems and Transforms Overview

Filter Implementation

In this section...

“Convolution and Filtering” on page 1-2
“Filters and Transfer Functions” on page 1-2
“Filtering with the filter Function” on page 1-3

Convolution and Filtering

The mathematical foundation of filtering is convolution. For a finite impulse response (FIR) filter, the
output y(k) of a filtering operation is the convolution of the input signal x(k) with the impulse
response h(k):

o)

y(k) = E h(Dx(k =1).

I= -

If the input signal is also of finite length, you can implement the filtering operation using the
MATLAB® conv function. For example, to filter a five-sample random vector with a third-order
averaging filter, you can store x(k) in a vector x, h(k) in a vector h, and convolve the two:

randn(5,1);
[11111/4; % A third-order filter has length 4
conv (h,x)

X
h
y

<
1l

.3375
.4213
.6026
.5868
.1030
.3443
.1629
.1787

'
[ocNoNoN SNoNoNoNo)

The length of y is one less than the sum of the lengths of x and h.

Filters and Transfer Functions

The transfer function of a filter is the Z-transform of its impulse response. For an FIR filter, the Z-
transform of the output y, Y(2), is the product of the transfer function and X(z), the Z-transform of the
input x:

Y(2) = H@)X(2) = (h(1) + h(2)z™! + - + h(n + 1)z7")X(2).

The polynomial coefficients h(1), h(2), ..., h(n + 1) correspond to the coefficients of the impulse
response of an nth-order filter.

Note The filter coefficient indices run from 1 to (n + 1), rather than from 0 to n. This reflects the
standard indexing scheme used for MATLAB vectors.
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Filter Implementation

FIR filters are also called all-zero, nonrecursive, or moving-average (MA) filters.

For an infinite impulse response (IIR) filter, the transfer function is not a polynomial, but a rational
function. The Z-transforms of the input and output signals are related by

b(1)+ b2z +...+b(n+1)z7"

V@) =H@X@ = 07 T .t am+ D™

X(2),

where b(i) and a(i) are the filter coefficients. In this case, the order of the filter is the maximum of n
and m. IIR filters with n = 0 are also called all-pole, recursive, or autoregressive (AR) filters. IIR
filters with both n and m greater than zero are also called pole-zero, recursive, or autoregressive
moving-average (ARMA) filters. The acronyms AR, MA, and ARMA are usually applied to filters
associated with filtered stochastic processes.

Filtering with the filter Function

For IIR filters, the filtering operation is described not by a simple convolution, but by a difference
equation that can be found from the transfer-function relation. Assume that a(1) = 1, move the
denominator to the left side, and take the inverse Z-transform to obtain

yk)+aR)yk -1+ ...+am+1)yk —m) =b(1)x(k) + b2)x(k — 1)+~ +b(n+ 1) x(k —n).
In terms of current and past inputs, and past outputs, y(k) is
yk)=b()x(k) +b2)x(k—=1)+ - +bn+ 1) x(k—n)—a2)y(k = 1) = - —a(m+ 1) y(k — m),

which is the standard time-domain representation of a digital filter. Starting with y(1) and assuming a
causal system with zero initial conditions, the representation is equivalent to

y(1) = b(1) x(1)

y(2) = b(1) x(2) + b(2) x(1) — a(2) y(1)

y(3) = b(1) x(3) + b(2) x(2) + b(3) x(1) — a(2) y(2) — a(3) y(1)
y(n) = b(1) x(n) + - + b(n) x(1) —a(2) y(n — 1) = - —a(n) y(1).

To implement this filtering operation, you can use the MATLAB filter function. filter stores the
coefficients in two row vectors, one for the numerator and one for the denominator. For example, to
solve the difference equation

1

y(n) =0.9y(n-1) =x(n) = Y@= WX(Z) = H(2) X(2),
you can use
b =1;
a=1[1 -0.9];
y = filter(b,a,x);

filter gives you as many output samples as there are input samples, that is, the length of y is the
same as the length of x. If the first element of a is not 1, then filter divides the coefficients by a(1)
before implementing the difference equation.
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See Also

Apps
Filter Designer

Functions
conv | designfilt | filter
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The filter Function

The filter Function

filter is implemented as the transposed direct-form II structure, where n-1 is the filter order. This
is a canonical form that has the minimum number of delay elements.

xlm]

bini b3 b2 Hli

R =L Ti—— -l vim]

Ip-Llml z2(m) Ilm

—ain —al3) —al2]

At sample m, filter computes the difference equations

y(m) =b()x(m)+2z;(m-1)
z1(m) = b(2)x(m) + zy(m — 1) — a(2)y(m)

2 - 2(m) = b(n — 1)x(m) + 2, - 1(m = 1) — a(n — 1)y(m)
Zp - 1(m) = b(n)x(m) — a(n)y(m)
In its most basic form, filter initializes the delay outputs 2;(1), i = 1, ..., n-1 to 0. This is equivalent

to assuming both past inputs and outputs are zero. Set the initial delay outputs using a fourth input
parameter to filter, or access the final delay outputs using a second output parameter:

[y,zf] = filter(b,a,x,zi)

Access to initial and final conditions is useful for filtering data in sections, especially if memory
limitations are a consideration. Suppose you have collected data in two segments of 5000 points each:

x1
X2

randn(5000,1); 9% Generate two random data sequences.
randn(5000,1);

Perhaps the first sequence, x1, corresponds to the first 10 minutes of data and the second, x2, to an
additional 10 minutes. The whole sequence is x = [x1;x2]. If there is not sufficient memory to hold
the combined sequence, filter the subsequences x1 and x2 one at a time. To ensure continuity of the
filtered sequences, use the final conditions from x1 as initial conditions to filter x2:

[yl,zf] = filter(b,a,x1);
y2 = filter(b,a,x2,zf);

The filtic function generates initial conditions for filter. filtic computes the delay vector to
make the behavior of the filter reflect past inputs and outputs that you specify. To obtain the same
output delay values zf as above using filtic, use

zf = filtic(b,a,flipud(yl),flipud(x1));

This can be useful when filtering short data sequences, as appropriate initial conditions help reduce
transient startup effects.
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Multirate Filter Bank Implementation

1-6

The upfirdn function alters the sampling rate of a signal by an integer ratio P/Q. It computes the
result of a cascade of three systems that performs the following tasks:

» Upsampling (zero insertion) by integer factor p

* Filtering by FIR filter h

* Downsampling by integer factor q

i) |P FIJ_:IR IQ—'MJ

For example, to change the sample rate of a signal from 44.1 kHz to 48 kHz, we first find the smallest
integer conversion ratio p/q. Set

d = gcd(48000,44100);
p = 48000/d;
g = 44100/d;

In this example, p = 160 and q = 147. Sample rate conversion is then accomplished by typing
y = upfirdn(x,h,p,q)

This cascade of operations is implemented in an efficient manner using polyphase filtering
techniques, and it is a central concept of multirate filtering. Note that the quality of the resampling
result relies on the quality of the FIR filter h.

Filter banks may be implemented using upfirdn by allowing the filter h to be a matrix, with one FIR
filter per column. A signal vector is passed independently through each FIR filter, resulting in a
matrix of output signals.

Other functions that perform multirate filtering (with fixed filter) include resample, interp, and
decimate.



Frequency Domain Filter Implementation

Frequency Domain Filter Implementation

Duality between the time domain and the frequency domain makes it possible to perform any
operation in either domain. Usually one domain or the other is more convenient for a particular
operation, but you can always accomplish a given operation in either domain.

To implement general IIR filtering in the frequency domain, multiply the discrete Fourier transform
(DFT) of the input sequence with the quotient of the DFT of the filter:

n
y

length(x);
ifft(fft(x).*fft(b,n)./fft(a,n));

This computes results that are identical to filter, but with different startup transients (edge
effects). For long sequences, this computation is very inefficient because of the large zero-padded
FFT operations on the filter coefficients, and because the FFT algorithm becomes less efficient as the
number of points n increases.

For FIR filters, however, it is possible to break longer sequences into shorter, computationally
efficient FFT lengths. The function

y = fftfilt(b,x)

uses the overlap add method to filter a long sequence with multiple medium-length FFTs. Its output is
equivalent to filter(b,1,x).
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Anti-Causal, Zero-Phase Filter Implementation

In the case of FIR filters, it is possible to design linear phase filters that, when applied to data (using
filter or conv), simply delay the output by a fixed number of samples. For IIR filters, however, the
phase distortion is usually highly nonlinear. The filtfilt function uses the information in the signal
at points before and after the current point, in essence "looking into the future," to eliminate phase
distortion.

To see how filtfilt does this, recall that if the Z-transform of a real sequence x(n) is X(z), then the
Z-transform of the time-reversed sequence x( — n) is X(z'l). Consider the following processing

scheme:

H(z)

X(2)H(z)

1-8

Time
reversal

X(z7HH(z™)

H(z)

X(z YH(z")H(z)

Time
reversal

- X(2)H(2)H(z")

When |2| = 1, that is z = e/, the output reduces to X(ej‘*’)|H (ej“’)|2. Given all the samples of the
sequence x(n), a doubly filtered version of x that has zero-phase distortion is possible.

For example, a 1-second duration signal sampled at 100 Hz, composed of two sinusoidal components
at 3 Hz and 40 Hz, is

fs = 100;
t =0:1/fs:1;
X =

sin(2*pi*t*3)+.25%sin(2*pi*t*40);

Now create a 6th-order Butterworth lowpass filter to filter out the high-frequency sinusoid. Filter x

using both filter and filtfilt for comparison:

[b,a] = butter(6,20/(fs/2));

y = filtfilt(b,a,x);
yy = filter(b,a,x);

plot(t,x,t,y,t,yy)

legend('Original’', 'filtfilt','filter")



Anti-Causal, Zero-Phase Filter Implementation

1.5 T T T T T T T T T
H E;?inal
f 1 v )
1F II"H.“' I|-1_| [} : filter 4
" 4 | Jh ! 1&31 '."lﬁ EHr
oy ﬁr 0y ! 7 _

Both filtered versions eliminate the 40 Hz sinusoid evident in the original signal. The plot also shows
how filter and filtfilt differ. The filtfilt line is in phase with the original 3 Hz sinusoid,
while the filter line is delayed. The filter line shows a transient at early times. filtfilt
reduces filter startup transients by carefully choosing initial conditions, and by prepending onto the
input sequence a short, reflected piece of the input sequence.

For best results, make sure the sequence you are filtering has length at least three times the filter
order and tapers to zero on both edges.

See Also
conv | filter | filtfilt
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Impulse Response

The impulse response of a digital filter is the output arising from the unit impulse sequence defined
as

om =13 138
You can generate an impulse sequence a number of ways; one straightforward way is
imp = [1; zeros(49,1)1;

The impulse response of the simple filter with b = 1 and a = [1 —-0.9]is h(n) = 0.9", which decays

exponentially.

b=1;

a=1[1-0.9];

h = filter(b,a,imp);

stem(0:49,h)
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A simple way to display the impulse response is with the Filter Visualization Tool, fvtool.

fvtool(b,a)
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Impulse Response

Magnitude {dB)

20
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Click the Impulse Response button, [ | ], on the toolbar, select Analysis > Impulse Response
from the menu, or type the following code to obtain the exponential decay of the single-pole system.

fvtool(b,a, 'Analysis', 'impulse"')
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Impulse Response
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Frequency Response

Frequency Response

In this section...

“Digital Domain” on page 1-13

“Analog Domain” on page 1-18

Digital Domain

freqgz uses an FFT-based algorithm to calculate the Z-transform frequency response of a digital filter.
Specifically, the statement

[h,w] = freqz(b,a,p)
returns the p-point complex frequency response, H(e/®), of the digital filter.

b(1) + bQ2)e™ ¥ + ... + b(n + 1)e~Jwn

He) = Dt ae 4 . + am + e~ Jom

In its simplest form, freqz accepts the filter coefficient vectors b and a, and an integer p specifying
the number of points at which to calculate the frequency response. freqz returns the complex
frequency response in vector h, and the actual frequency points in vector w in rad/s.

freqz can accept other parameters, such as a sampling frequency or a vector of arbitrary frequency
points. The example below finds the 256-point frequency response for a 12th-order Chebyshev Type I
filter. The call to freqz specifies a sampling frequency fs of 1000 Hz:

[b,a]
[h,f]

cheby1(12,0.5,200/500) ;
freqz(b,a,256,1000);

Because the parameter list includes a sampling frequency, freqz returns a vector f that contains the
256 frequency points between 0 and fs/2 used in the frequency response calculation.

Note This toolbox uses the convention that unit frequency is the Nyquist frequency, defined as half
the sampling frequency. The cutoff frequency parameter for all basic filter design functions is
normalized by the Nyquist frequency. For a system with a 1000 Hz sampling frequency, for example,
300 Hz is 300/500 = 0.6. To convert normalized frequency to angular frequency around the unit
circle, multiply by . To convert normalized frequency back to hertz, multiply by half the sample
frequency.

If you call freqz with no output arguments, it plots both magnitude versus frequency and phase
versus frequency. For example, a ninth-order Butterworth lowpass filter with a cutoff frequency of
400 Hz, based on a 2000 Hz sampling frequency, is

[b,a] = butter(9,400/1000);

To calculate the 256-point complex frequency response for this filter, and plot the magnitude and
phase with freqz, use

freqz(b,a,256,2000)
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freqz can also accept a vector of arbitrary frequency points for use in the frequency response
calculation. For example,

w
h

linspace(0,pi);
fregz(b,a,w);

calculates the complex frequency response at the frequency points in w for the filter defined by
vectors b and a. The frequency points can range from 0 to 2m. To specify a frequency vector that
ranges from zero to your sampling frequency, include both the frequency vector and the sampling
frequency value in the parameter list.

These examples show how to compute and display digital frequency responses.
Frequency Response from Transfer Function

Compute and display the magnitude response of the third-order IIR lowpass filter described by the
following transfer function:

. 0.05634(1 +271(1-1.0166271 +272)
H(z) = 1 -1 -2y
(1-0.683271)(1 —1.4461271 +0.7957272)

Express the numerator and denominator as polynomial convolutions. Find the frequency response at
2001 points spanning the complete unit circle.

b0 = 0.05634;

bl = [1 1];

b2 = [1 -1.0166 1];

al = [1 -0.683];

a2 = [1 -1.4461 0.7957];

b = bO*conv(bl,b2);



Frequency Response

a = conv(al,a2);
[h,w] = freqz(b,a, 'whole',2001);
Plot the magnitude response expressed in decibels.

plot(w/pi,20*loglO(abs(h)))

ax = gca;

ax.YLim = [-100 20];

ax.XTick = 0:.5:2;

xlabel('Normalized Frequency (\times\pi rad/sample)')
ylabel('Magnitude (dB)")

Magnitude (dB)
N
=
™~

0 0.5 1 15
Mormalized Frequency (= rad/sample)

Frequency Response of an FIR Bandpass Filter

Design an FIR bandpass filter with passband between 0.35m and 0. 8 rad/sample and 3 dB of ripple.
The first stopband goes from 0 to 0. 1m rad/sample and has an attenuation of 40 dB. The second
stopband goes from 0.9 rad/sample to the Nyquist frequency and has an attenuation of 30 dB.
Compute the frequency response. Plot its magnitude in both linear units and decibels. Highlight the

passband.

sfl = 0.1;
pfl = 0.35;
pf2 = 0.8;
sf2 = 0.9;

pb = linspace(pfl,pf2,1e3)*pi;
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bp = designfilt('bandpassfir’,
'StopbandAttenuationl', 40, 'StopbandFrequencyl’',sfl,...
'PassbandFrequencyl',pfl, 'PassbandRipple’, 3, 'PassbandFrequency2',pf2,
'StopbandFrequency2',sf2, 'StopbandAttenuation2',30);

freqz(bp,1024);

[h,w] =
= freqz(bp,pb);

hpb

subplot(2,1,1)
plot(w/pi,abs(h),pb/pi,abs(hpb),"'.-")

axis([0 1 -1 2])

legend('Response', 'Passband', 'Location', 'South")
ylabel('Magnitude")

subplot(2,1,2)

plot(w/pi,db(h),pb/pi,db(hpb),"'.-")

axis([0 1 -60 10])

xlabel('Normalized Frequency (\times\pi rad/sample)')
ylabel('Magnitude (dB)"')
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Magnitude Response of a Highpass Filter

Design a 3rd-order highpass Butterworth filter having a normalized 3-dB frequency of 0. 5m rad/
sample. Compute its frequency response. Express the magnitude response in decibels and plot it.

[b,a]
[h,w]

butter(3,0.5, 'high');
freqz(b,a);



Frequency Response

dB = mag2db(abs(h));

plot(w/pi,dB)
xlabel('\omega / \pi')
ylabel('Magnitude (dB)")

ylim([-82 5])

Magnitude (dB)
én A o R
= = = =
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L JII i

Repeat the computation using fvtool.

fvtool(b,a)
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Analog Domain

freqgs evaluates frequency response for an analog filter defined by two input coefficient vectors, b
and a. Its operation is similar to that of freqz; you can specify a number of frequency points to use,
supply a vector of arbitrary frequency points, and plot the magnitude and phase response of the filter.
This example shows how to compute and display analog frequency responses.

Comparison of Analog IIR Lowpass Filters

Design a Sth-order analog Butterworth lowpass filter with a cutoff frequency of 2 GHz. Multiply by 2
to convert the frequency to radians per second. Compute the frequency response of the filter at 4096
points.

n 5;

f 2e9;

[zb,pb,kb] = butter(n,2*pi*f,'s");
[bb,ab] = zp2tf(zb,pb,kb);

[hb,wb] = freqs(bb,ab,4096);

Design a 5th-order Chebyshev Type I filter with the same edge frequency and 3 dB of passhand
ripple. Compute its frequency response.

[z1,pl,k1] = chebyl(n,3,2*pi*f,'s"');
[bl,al] = zp2tf(zl,pl,kl);
[h1,wl] = freqs(bl,al,4096);



Frequency Response

Design a 5th-order Chebyshev Type II filter with the same edge frequency and 30 dB of stopband
attenuation. Compute its frequency response.

[z2,p2,k2] = cheby2(n,30,2*pi*f,'s");
[b2,a2] = zp2tf(z2,p2,k2);
[h2,w2] = freqs(b2,a2,4096);

Design a bth-order elliptic filter with the same edge frequency, 3 dB of passband ripple, and 30 dB of
stopband attenuation. Compute its frequency response.

[ze,pe,ke] = ellip(n,3,30,2*¥pi*f,'s");
[be,ae] = zp2tf(ze,pe,ke);
[he,we] = freqs(be,ae,4096);

Plot the attenuation in decibels. Express the frequency in gigahertz. Compare the filters.

plot(wb/(2e9*pi),mag2db(abs(hb)))
hold on
plot(wl/(2e9*pi),mag2db(abs(hl)))
plot(w2/(2e9*pi),mag2db(abs(h2)))
plot(we/(2e9*pi),mag2db(abs(he)))

axis([0 4 -40 5])

grid

xlabel('Frequency (GHz)")
ylabel('Attenuation (dB)")
legend('butter', 'chebyl', 'cheby2','ellip")

butter
cheby1 | 4

) _“'_ﬂ'-.',_---__ ’-—-T a— _q/.
; M?‘_--_—,.;_ _#__.-“‘fx_\_h__ B\ \ cheby?

Attenuation (dB)
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Frequency (GHz)
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The Butterworth and Chebyshev Type II filters have flat passbands and wide transition bands. The
Chebyshev Type I and elliptic filters roll off faster but have passband ripple. The frequency input to
the Chebyshev Type II design function sets the beginning of the stopband rather than the end of the
passband.
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Phase Response

MATLAB® functions are available to extract the phase response of a filter. Given a frequency
response, the function abs returns the magnitude and angle returns the phase angle in radians. To
view the magnitude and phase of a Butterworth filter using fvtool:

d = designfilt('lowpassiir','FilterOrder"',9,
'HalfPowerFrequency',400, 'SampleRate',2000);
fvtool(d, 'Analysis', 'freq")

Magnitude Response (dB) and Phase Response EIM @ QG
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\
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| | | | | | | 1 1
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Frequency (Hz)

You can also click the Magnitude and Phase Response button on the toolbar or select Analysis >
Magnitude and Phase Response to display the plot.

The unwrap function is also useful in frequency analysis. unwrap unwraps the phase to make it
continuous across 360° phase discontinuities by adding multiples of £360°, as needed. To see how
unwrap is useful, design a 25th-order lowpass FIR filter:

h = firl(25,0.4);
Obtain the frequency response with freqz and plot the phase in degrees:
[H,f] = freqz(h,1,512,2);

plot(f,angle(H)*180/pi)
grid
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It is difficult to distinguish the 360° jumps (an artifact of the arctangent function inside angle) from
the 180° jumps that signify zeros in the frequency response.

unwrap eliminates the 360° jumps:

plot(f,unwrap(angle(H))*180/pi)
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Alternatively, you can use phasez to see the unwrapped phase:

phasez(h,1)
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Phase Response
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See Also
abs | angle | freqz | FVTool | phasez | unwrap
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Group Delay and Phase Delay

The group delay of a filter is a measure of the average time delay of the filter as a function of
frequency. The group delay is defined as the negative first derivative of the filter's phase response. If

the complex frequency response of a filter is H (ej“’), then the group delay is

de
To(0) = ~ G

where 6(w) is the phase, or argument, of H (ej‘*’). Use the grpdelay function to compute group delay

of a filter. For example, verify that, for a linear-phase FIR filter, the group delay is one-half the filter
order.

fs = 2000;
b = firl(20,200/(fs/2));

islinphase(b)
ans = logical

1

grpdelay(b,1,[1,fs)

11 T T T T T T T T T

Group delay (samples)
© © ©»
R =] [=i] =

0
(%
T
1

100 200 300 400 500 600 700 BOO 900 1000
Frequency (Hz)
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=

The phase delay of a filter is defined as the negative of the phase divided by the frequency:
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Use the phasedelay function to compute the phase delay of a filter. For the linear-phase FIR filter of
the previous example, the phase delay is equal to the group delay.

phasedelay(b,1,[]1,fs)

0.0314159265359 T T r .
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0.0314159265359 ]

0.0314159265359 ]

0.0314159265359 ]

0.0314159265359 T ]
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Frequency (Hz)

Plot the group delay and the phase delay of a fifth-order Butterworth lowpass filter.
[b,a] = butter(5,200/(fs/2));

grpdelay(b,a, [],fs)
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phasedelay(b,a,[],fs)
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See Also
FVTool | grpdelay | phasedelay
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Zero-Pole Analysis

The zplane function plots poles and zeros of a linear system. For example, a simple filter with a zero
at -1/2 and a complex pole pair at 0.9e~/210-3 and 0. 92703 g

zer
pol

-0.5;
0.9*exp(j*2*pi*[-0.3 0.31");

To view the pole-zero plot for this filter you can use zplane. Supply column vector arguments when
the system is in pole-zero form.

zplane(zer,pol)

0.6 : e |

0.4 F _ ]

Imaginary Part

Real Part

For access to additional tools, use fvtool. First convert the poles and zeros to transfer function
form, then call fvtool.

[b,a]l = zp2tf(zer,pol,k1);
fvtool(b,a)
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Click the Pole/Zero Plot toolbar button, select Analysis > Pole/Zero Plot from the menu, or type
the following code to see the plot.

fvtool(b,a, 'Analysis', 'polezero')
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To use zplane for a system in transfer function form, supply row vector arguments. In this case,
zplane finds the roots of the numerator and denominator using the roots function and plots the
resulting zeros and poles.

zplane(b,a)
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See “Discrete-Time System Models” on page 1-33 for details on zero-pole and transfer function
representation of systems.

See Also
FVTool | zplane | zp2tf
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Discrete-Time System Models

The discrete-time system models are representational schemes for digital filters. The MATLAB
technical computing environment supports several discrete-time system models, which are described
in the following sections:

* “Transfer Function” on page 1-33

» “Zero-Pole-Gain” on page 1-33

* “State Space” on page 1-34

» “Partial Fraction Expansion (Residue Form)” on page 1-34

* “Second-Order Sections (SOS)” on page 1-35

* “Lattice Structure” on page 1-36

* “Convolution Matrix” on page 1-37

Transfer Function

The transfer function is a basic Z-domain representation of a digital filter, expressing the filter as a
ratio of two polynomials. It is the principal discrete-time model for this toolbox. The transfer function
model description for the Z-transform of a digital filter's difference equation is

b(1)+b2)z" 1+ ...+ b(n+ 1)z
al)+a)z" + ... +am+ 1)z™m

Y(2) = X(2).

Here, the constants b(i) and a(i) are the filter coefficients, and the order of the filter is the maximum
of n and m. In the MATLAB environment, you store these coefficients in two vectors (row vectors by
convention), one row vector for the numerator and one for the denominator. See “Filters and Transfer
Functions” on page 1-2 for more details on the transfer function form.

Zero-Pole-Gain
The factored or zero-pole-gain form of a transfer function is

_q (z = q(1))(z = q(2))...(z = q(n))
H@ = 5% = e pMz = pQ)..z = p()

By convention, polynomial coefficients are stored in row vectors and polynomial roots in column
vectors. In zero-pole-gain form, therefore, the zero and pole locations for the numerator and
denominator of a transfer function reside in column vectors. The factored transfer function gain k is a
MATLAB scalar.

The poly and roots functions convert between polynomial and zero-pole-gain representations. For
example, a simple IIR filter is

b
a

[2 3 4];
[1331];

The zeros and poles of this filter are

roots(b)
roots(a)

q
p
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1-34

% Gain factor
k = b(1)/a(1)

Returning to the original polynomials,

bb
aa

k*poly(q)
poly(p)

Note that b and a in this case represent the transfer function:

Hiz) = 243271 +4272 2222+ 3z+4)
(2) = T.2,22,3 3113,2 :
1+327 " +327“+2 22+ 32+ 32+1

Forb = [2 3 4], the roots function misses the zero for z equal to 0. In fact, the function misses
poles and zeros for z equal to 0 whenever the input transfer function has more poles than zeros, or
vice versa. This is acceptable in most cases. To circumvent the problem, however, simply append
zeros to make the vectors the same length before using the roots function; for example, b = [b 0].

State Space

It is always possible to represent a digital filter, or a system of difference equations, as a set of first-
order difference equations. In matrix or state-space form, you can write the equations as

x(n+ 1) = Ax(n) + Bu(n)
y(n) = Cx(n) + Du(n),

where u is the input, x is the state vector, and y is the output. For single-channel systems, A is an m-
by-m matrix where m is the order of the filter, B is a column vector, C is a row vector, and D is a scalar.
State-space notation is especially convenient for multichannel systems where input u and output y
become vectors, and B, C, and D become matrices.

State-space representation extends easily to the MATLAB environment. A, B, C, and D are rectangular
arrays; MATLAB functions treat them as individual variables.

Taking the Z-transform of the state-space equations and combining them shows the equivalence of
state-space and transfer function forms:

Y(2) = H(z)U(z), where H(z) = C(zI — A) "B + D

Don't be concerned if you are not familiar with the state-space representation of linear systems. Some
of the filter design algorithms use state-space form internally but do not require any knowledge of
state-space concepts to use them successfully. If your applications use state-space based signal
processing extensively, however, see the Control System Toolbox™ product for a comprehensive
library of state-space tools.

Partial Fraction Expansion (Residue Form)

Each transfer function also has a corresponding partial fraction expansion or residue form
representation, given by

b(2) r(1)

= -1 -1 — —-(m-n)
a(z) 1 - p(l)z‘l t. 1-— p(n)z‘l +k(M)+kR)z*+...+kim-n+ 1)z
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provided H(z) has no repeated poles. Here, n is the degree of the denominator polynomial of the
rational transfer function b(z)/a(z). If r is a pole of multiplicity s,, then H(z) has terms of the form:

r(j) - r(j+1) + r(j+sr—1)
1-p()z

A-p(z )’ (1= pGz )"

The Signal Processing Toolbox residuez function in converts transfer functions to and from the
partial fraction expansion form. The “z” on the end of residuez stands for z-domain, or discrete
domain. residuez returns the poles in a column vector p, the residues corresponding to the poles in
a column vector r, and any improper part of the original transfer function in a row vector k.
residuez determines that two poles are the same if the magnitude of their difference is smaller than
0.1 percent of either of the poles' magnitudes.

Partial fraction expansion arises in signal processing as one method of finding the inverse Z-
transform of a transfer function. For example, the partial fraction expansion of

-4 487!
H(z) =
@) 1+6271+8272
is
b=1[-48];
a=1[16 8];

[r,p,k] = residuez(b,a)

which corresponds to

-12 8
H(z) =
@) 1+4271  1+2271

To find the inverse Z-transform of H(2), find the sum of the inverse Z-transforms of the two addends of
H(z), giving the causal impulse response:

h(n) = -12(-4)"+8(-2)", n=0,1,2,...
To verify this in the MATLAB environment, type
imp =[100 0 0];
resptf = filter(b,a,imp)

respres = filter(r(1),[1 -p(1)],imp)+...
filter(r(2),[1 -p(2)],imp)

Second-Order Sections (SOS)

Any transfer function H(z) has a second-order sections representation

L L b b -1 b -2

0k T D1xkZ ~ + DkZ
H(z) = [] Hxz) = — —
k=1 k=10aok Tt q1xkz =+ axz

where L is the number of second-order sections that describe the system. The MATLAB environment
represents the second-order section form of a discrete-time system as an L-by-6 array sos. Each row
of sos contains a single second-order section, where the row elements are the three numerator and

three denominator coefficients that describe the second-order section.
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bo1 b11 b21 ap1 a1 ax;
bo2 b12 b2z apz a1z ax
SOS = . . . . . .
bor b1L bar aor @11 azr
There are many ways to represent a filter in second-order section form. Through careful pairing of
the pole and zero pairs, ordering of the sections in the cascade, and multiplicative scaling of the
sections, it is possible to reduce quantization noise gain and avoid overflow in some fixed-point filter

implementations. The functions zp2so0s and ss2s0s, described in “Linear System Transformations”
on page 1-40, perform pole-zero pairing, section scaling, and section ordering.

Note All Signal Processing Toolbox second-order section transformations apply only to digital filters.

Lattice Structure

For a discrete Nth order all-pole or all-zero filter described by the polynomial coefficients a(n),
n=1,2,.., N+1, there are N corresponding lattice structure coefficients k(n), n = 1, 2, ..., N. The
parameters k(n) are also called the reflection coefficients of the filter. Given these reflection
coefficients, you can implement a discrete filter as shown below.

o wmi Minimum- phase

Mazimum-phasz autput

—ie- ) .ﬁ,”-l]lilb I:IUTIJUT

Allpess autput

ITR Lattice Filter

FIR and IIR Lattice Filter structure diagrams

For a general pole-zero IIR filter described by polynomial coefficients a and b, there are both lattice
coefficients k(n) for the denominator a and ladder coefficients v(n) for the numerator b. The lattice/
ladder filter may be implemented as
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i)

vil1)

o ARMA autput

Diagram of lattice/ladder filter

The toolbox function tf2latc accepts an FIR or IIR filter in polynomial form and returns the
corresponding reflection coefficients. An example FIR filter in polynomial form is

b =1[1.0000 0.6149 0.9899 0.0000 0.0031 -0.0082];
This filter's lattice (reflection coefficient) representation is
k = tf2latc(b)

For IIR filters, the magnitude of the reflection coefficients provides an easy stability check. If all the
reflection coefficients corresponding to a polynomial have magnitude less than 1, all of that
polynomial's roots are inside the unit circle. For example, consider an IIR filter with numerator
polynomial b from above and denominator polynomial:

a=[11/2 1/3];

The filter's lattice representation is

[k,v] = tf2latc(b,a);

Because abs (k) < 1 for all reflection coefficients in k, the filter is stable.

The function latc2tf calculates the polynomial coefficients for a filter from its lattice (reflection)
coefficients. Given the reflection coefficient vector k, the corresponding polynomial form is

b = latc2tf(k);
The lattice or lattice/ladder coefficients can be used to implement the filter using the function

latcfilt.

Convolution Matrix

In signal processing, convolving two vectors or matrices is equivalent to filtering one of the input
operands by the other. This relationship permits the representation of a digital filter as a convolution
matrix.

Given any vector, the toolbox function convmtx generates a matrix whose inner product with another
vector is equivalent to the convolution of the two vectors. The generated matrix represents a digital
filter that you can apply to any vector of appropriate length; the inner dimension of the operands
must agree to compute the inner product.

The convolution matrix for a vector b, representing the numerator coefficients for a digital filter, is
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b=1[12 3];
X = randn(3,1);
C = convmtx(b',k3);

Two equivalent ways to convolve b with x are as follows.

C*x;
conv(b,x);

yl
y2
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Continuous-Time System Models

The continuous-time system models are representational schemes for analog filters. Many of the
discrete-time system models described earlier are also appropriate for the representation of
continuous-time systems:
» State-space form
» Partial fraction expansion
* Transfer function
» Zero-pole-gain form
It is possible to represent any system of linear time-invariant differential equations as a set of first-
order differential equations. In matrix or state-space form, you can express the equations as

x = Ax + Bu

y=Cx+Du

where u is a vector of nu inputs, x is an nx-element state vector, and y is a vector of ny outputs. In the
MATLAB environment, A, B, C, and D are stored in separate rectangular arrays.

An equivalent representation of the state-space system is the Laplace transform transfer function
description

H(s)=C(sI-A)"'B+D
For single-input, single-output systems, this form is given by

b(s) _ b(1)s"+b()s" 1+ ... +b(n+1)
ais)  a)sm+a)s™ " +..+am+1)

Given the coefficients of a Laplace transform transfer function, residue determines the partial
fraction expansion of the system. See the description of residue for details.

The factored zero-pole-gain form is

2(1))(s = 2(2))...(s = z(n))
p(1)(s = p(2))...(s = p(m))

As in the discrete-time case, the MATLAB environment stores polynomial coefficients in row vectors
in descending powers of s. It stores polynomial roots, or zeros and poles, in column vectors.

_zs) _, (s—
Hs) = 55y = ks =
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Linear System Transformations

A number of Signal Processing Toolbox functions are provided to convert between the various linear
system models. You can use the following chart to find an appropriate transfer function: find the row
of the model to convert from on the left side of the chart and the column of the model to convert to on
the top of the chart and read the function name(s) at the intersection of the row and column. Note
that some cells of this table are empty.

To - Transfer State- |Zero- Pole- |Partial Lattice Second- Convolution
Function |Space |Gain Fraction Filter Order Matrix

From | Sections

Transfer tf2ss [tf2zp residuez tf2latc |tf2sos convmtx

Function roots

State-Space |ss2tf ss2zp none none $52S0S none

Zero-Pole- zp2tf poly|zp2ss none none Zp2s0s none

Gain

Partial residuez |none none none none none

Fraction

Lattice Filter |[latc2tf none none none none none

SOS sos2tf 505255 |50S2zp none none none

1-40

Note Converting from one filter structure or model to another may produce a result with different
characteristics than the original. This is due to the computer's finite-precision arithmetic and the
variations in the conversion's round-off computations.

Many of the toolbox filter design functions use these functions internally. For example, the zp2ss
function converts the poles and zeros of an analog prototype into the state-space form required for
creation of a Butterworth, Chebysheyv, or elliptic filter. Once in state-space form, the filter design
function performs any required frequency transformation, that is, it transforms the initial lowpass
design into a bandpass, highpass, or bandstop filter, or a lowpass filter with the desired cutoff
frequency.

Note All Signal Processing Toolbox second-order section transformations apply only to digital filters.
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Discrete Fourier Transform

The discrete Fourier transform, or DFT, is the primary tool of digital signal processing. The
foundation of the product is the fast Fourier transform (FFT), a method for computing the DFT with
reduced execution time. Many of the toolbox functions (including Z-domain frequency response,
spectrum and cepstrum analysis, and some filter design and implementation functions) incorporate
the FFT.

The MATLAB® environment provides the functions fft and ifft to compute the discrete Fourier
transform and its inverse, respectively. For the input sequence x and its transformed version X (the
discrete-time Fourier transform at equally spaced frequencies around the unit circle), the two
functions implement the relationships

N-1
Xk+1) =S xn+ WK
n=0

and
x(n+1) 2 X(k +1)W

In these equations, the series subscripts begin with 1 instead of 0 because of the MATLAB vector
indexing scheme, and

Wy = e~ J20N.

Note The MATLAB convention is to use a negative j for the fft function. This is an engineering
convention; physics and pure mathematics typically use a positive j.

fft, with a single input argument, x, computes the DFT of the input vector or matrix. If X is a vector,
fft computes the DFT of the vector; if x is a rectangular array, fft computes the DFT of each array
column.

For example, create a time vector and signal:

t
X

0:1/100:10-1/100;
sin(2*pi*15*t) + sin(2*pi*40*t);

% Time vector
% Signal

Compute the DFT of the signal and the magnitude and phase of the transformed sequence. Decrease
round-off error when computing the phase by setting small-magnitude transform values to zero.

y = fft(x); % Compute DFT of x
m = abs(y); % Magnitude
y(m<le-6) = 0;

p = unwrap(angle(y)); % Phase

To plot the magnitude and phase in degrees, type the following commands:
f = (0:length(y)-1)*100/1length(y); % Frequency vector
subplot(2,1,1)

plot(f,m)

title('Magnitude')
= gca;
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ax.XTick = [15 40 60 85];

subplot(2,1,2)
plot(f,p*180/pi)
title('Phase’)

ax = gca;

ax.XTick = [15 40 60 85];
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A second argument to fft specifies a number of points n for the transform, representing DFT length:

512;

fft(x,n);

abs(y);

unwrap (angle(y));
(0:length(y)-1)*100/1length(y);

T 3 S5
I nn

subplot(2,1,1)

plot(f,m)
title('Magnitude')

ax = gca;

ax.XTick = [15 40 60 85];

subplot(2,1,2)
plot(f,p*180/pi)
title('Phase')

ax = gca;

ax.XTick = [15 40 60 85];
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In this case, fft pads the input sequence with zeros if it is shorter than n, or truncates the sequence
if it is longer than n. If n is not specified, it defaults to the length of the input sequence. Execution
time for fft depends on the length, n, of the DFT it performs; see the fft reference page for details
about the algorithm.

Note The resulting FFT amplitude is A*n/2, where A is the original amplitude and n is the number
of FFT points. This is true only if the number of FFT points is greater than or equal to the number of
data samples. If the number of FFT points is less, the FFT amplitude is lower than the original
amplitude by the above amount.

The inverse discrete Fourier transform function ifft also accepts an input sequence and, optionally,
the number of desired points for the transform. Try the example below; the original sequence x and
the reconstructed sequence are identical (within rounding error).

t
X

y

0:1/255:1;
sin(2*pi*120*t);
real (ifft(fft(x)));

figure
plot(t,x-y)
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This toolbox also includes functions for the two-dimensional FFT and its inverse, fft2 and i fft2.
These functions are useful for two-dimensional signal or image processing. The goertzel function,
which is another algorithm to compute the DFT, also is included in the toolbox. This function is
efficient for computing the DFT of a portion of a long signal.

It is sometimes convenient to rearrange the output of the fft or fft2 function so the zero frequency
component is at the center of the sequence. The function fftshift moves the zero frequency
component to the center of a vector or matrix.

See Also
fft| fft2 | fftshift |goertzel |ifft|ifft2
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Filter Requirements and Specification

2-2

Filter design is the process of creating the filter coefficients to meet specific filtering requirements.
Filter implementation involves choosing and applying a particular filter structure to those
coefficients. Only after both design and implementation have been performed can data be filtered.
The following chapter describes filter design and implementation in Signal Processing Toolbox™
software.

The goal of filter design is to perform frequency dependent alteration of a data sequence. A possible
requirement might be to remove noise above 200 Hz from a data sequence sampled at 1000 Hz. A
more rigorous specification might call for a specific amount of passband ripple, stopband attenuation,
or transition width. A very precise specification could ask to achieve the performance goals with the
minimum filter order, or it could call for an arbitrary magnitude shape, or it might require an FIR
filter. Filter design methods differ primarily in how performance is specified.

To design a filter, the Signal Processing Toolbox software offers two approaches. The first approach
uses the designfilt function. As an example, design and implement a 5th-order lowpass
Butterworth filter with a 3-dB frequency of 200 Hz. Assume a sample rate of 1 kHz. Apply the filter to
input data.

Fs 1000;

fc 200;

time = 0:1/Fs:1;

X = CcoS(2*pi*60*time)+sin(2*pi*120*time)+randn(size(time));

d = designfilt('lowpassiir','FilterOrder',5,
'HalfPowerFrequency', fc, 'DesignMethod', 'butter’,
'SampleRate',Fs);

yd = filter(d,x);

The other approach implements the filter using a function such as butter or firpm. All of these
"classic" filter design functions operate with normalized frequencies. Convert frequency
specifications in Hz to normalized frequency to use these functions. The Signal Processing Toolbox
software defines normalized frequency to be in the closed interval [0,1], with 1 denoting  rad/
sample. For example, to specify a normalized frequency of rr/2 rad/sample, enter 0.5.

To convert from Hz to normalized frequency, multiply the frequency in Hz by two and divide by the
sampling frequency. For example, design a 5th-order lowpass Butterworth filter with a 3-dB frequency
of 200 Hz using butter.

Wn = fc/(Fs/2);

[b,a]l] = butter(5,Wn, 'low');
yb = filter(b,a,x);

Plot the two filtered signals.

plot(time,yd, time,yb)
legend('designfilt', 'butter')
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designfilt
butter

See Also
butter|designfilt | filter
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In this section...

“IIR vs. FIR Filters” on page 2-4

“Classical IIR Filters” on page 2-4

“Other IIR Filters” on page 2-4

“IIR Filter Method Summary” on page 2-4

“Classical IIR Filter Design Using Analog Prototyping” on page 2-5

“Comparison of Classical IIR Filter Types” on page 2-7

IIR vs. FIR Filters

The primary advantage of IIR filters over FIR filters is that they typically meet a given set of
specifications with a much lower filter order than a corresponding FIR filter. Although IIR filters have
nonlinear phase, data processing within MATLAB software is commonly performed “offline,” that is,
the entire data sequence is available prior to filtering. This allows for a noncausal, zero-phase
filtering approach (via the filtfilt function), which eliminates the nonlinear phase distortion of an
IIR filter.

Classical IIR Filters

The classical IIR filters, Butterworth, Chebyshev Types I and II, elliptic, and Bessel, all approximate
the ideal “brick wall” filter in different ways.

This toolbox provides functions to create all these types of classical IIR filters in both the analog and
digital domains (except Bessel, for which only the analog case is supported), and in lowpass,
highpass, bandpass, and bandstop configurations. For most filter types, you can also find the lowest
filter order that fits a given filter specification in terms of passband and stopband attenuation, and
transition width(s).

Other IIR Filters

The direct filter design function yulewalk finds a filter with magnitude response approximating a
specified frequency-response function. This is one way to create a multiband bandpass filter.

You can also use the parametric modeling or system identification functions to design IIR filters.
These functions are discussed in “Parametric Modeling” on page 8-18.

The generalized Butterworth design function maxflat is discussed in the section “Generalized
Butterworth Filter Design” on page 2-14.

lIR Filter Method Summary

The following table summarizes the various filter methods in the toolbox and lists the functions
available to implement these methods.
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Toolbox Filters Methods and Available Functions

Filter Method

Description

Filter Functions

Analog Prototyping

Using the poles and zeros of a
classical lowpass prototype filter in
the continuous (Laplace) domain,
obtain a digital filter through
frequency transformation and filter
discretization.

Complete design functions: besself, butter,
chebyl, cheby2, ellip

Order estimation functions: buttord, cheblord,
cheb2ord, ellipord

Lowpass analog prototype functions: besselap,
buttap, cheblap, cheb2ap, ellipap

Frequency transformation functions: 1p2bp,
1p2bs, 1p2hp, 1p21lp

Filter discretization functions: bilinear,
impinvar

Direct Design Design digital filter directly in the yulewalk
discrete time-domain by
approximating a piecewise linear
magnitude response.
Generalized Design lowpass Butterworth filters maxflat
Butterworth Design [with more zeros than poles.
Parametric Find a digital filter that approximates |Time-domain modeling functions: lpc, prony,
Modeling a prescribed time or frequency stmcb

domain response. (See System
Identification Toolbox™
documentation for an extensive
collection of parametric modeling
tools.)

Frequency-domain modeling functions:
invfreqs, invfreqz

Classical IIR Filter Design Using Analog Prototyping

The principal IIR digital filter design technique this toolbox provides is based on the conversion of
classical lowpass analog filters to their digital equivalents. The following sections describe how to
design filters and summarize the characteristics of the supported filter types. See “Special Topics in
IIR Filter Design” on page 2-33 for detailed steps on the filter design process.

Complete Classical IIR Filter Design

You can easily create a filter of any order with a lowpass, highpass, bandpass, or bandstop
configuration using the filter design functions.

2-5
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Filter Design Functions

Filter Type Design Function

Bessel (analog only) [b,a] = besself(n,Wn,options)
[z,p,k] = besself(n,Wn,options)
[A,B,C,D] = besself(n,Wn,options)

Butterworth [b,a] = butter(n,Wn,options)
[z,p,k] = butter(n,Wn,options)

[A,B,C,D] = butter(n,Wn,options)

Chebyshev Type I [b,a] = chebyl(n,Rp,Wn,options)
[z,p,k] = chebyl(n,Rp,Wn,options)
[A,B,C,D] = chebyl(n,Rp,Wn,options)

Chebyshev Type II [b,a] = cheby2(n,Rs,Wn,options)
[z,p,k] = cheby2(n,Rs,Wn,options)
[A,B,C,D] = cheby2(n,Rs,Wn,options)

Elliptic [b,a] = ellip(n,Rp,Rs,Wn,options)

[z,p,k] = ellip(n,Rp,Rs,Wn,options)

[A,B,C,D] = ellip(n,Rp,Rs,Wn,options)

By default, each of these functions returns a lowpass filter; you need to specify only the cutoff
frequency that you want, Wn, in normalized units such that the Nyquist frequency is 1 Hz). For a
highpass filter, append 'high' to the function's parameter list. For a bandpass or bandstop filter,
specify Wn as a two-element vector containing the passband edge frequencies. Append 'stop' for
the bandstop configuration.

Here are some example digital filters:

[b,a] = butter(5,0.4); % Lowpass Butterworth

[b,a] = chebyl(4,1,[0.4 0.7]); % Bandpass Chebyshev Type I
[b,a] = cheby2(6,60,0.8, 'high'); % Highpass Chebyshev Type II
[b,a] = ellip(3,1,60,[0.4 0.7], 'stop'); % Bandstop elliptic

To design an analog filter, perhaps for simulation, use a trailing 's' and specify cutoff frequencies in
rad/s:

[b,a] = butter(5,0.4,'s"); % Analog Butterworth filter

All filter design functions return a filter in the transfer function, zero-pole-gain, or state-space linear
system model representation, depending on how many output arguments are present. In general, you
should avoid using the transfer function form because numerical problems caused by round-off errors
can occur. Instead, use the zero-pole-gain form which you can convert to a second-order section
(SOS) form using zp2sos and then use the SOS form to analyze or implement your filter.

2-6
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Note All classical IIR lowpass filters are ill-conditioned for extremely low cutoff frequencies.
Therefore, instead of designing a lowpass IIR filter with a very narrow passband, it can be better to
design a wider passband and decimate the input signal.

Designing IIR Filters to Frequency Domain Specifications

This toolbox provides order selection functions that calculate the minimum filter order that meets a
given set of requirements.

Filter Type Order Estimation Function
Butterworth [n,Wn] = buttord(Wp,Ws,Rp,Rs)
Chebyshev Type I [n,Wn] = cheblord(Wp,Ws,Rp,Rs)
Chebyshev Type II [n,Wn] = cheb2ord(Wp,Ws,Rp,Rs)
Elliptic [n,Wn] = ellipord(Wp,Ws,Rp,Rs)

These are useful in conjunction with the filter design functions. Suppose you want a bandpass filter
with a passband from 1000 to 2000 Hz, stopbands starting 500 Hz away on either side, a 10 kHz
sampling frequency, at most 1 dB of passband ripple, and at least 60 dB of stopband attenuation. You
can meet these specifications by using the butter function as follows.

[n,Wn] = buttord([1000 2000]/5000,[500 2500]/5000,1,60)
[b,a]l] = butter(n,Wn);

n:
12

Wn =

0.1951 0.4080

An elliptic filter that meets the same requirements is given by

[n,Wn] = ellipord([1000 2000]/5000, [500 2500]/5000,1,60)
[b,a] = ellip(n,1,60,Wn);

n =
5

Wn =

0.2000 0.4000

These functions also work with the other standard band configurations, as well as for analog filters.

Comparison of Classical IIR Filter Types

The toolbox provides five different types of classical IIR filters, each optimal in some way. This section
shows the basic analog prototype form for each and summarizes major characteristics.

Butterworth Filter

The Butterworth filter provides the best Taylor series approximation to the ideal lowpass filter
response at analog frequencies Q = 0 and Q = «; for any order N, the magnitude squared response
has 2N - 1 zero derivatives at these locations (maximally flat at Q = 0 and Q = «). Response is
monotonic overall, decreasing smoothly from Q = 0 to Q = «. |[H(jQ)| = 1/y/2 at Q = 1.

2-7
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Chebyshev Type I Filter

The Chebyshev Type I filter minimizes the absolute difference between the ideal and actual frequency
response over the entire passband by incorporating an equal ripple of Rp dB in the passband.

Stopband response is maximally flat. The transition from passband to stopband is more rapid than for
the Butterworth filter. [H(jQ)| = 10" /20 at 0 = 1.
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The Chebyshev Type II filter minimizes the absolute difference between the ideal and actual

frequency response over the entire stopband by incorporating an equal ripple of Rs dB in the
stopband. Passband response is maximally flat.

The stopband does not approach zero as quickly as the type I filter (and does not approach zero at all
for even-valued filter order n). The absence of ripple in the passband, however, is often an important

advantage. |[H(jQ)| = 107820 at 0 = 1.
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Elliptic Filter

Elliptic filters are equiripple in both the passband and stopband. They generally meet filter
requirements with the lowest order of any supported filter type. Given a filter order n, passband

ripple Rp in decibels, and stopband ripple Rs in decibels, elliptic filters minimize transition width.
|H(jQ)| = 107820 3¢ 0 = 1.
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Bessel Filter

Analog Bessel lowpass filters have maximally flat group delay at zero frequency and retain nearly
constant group delay across the entire passband. Filtered signals therefore maintain their
waveshapes in the passband frequency range. When an analog Bessel lowpass filter is converted to a
digital one through frequency mapping, it no longer has this maximally flat property. Signal
Processing Toolbox supports only the analog case for the complete Bessel filter design function.

Bessel filters generally require a higher filter order than other filters for satisfactory stopband

attenuation. |H(jQ)| < 1/42 at Q = 1 and decreases as filter order n increases.
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Note The lowpass filters shown above were created with the analog prototype functions besselap,
buttap, cheblap, cheb2ap, and ellipap. These functions find the zeros, poles, and gain of an nth-
order analog filter of the appropriate type with a cutoff frequency of 1 rad/s. The complete filter
design functions (besself, butter, chebyl, cheby?2, and ellip) call the prototyping functions as a
first step in the design process. See “Special Topics in IIR Filter Design” on page 2-33 for details.

To create similar plots, use n = 5 and, as needed, Rp = 0.5 and Rs = 20. For example, to create the
elliptic filter plot:

[z,p,k] = ellipap(5,0.5,20);

w = logspace(-1,1,1000);

h = fregs(k*poly(z),poly(p),w);
semilogx(w,abs(h)), grid
xlabel('Frequency (rad/s)")
ylabel('Magnitude")

Direct IIR Filter Design

This toolbox uses the term direct methods to describe techniques for IIR design that find a filter
based on specifications in the discrete domain. Unlike the analog prototyping method, direct design
methods are not constrained to the standard lowpass, highpass, bandpass, or bandstop
configurations. Rather, these functions design filters with an arbitrary, perhaps multiband, frequency
response. This section discusses the yulewalk function, which is intended specifically for filter
design; “Parametric Modeling” on page 8-18 discusses other methods that may also be considered
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direct, such as Prony's method, Linear Prediction, the Steiglitz-McBride method, and inverse
frequency design.

The yulewalk function designs recursive IIR digital filters by fitting a specified frequency response.
yulewalk's name reflects its method for finding the filter's denominator coefficients: it finds the
inverse FFT of the ideal specified magnitude-squared response and solves the modified Yule-Walker
equations using the resulting autocorrelation function samples. The statement

[b,a] = yulewalk(n,f,m)

returns row vectors b and a containing the n+1 numerator and denominator coefficients of the nth-
order IIR filter whose frequency-magnitude characteristics approximate those given in vectors f and
m. f is a vector of frequency points ranging from 0 to 1, where 1 represents the Nyquist frequency. m
is a vector containing the specified magnitude response at the points in f. f and m can describe any
piecewise linear shape magnitude response, including a multiband response. The FIR counterpart of
this function is fir2, which also designs a filter based on an arbitrary piecewise linear magnitude
response. See “FIR Filter Design” on page 2-16 for details.

Note that yulewalk does not accept phase information, and no statements are made about the
optimality of the resulting filter.

Design a multiband filter with yulewalk and plot the specified and actual frequency response:

m=[0 6 1 1 006 06 1 1 0 0];
f=1000.10.20.30.40.50.60.70.81];
[b,a] = yulewalk(10,f,m);

[h,w] = freqz(b,a,128)

plot(f,m,w/pi,abs(h))
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Generalized Butterworth Filter Design
The toolbox function maxflat enables you to design generalized Butterworth filters, that is,

Butterworth filters with differing numbers of zeros and poles. This is desirable in some
implementations where poles are more expensive computationally than zeros. maxflat is just like
the butter function, except that it you can specify two orders (one for the numerator and one for the
denominator) instead of just one. These filters are maximally flat. This means that the resulting filter
is optimal for any numerator and denominator orders, with the maximum number of derivatives at 0

and the Nyquist frequency w = m both set to 0.
For example, when the two orders are the same, maxflat is the same as butter:

[b,a] = maxflat(3,3,0.25)

b =
0.0951 0.0951 0.0317

0.0317

a =
1.0000 -1.4590 0.9104 -0.1978

[b,a] = butter(3,0.25)

b =
0.0317 0.0951 0.0951 0.0317

a =
1.0000 -1.4590 0.9104

-0.1978
However, maxflat is more versatile because it allows you to design a filter with more zeros than

poles:
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[b,a] = maxflat(3,1,0.25)
b =

0.0950 0.2849 0.2849 0.0950
a =

1.0000 -0.2402

The third input to maxflat is the half-power frequency, a frequency between 0 and 1 with a
magnitude response of 1/,/2.

You can also design linear phase filters that have the maximally flat property using the 'sym' option:
maxflat(4, 'sym',0.3)

ans =
0.0331 0.2500 0.4337 0.2500 0.0331

For complete details of the maxflat algorithm, see Selesnick and Burrus [2].
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FIR Filter Design

2-16

In this section...

“FIR vs. IIR Filters” on page 2-16

“FIR Filter Summary” on page 2-16

“Linear Phase Filters” on page 2-17

“Windowing Method” on page 2-17

“Multiband FIR Filter Design with Transition Bands” on page 2-20
“Constrained Least Squares FIR Filter Design” on page 2-24
“Arbitrary-Response Filter Design” on page 2-28

FIR vs. IIR Filters

Digital filters with finite-duration impulse response (all-zero, or FIR filters) have both advantages and
disadvantages compared to infinite-duration impulse response (IIR) filters.

FIR filters have the following primary advantages:

* They can have exactly linear phase.

» They are always stable.

* The design methods are generally linear.

* They can be realized efficiently in hardware.

* The filter startup transients have finite duration.

The primary disadvantage of FIR filters is that they often require a much higher filter order than IIR
filters to achieve a given level of performance. Correspondingly, the delay of these filters is often
much greater than for an equal performance IIR filter.

FIR Filter Summary

FIR Filters
Filter Design Description Filter Functions
Method
Windowing Apply window to truncated inverse Fourier firl, fir2, kaiserord
transform of specified "brick wall" filter
Multiband with Equiripple or least squares approach over sub- firls, firpm,
Transition Bands bands of the frequency range firpmord
Constrained Least Minimize squared integral error over entire fircls, firclsl
Squares frequency range subject to maximum error
constraints
Arbitrary Response  |Arbitrary responses, including nonlinear phase and |cfirpm
complex filters
Raised Cosine Lowpass response with smooth, sinusoidal rcosdesign
transition




FIR Filter Design

Linear Phase Filters

Except for cfirpm, all of the FIR filter design functions design linear phase filters only. The filter
coefficients, or “taps,” of such filters obey either an even or odd symmetry relation. Depending on
this symmetry, and on whether the order n of the filter is even or odd, a linear phase filter (stored in
length n+1 vector b) has certain inherent restrictions on its frequency response.

Linear Phase (Filter Symmetry of Coefficients Response Response
Filter Type Order H(f),f = 0 H(f), f = 1
(Nyquist)

Type I Even even: No restriction |No restriction
b(k)=b(n+2-k), k=1,..,n+1

Type 11 Odd even: No restriction |H(1) = 0
b(k)=b(n+2-k), k=1,..,n+1

Type 111 Even odd: HO) =0 H(1) =0
b(k)y= -b(n+2-k), k=1,..,n+1

Type IV Odd odd: HO) =0 No restriction
b(k)= —=b(n+2-k), k=1,.,n+1

The phase delay and group delay of linear phase FIR filters are equal and constant over the frequency
band. For an order n linear phase FIR filter, the group delay is n/2, and the filtered signal is simply
delayed by n/2 time steps (and the magnitude of its Fourier transform is scaled by the filter's
magnitude response). This property preserves the wave shape of signals in the passband; that is,
there is no phase distortion.

The functions firl, fir2, firls, firpm, fircls, and firclsl all design type I and II linear phase
FIR filters by default. rcosdesign designs only type I filters. Both firls and firpm design type III
and IV linear phase FIR filters given a 'hilbert' or 'differentiator' flag. cfirpm can design
any type of linear phase filter, and nonlinear phase filters as well.

Note Because the frequency response of a type II filter is zero at the Nyquist frequency (“high”
frequency), Tirl does not design type II highpass and bandstop filters. For odd-valued n in these
cases, Tirl adds 1 to the order and returns a type I filter.

Windowing Method

Consider the ideal, or “brick wall,” digital lowpass filter with a cutoff frequency of w, rad/s. This filter
has magnitude 1 at all frequencies with magnitude less than w,, and magnitude 0 at frequencies with
magnitude between w, and 1. Its impulse response sequence h(n) is

. wy
h(n) = %IZH(w)eJ‘””dw = %fwoeﬂ””dw =

sinwgn

mn
This filter is not implementable since its impulse response is infinite and noncausal. To create a finite-
duration impulse response, truncate it by applying a window. By retaining the central section of

impulse response in this truncation, you obtain a linear phase FIR filter. For example, a length 51
filter with a lowpass cutoff frequency w, of 0.4 o rad/s is
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b = 0.4*%sinc(0.4%(-25:25));

The window applied here is a simple rectangular window. By Parseval’s theorem, this is the length 51
filter that best approximates the ideal lowpass filter, in the integrated least squares sense. The
following command displays the filter's frequency response in FVTool:

fvtool(b,1)

Note that the y-axis shown in the figure below is in Magnitude Squared. You can set this by right-
clicking on the axis label and selecting Magnitude Squared from the menu.

Magnitude Response (squared)
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Ringing and ripples occur in the response, especially near the band edge. This “Gibbs effect” does not
vanish as the filter length increases, but a nonrectangular window reduces its magnitude.
Multiplication by a window in the time domain causes a convolution or smoothing in the frequency
domain. Apply a length 51 Hamming window to the filter and display the result using FVTool:

b 0.4*%sinc(0.4*(-25:25));

b b.*hamming(51)';
fvtool(b,1)

Note that the y-axis shown in the figure below is in Magnitude Squared. You can set this by right-
clicking on the axis label and selecting Magnitude Squared from the menu.
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Magnitude Response (squared)
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Using a Hamming window greatly reduces the ringing. This improvement is at the expense of
transition width (the windowed version takes longer to ramp from passband to stopband) and
optimality (the windowed version does not minimize the integrated squared error).

Standard Band FIR Filter Design: firl

firl uses a least-squares approximation to compute filter coefficients and then smooths the impulse
response with a window. For an overview of windows and their properties, see “Windows” on page 8-
2. firl resembles the IIR filter design functions in that it is formulated to design filters in

standard band configurations: lowpass, bandpass, highpass, and bandstop.

The statements

n = 50;
Wn = 0.4;
b = firl(n,Wn);

create row vector b containing the coefficients of the order n Hamming-windowed filter. This is a
lowpass, linear phase FIR filter with cutoff frequency Wn. Wn is a number between 0 and 1, where 1
corresponds to the Nyquist frequency, half the sampling frequency. (Unlike other methods, here Wn
corresponds to the 6 dB point.) For a highpass filter, simply append 'high' to the function's

parameter list. For a bandpass or bandstop filter, specify Wn as a two-element vector containing the
passband edge frequencies. Append 'stop' for the bandstop configuration.

b = firl(n,Wn,window) uses the window specified in column vector window for the design. The

vector window must be n+1 elements long. If you do not specify a window, firl applies a Hamming
window.

Kaiser Window Order Estimation

The kaiserord function estimates the filter order, cutoff frequency, and Kaiser window beta
parameter needed to meet a given set of specifications. Given a vector of frequency band edges and a
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corresponding vector of magnitudes, as well as maximum allowable ripple, kaiserord returns
appropriate input parameters for the firl function.

Multiband FIR Filter Design: fir2

The fir2 function also designs windowed FIR filters, but with an arbitrarily shaped piecewise linear
frequency response. This is in contrast to firl, which only designs filters in standard lowpass,
highpass, bandpass, and bandstop configurations.

The commands

n = 50;

f =100 .4 .51];
m=1[1 1 0 0];
b = fir2(n,f,m);

return row vector b containing the n+1 coefficients of the order n FIR filter whose frequency-
magnitude characteristics match those given by vectors T and m. f is a vector of frequency points
ranging from 0 to 1, where 1 represents the Nyquist frequency. m is a vector containing the specified
magnitude response at the points specified in f. (The IIR counterpart of this function is yulewalk,
which also designs filters based on arbitrary piecewise linear magnitude responses. See “IIR Filter
Design” on page 2-4 for details.)

Multiband FIR Filter Design with Transition Bands

The firls and firpm functions provide a more general means of specifying the ideal specified filter
than the firl and fir2 functions. These functions design Hilbert transformers, differentiators, and
other filters with odd symmetric coefficients (type III and type IV linear phase). They also let you
include transition or “don't care” regions in which the error is not minimized, and perform band
dependent weighting of the minimization.

The firls function is an extension of the firl and fir2 functions in that it minimizes the integral
of the square of the error between the specified frequency response and the actual frequency
response.

The firpm function implements the Parks-McClellan algorithm, which uses the Remez exchange
algorithm and Chebyshev approximation theory to design filters with optimal fits between the
specified and actual frequency responses. The filters are optimal in the sense that they minimize the
maximum error between the specified frequency response and the actual frequency response; they
are sometimes called minimax filters. Filters designed in this way exhibit an equiripple behavior in
their frequency response, and hence are also known as equiripple filters. The Parks-McClellan FIR
filter design algorithm is perhaps the most popular and widely used FIR filter design methodology.

The syntax for firls and firpm is the same; the only difference is their minimization schemes. The
next example shows how filters designed with firls and firpm reflect these different schemes.

Basic Configurations

The default mode of operation of firls and firpmis to design type I or type II linear phase filters,
depending on whether the order you want is even or odd, respectively. A lowpass example with
approximate amplitude 1 from 0 to 0.4 Hz, and approximate amplitude 0 from 0.5 to 1.0 Hz is

Filter order
Frequency band edges

n
f

20;
[0 0.4 0.5 1];

%
%
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a

[1 1 0 0]; % Amplitudes
b

firpm(n,f,a);

From 0.4 to 0.5 Hz, firpm performs no error minimization; this is a transition band or “don't care”
region. A transition band minimizes the error more in the bands that you do care about, at the

expense of a slower transition rate. In this way, these types of filters have an inherent trade-off
similar to FIR design by windowing.

To compare least squares to equiripple filter design, use firls to create a similar filter. Type

bb = firls(n,f,a);

and compare their frequency responses using FVTool:

fvtool(b,1,bb,1)

Note that the y-axis shown in the figure below is in Magnitude Squared. You can set this by right-
clicking on the axis label and selecting Magnitude Squared from the menu.
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The filter designed with firpm exhibits equiripple behavior. Also note that the firls filter has a
better response over most of the passband and stopband, but at the band edges (f = 0.4 and

f = 0.5), the response is further away from the ideal than the firpm filter. This shows that the
firpm filter's maximum error over the passband and stopband is smaller and, in fact, it is the
smallest possible for this band edge configuration and filter length.

Think of frequency bands as lines over short frequency intervals. firpm and firls use this scheme
to represent any piecewise linear frequency-response function with any transition bands. firls and
firpm design lowpass, highpass, bandpass, and bandstop filters; a bandpass example is

f
a

[0 0.3 0.4 0.7 0.8 1]; % Band edges in pairs
[0 O 1 1 0 01; % Bandpass filter amplitude
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Technically, these f and a vectors define five bands:

* Two stopbands, from 0.0 to 0.3 and from 0.8 to 1.0
* A passband from 0.4 to 0.7
* Two transition bands, from 0.3 to 0.4 and from 0.7 to 0.8

Example highpass and bandstop filters are

[0 0.7 0.8 11;
[0 0 1 1];
[00.3 0.4 0.5 0.8 1];
1 1 0 0 1 11;

Band edges in pairs
Highpass filter amplitude
Band edges in pairs
Bandstop filter amplitude

DV —h QY —h
LI | | 1

o® o o o°

An example multiband bandpass filter is

00.10.150.25 0.3 0.4 0.45 0.55 0.6 0.7 0.75 0.85 0.9 1];

f
a 1 1 © 0 1 1 © 0 1 1 © 0 1 1];

= [
= [
Another possibility is a filter that has as a transition region the line connecting the passband with the
stopband; this can help control “runaway” magnitude response in wide transition regions:

f
a

[0 0.4 0.42 0.48 0.5 1];
[110.80.200]; % Passband, linear transition,
% stopband

The Weight Vector

Both firls and firpm allow you to place more or less emphasis on minimizing the error in certain
frequency bands relative to others. To do this, specify a weight vector following the frequency and
amplitude vectors. An example lowpass equiripple filter with 10 times less ripple in the stopband than
the passband is

n = 20; % Filter order
f=1000.40.511; % Frequency band edges
a=1[1 1 0 01; % Amplitudes
w=[110]; % Weight vector

b = firpm(n,f,a,w);

A legal weight vector is always half the length of the f and a vectors; there must be exactly one
weight per band.

Anti-Symmetric Filters / Hilbert Transformers

When called with a trailing 'h' or 'Hilbert' option, firpmand firls design FIR filters with odd
symmetry, that is, type III (for even order) or type IV (for odd order) linear phase filters. An ideal
Hilbert transformer has this anti-symmetry property and an amplitude of 1 across the entire
frequency range. Try the following approximate Hilbert transformers and plot them using FVTool:

b = firpm(21,[0.05 1],[1 1],'h"); % Highpass Hilbert
bb = firpm(20,[0.05 0.95],[1 1],'h"); % Bandpass Hilbert
fvtool(b,1,bb,1)
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You can find the delayed Hilbert transform of a signal x by passing it through these filters.

fs = 1000; % Sampling frequency
t = (0:1/fs:2)"'; % Two second time vector
X = sin(2*pi*300*t); % 300 Hz sine wave example signal

xh = filter(bb,1,x); Hilbert transform of x

The analytic signal corresponding to x is the complex signal that has X as its real part and the Hilbert
transform of x as its imaginary part. For this FIR method (an alternative to the hilbert function),
you must delay x by half the filter order to create the analytic signal:

xd
Xa

[zeros(10,1); x(1l:length(x)-10)1; % Delay 10 samples
xd + j*xh; % Analytic signal

This method does not work directly for filters of odd order, which require a noninteger delay. In this
case, the hilbert function, described in “Hilbert Transform” on page 8-44, estimates the analytic
signal. Alternatively, use the resample function to delay the signal by a noninteger number of
samples.

Differentiators

Differentiation of a signal in the time domain is equivalent to multiplication of the signal's Fourier
transform by an imaginary ramp function. That is, to differentiate a signal, pass it through a filter that
has a response H(w) = jw. Approximate the ideal differentiator (with a delay) using firpmor firls
witha 'd' or 'differentiator' option:

b = firpm(21,[0 1],[0 pil,'d");

For a type III filter, the differentiation band should stop short of the Nyquist frequency, and the
amplitude vector must reflect that change to ensure the correct slope:

bb = firpm(20,[0 0.9],[0 0.9%pi],'d");
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In the 'd' mode, firpm weights the error by 1/w in nonzero amplitude bands to minimize the
maximum relative error. firls weights the error by (1/w)? in nonzero amplitude bands in the 'd"'
mode.

The following plots show the magnitude responses for the differentiators above.

fvtool(b,1,bb,1)
legend('0dd order', 'Even order', 'Location', 'best")
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Constrained Least Squares FIR Filter Design

The Constrained Least Squares (CLS) FIR filter design functions implement a technique that enables
you to design FIR filters without explicitly defining the transition bands for the magnitude response.
The ability to omit the specification of transition bands is useful in several situations. For example, it
may not be clear where a rigidly defined transition band should appear if noise and signal information
appear together in the same frequency band. Similarly, it may make sense to omit the specification of
transition bands if they appear only to control the results of Gibbs phenomena that appear in the
filter's response. See Selesnick, Lang, and Burrus [2] for discussion of this method.

Instead of defining passbands, stopbands, and transition regions, the CLS method accepts a cutoff
frequency (for the highpass, lowpass, bandpass, or bandstop cases), or passband and stopband edges
(for multiband cases), for the response you specify. In this way, the CLS method defines transition
regions implicitly, rather than explicitly.

The key feature of the CLS method is that it enables you to define upper and lower thresholds that
contain the maximum allowable ripple in the magnitude response. Given this constraint, the
technique applies the least square error minimization technique over the frequency range of the
filter's response, instead of over specific bands. The error minimization includes any areas of
discontinuity in the ideal, "brick wall" response. An additional benefit is that the technique enables
you to specify arbitrarily small peaks resulting from the Gibbs phenomenon.
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There are two toolbox functions that implement this design technique.

Description Function
Constrained least square multiband FIR filter design fircls
Constrained least square filter design for lowpass and highpass linear phase filters |firclsl

For details on the calling syntax for these functions, see their reference descriptions in the Function
Reference.

Basic Lowpass and Highpass CLS Filter Design

The most basic of the CLS design functions, fircls1l, uses this technique to design lowpass and
highpass FIR filters. As an example, consider designing a filter with order 61 impulse response and
cutoff frequency of 0.3 (normalized). Further, define the upper and lower bounds that constrain the
design process as:

* Maximum passband deviation from 1 (passband ripple) of 0.02.

* Maximum stopband deviation from 0 (stopband ripple) of 0.008.

A A A AT T
1 U u D_(__"U?L-fjf—

To approach this design problem using fircls1, use the following commands:

n = 61;

wo = 0.3;
dp = 0.02;
ds = 0.008;

h = firclsl(n,wo,dp,ds);
fvtool(h,1)

Note that the y-axis shown below is in Magnitude Squared. You can set this by right-clicking on the
axis label and selecting Magnitude Squared from the menu.
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Multiband CLS Filter Design

fircls uses the same technique to design FIR filters with a specified piecewise constant magnitude
response. In this case, you can specify a vector of band edges and a corresponding vector of band
amplitudes. In addition, you can specify the maximum amount of ripple for each band.

For example, assume the specifications for a filter call for:

From 0 to 0.3 (normalized): amplitude 0, upper bound 0.005, lower bound -0.005
From 0.3 to 0.5: amplitude 0.5, upper bound 0.51, lower bound 0.49

From 0.5 to 0.7: amplitude 0, upper bound 0.03, lower bound -0.03

From 0.7 to 0.9: amplitude 1, upper bound 1.02, lower bound 0.98

From 0.9 to 1: amplitude 0, upper bound 0.05, lower bound -0.05

Design a CLS filter with impulse response order 129 that meets these specifications:

n = 129;

f=1[000.30.50.70.91];
a=1[00.5010];

up = [0.005 0.51 0.03 1.02 0.05];

lo = [-0.005 0.49 -0.03 0.98 -0.05];

h = fircls(n,f,a,up,l0);
fvtool(h,1)

Note that the y-axis shown below is in Magnitude Squared. You can set this by right-clicking on the
axis label and selecting Magnitude Squared from the menu.
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Weighted CLS Filter Design

Weighted CLS filter design lets you design lowpass or highpass FIR filters with relative weighting of
the error minimization in each band. The fircls1 function enables you to specify the passband and
stopband edges for the least squares weighting function, as well as a constant k that specifies the
ratio of the stopband to passhand weighting.

For example, consider specifications that call for an FIR filter with impulse response order of 55 and
cutoff frequency of 0.3 (normalized). Also assume maximum allowable passband ripple of 0.02 and
maximum allowable stopband ripple of 0.004. In addition, add weighting requirements:

» Passband edge for the weight function of 0.28 (normalized)
* Stopband edge for the weight function of 0.32
* Weight error minimization 10 times as much in the stopband as in the passband

To approach this using firclsl, type

wo
dp
ds
wp
wSs
k = 10;

h = firclsl(n,wo,dp,ds,wp,ws,K);
fvtool(h,1)

WNOOW

.02;
.004;
.28;
.32

’
’

Note that the y-axis shown below is in Magnitude Squared. You can set this by right-clicking on the
axis label and selecting Magnitude Squared from the menu.
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Arbitrary-Response Filter Design

The cfirpm filter design function provides a tool for designing FIR filters with arbitrary complex
responses. It differs from the other filter design functions in how the frequency response of the filter
is specified: it accepts the name of a function which returns the filter response calculated over a grid

of frequencies. This capability makes cfirpm a highly versatile and powerful technique for filter
design.

This design technique may be used to produce nonlinear-phase FIR filters, asymmetric frequency-

response filters (with complex coefficients), or more symmetric filters with custom frequency
responses.

The design algorithm optimizes the Chebyshev (or minimax) error using an extended Remez-
exchange algorithm for an initial estimate. If this exchange method fails to obtain the optimal filter,

the algorithm switches to an ascent-descent algorithm that takes over to finish the convergence to
the optimal solution.

Multiband Filter Design

Consider a multiband filter with the following special frequency-domain characteristics.

Band Amplitude Optimization Weighting
[-1-0.5] [51] 1

[-0.4 +0.3] [2 2] 10

[+0.4 +0.8] [2 1] 5

A linear-phase multiband filter may be designed using the predefined frequency-response function
multiband, as follows:
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[-1 -0.5 -0.4 0.3 0.40.8], ...
{'multiband', [5 12 2 2 1]}, [1 10 5]);

b = cfirpm(38,
For the specific case of a multiband filter, we can use a shorthand filter design notation similar to the
syntax for firpm:

b = cfirpm(38,[-1 -0.5 -0.4 0.3 0.4 0.8],
[512221], [110 5]);

As with firpm, a vector of band edges is passed to cfirpm. This vector defines the frequency bands
over which optimization is performed; note that there are two transition bands, from -0.5 to -0.4 and

from 0.3 to 0.4.
In either case, the frequency response is obtained and plotted using linear scale in FVTool:

fvtool(b,1)
Note that the range of data shown below is (-pi,pi).
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The filter response for this multiband filter is complex, which is expected because of the asymmetry

in the frequency domain. The impulse response, which you can select from the FVTool toolbar, is

shown below.
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Filter Design with Reduced Delay

Consider the design of a 62-tap lowpass filter with

a half-Nyquist cutoff. If we specify a negative offset

value to the Llowpass filter design function, the group delay offset for the design is significantly less
than that obtained for a standard linear-phase design. This filter design may be computed as follows:

b = cfirpm(61,[0 0.5 0.55 1],{'lowpass',-16});

The resulting magnitude response is

fvtool(b,1)

The y-axis is in Magnitude Squared, which you can set by right-clicking on the axis label and

selecting Magnitude Squared from the menu.
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The group delay of the filter reveals that the offset has been reduced from N/2 to N/2-16 (i.e., from

30.5 to 14.5). Now, however, the group delay is no longer flat in the passband region. To create this
plot, click the Group Delay Response button on the toolbar.
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If we compare this nonlinear-phase filter to a linear-phase filter that has exactly 14.5 samples of
group delay, the resulting filter is of order 2*¥14.5, or 29. Usingb = cfirpm(29,[0 0.5 0.55
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1], 'lowpass'), the passband and stopband ripple is much greater for the order 29 filter. These
comparisons can assist you in deciding which filter is more appropriate for a specific application.
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Special Topics in lIR Filter Design

In this section...

“Classic IIR Filter Design” on page 2-33
“Analog Prototype Design” on page 2-33
“Frequency Transformation” on page 2-34

“Filter Discretization” on page 2-35

Classic lIR Filter Design

The classic IIR filter design technique includes the following steps.

1 Find an analog lowpass filter with cutoff frequency of 1 and translate this prototype filter to the
specified band configuration
Transform the filter to the digital domain.

Discretize the filter.

The toolbox provides functions for each of these steps.

Design Task Available functions

Analog lowpass prototype buttap, cheblap, besselap, ellipap, cheb2ap
Frequency transformation 1p21lp, 1p2hp, Lp2bp, Lp2bs

Discretization bilinear, impinvar

Alternatively, the butter, chebyl, cheb2ord, ellip, and besself functions perform all steps of
the filter design and the buttord, cheblord, cheb2ord, and ellipord functions provide minimum
order computation for IIR filters. These functions are sufficient for many design problems, and the
lower level functions are generally not needed. But if you do have an application where you need to
transform the band edges of an analog filter, or discretize a rational transfer function, this section
describes the tools with which to do so.

Analog Prototype Design

This toolbox provides a number of functions to create lowpass analog prototype filters with cutoff
frequency of 1, the first step in the classical approach to IIR filter design.

The table below summarizes the analog prototype design functions for each supported filter type;
plots for each type are shown in “IIR Filter Design” on page 2-4.

Filter Type Analog Prototype Function
Bessel [z,p,k] = besselap(n)
Butterworth [z,p,k] = buttap(n)
Chebyshev Type I [z,p,k] = cheblap(n,Rp)
Chebyshev Type II [z,p,k] = cheb2ap(n,Rs)
Elliptic [z,p,k] = ellipap(n,Rp,Rs)
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Frequency Transformation

The second step in the analog prototyping design technique is the frequency transformation of a
lowpass prototype. The toolbox provides a set of functions to transform analog lowpass prototypes
(with cutoff frequency of 1 rad/s) into bandpass, highpass, bandstop, and lowpass filters with the
specified cutoff frequency.

Frequency Transformation Transformation Function
Lowpass to lowpass [numt,dent] = 1p2lp (num,den,Wo)
S = s/wy [At,Bt,Ct,Dt] = 1p2lp (A,B,C,D,Wo)
Lowpass to highpass [numt,dent] = 1lp2hp (num,den,Wo)
s’=ﬂ [At,Bt,Ct,Dt] = 1p2hp (A,B,C,D,Wo)
S
Lowpass to bandpass [numt,dent] = 1lp2bp (num,den,Wo,Bw)
’ wo(s/w0)2+1 [At,Bt,Ct,Dt] = 1lp2bp (A,B,C,D,Wo,Bw)
=B, siw
Lowpass to bandstop [numt,dent] = 1p2bs (num,den,Wo,Bw)
_ By slwg [At,Bt,Ct,Dt] = lp2bs( A,B,C,D,Wo,Bw)
WO (s/wp)? + 1

As shown, all of the frequency transformation functions can accept two linear system models: transfer
function and state-space form. For the bandpass and bandstop cases

w0 = |10z
and
By, =wy—wy
where w; is the lower band edge and w, is the upper band edge.

The frequency transformation functions perform frequency variable substitution. In the case of 1p2bp
and 1p2bs, this is a second-order substitution, so the output filter is twice the order of the input. For
1p21p and 1p2hp, the output filter is the same order as the input.

To begin designing an order 10 bandpass Chebyshev Type I filter with a value of 3 dB for passband
ripple, enter

[z,p,k] = cheblap(10,3);

Outputs z, p, and k contain the zeros, poles, and gain of a lowpass analog filter with cutoff frequency
Q. equal to 1 rad/s. Use the function to transform this lowpass prototype to a bandpass analog filter
with band edges Q; = n/5 and Q, = m. First, convert the filter to state-space form so the 1p2bp
function can accept it:

[A,B,C,D] = zp2ss(z,p,k); % Convert to state-space form.

Now, find the bandwidth and center frequency, and call 1p2bp:
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ul = 0.1*%2*pi;
u2 = 0.5*%2*pi; % In radians per second
Bw = u2-ul;

Wo sqrt(ul*u2);
[At,Bt,Ct,Dt] = 1p2bp(A,B,C,D,Wo,Bw);

Finally, calculate the frequency response and plot its magnitude:

onvert to TF form
enerate frequency vector

C

G

Compute frequency response
P

ss2tf(At,Bt,Ct,Dt);
lot log magnitude vs. freq

[b,a] =
w = linspace(0.01,1,500)*2*pi;

h = freqs(b,a,w);
semilogy(w/2/pi,abs(h))
xlabel('Frequency (Hz)'

o® o o o°
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grid
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Filter Discretization
The third step in the analog prototyping technique is the transformation of the filter to the discrete-

time domain. The toolbox provides two methods for this: the impulse invariant and bilinear
transformations. The filter design functions butter, chebyl, cheby2, and ellip use the bilinear

transformation for discretization in this step.

Analog to Digital Transformation Function
Transformation
Impulse invariance [numd,dend] = impinvar (num,den,fs)
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Analog to Digital Transformation Function

Transformation
Bilinear transform

[zd,pd,kd] = bilinear (z,p,k,fs,Fp)

[numd,dend] = bilinear (num,den,fs,Fp)

[Ad,Bd,Cd,Dd] = bilinear (At,Bt,Ct,Dt,fs,Fp)

Impulse Invariance

The toolbox function impinvar creates a digital filter whose impulse response is the samples of the
continuous impulse response of an analog filter. This function works only on filters in transfer
function form. For best results, the analog filter should have negligible frequency content above half

the sampling frequency, because such high-frequency content is aliased into lower bands upon
sampling. Impulse invariance works for some lowpass and bandpass filters, but is not appropriate for

highpass and bandstop filters.
Design a Chebyshev Type I filter and plot its frequency and phase response using FVTool:

[bz,az] = impinvar(b,a,2);
fvtool(bz,az)

Click the Magnitude and Phase Response toolbar button.

Magnitude Response (dB) and Phase Response
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Impulse invariance retains the cutoff frequencies of 0.1 Hz and 0.5 Hz.

Bilinear Transformation
The bilinear transformation is a nonlinear mapping of the continuous domain to the discrete domain;

it maps the s-plane into the z-plane by
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z-1
kz+1

H(z) = H(s)

S =

Bilinear transformation maps the jQ-axis of the continuous domain to the unit circle of the discrete
domain according to

-1({Q
w = 2tan (?)
The toolbox function bilinear implements this operation, where the frequency warping constant k
is equal to twice the sampling frequency (2*fs) by default, and equal to 2pr/tan(ﬂfp/ fs)if you give
bilinear a trailing argument that represents a “match” frequency Fp. If a match frequency Fp (in
hertz) is present, bilinear maps the frequency Q = 2mf,, (in rad/s) to the same frequency in the
discrete domain, normalized to the sampling rate: w = 2mf,/f; (in rad/sample).

The bilinear function can perform this transformation on three different linear system
representations: zero-pole-gain, transfer function, and state-space form. Try calling bilinear with
the state-space matrices that describe the Chebyshev Type I filter from the previous section, using a
sampling frequency of 2 Hz, and retaining the lower band edge of 0.1 Hz:

[Ad,Bd,Cd,Dd] = bilinear(At,Bt,Ct,Dt,2,0.1);
The frequency response of the resulting digital filter is

[bz,az] = ss2tf(Ad,Bd,Cd,Dd); % Convert to TF
fvtool(bz,az)

Click the Magnitude and Phase Response toolbar button.

Magnitude Response (dB) and Phase Response
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The lower band edge is at 0.1 Hz as expected. Notice, however, that the upper band edge is slightly
less than 0.5 Hz, although in the analog domain it was exactly 0.5 Hz. This illustrates the nonlinear
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2-38

nature of the bilinear transformation. To counteract this nonlinearity, it is necessary to create analog
domain filters with “prewarped” band edges, which map to the correct locations upon bilinear
transformation. Here the prewarped frequencies ul and u2 generate Bw and Wo for the 1p2bp
function:

fs = 2; % Sampling frequency (hertz)
ul = 2*fs*tan(0.1*(2*pi/fs)/2); % Lower band edge (rad/s)

u2 = 2*fs*tan(0.5*%(2*pi/fs)/2); % Upper band edge (rad/s)
Bw = u2 - ul; % Bandwidth

Wo = sqrt(ul*u2); % Center frequency

[At,Bt,Ct,Dt] = 1lp2bp(A,B,C,D,Wo,Bw);
A digital bandpass filter with correct band edges 0.1 and 0.5 times the Nyquist frequency is
[Ad,Bd,Cd,Dd] = bilinear(At,Bt,Ct,Dt,fs);

The example bandpass filters from the last two sections could also be created in one statement using
the complete IIR design function cheby1l. For instance, an analog version of the example Chebyshev
filter is

[b,a] = chebyl(5,3,[0.1 0.5]%2%pi, 's");

Note that the band edges are in rad/s for analog filters, whereas for the digital case, frequency is
normalized:

[bz,az] = chebyl(5,3,[0.1 0.5]);

All of the complete design functions call bilinear internally. They prewarp the band edges as
needed to obtain the correct digital filter.
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Filtering Data with Signal Processing Toolbox Software
Lowpass FIR Filter - Window Method

This example shows how to design and implement an FIR filter using two command line functions,
firl and designfilt, and the interactive Filter Designer app.

Create a signal to use in the examples. The signal is a 100 Hz sine wave in additive N(0, 1/4) white
Gaussian noise. Set the random number generator to the default state for reproducible results.

rng default
Fs = 1000;

t linspace(0,1,Fs);
X Ccos (2*pi*100*t)+0.5*randn(size(t));

The filter design is an FIR lowpass filter with order equal to 20 and a cutoff frequency of 150 Hz. Use
a Kaiser window with length one sample greater than the filter order and = 3. See kaiser for
details on the Kaiser window.

Use firl to design the filter. firl requires normalized frequencies in the interval [0,1], where 1
corresponds to m rad/sample. To use firl, you must convert all frequency specifications to
normalized frequencies.

Design the filter and view the magnitude response.

fc 150;
Wn (2/Fs)*fc;
b = firl(20,Wn, 'low',6kaiser(21,3));

[h,f] = freqz(b,1,[]
plot(f,mag2db(abs(h)
xlabel('Frequency (H
ylabel('Magnitude (d
grid

,Fs);
))

z)")
B)")
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Apply the filter to the signal and plot the result for the first ten periods of the 100 Hz sinusoid.
y = filter(b,1,x);

plot(t,x,t,y)
x1im([0 0.1])

xlabel('Time (s)")

ylabel('Amplitude")
legend('Original Signal', 'Filtered Data')
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Design the same filter using designfilt. Set the filter response to ' lowpassfir' and input the
specifications as Name, Value pairs. With designfilt, you can specify your filter design in Hz.

Fs = 1000;

Hd designfilt('lowpassfir', 'FilterOrder',20, 'CutoffFrequency',150, ...
'DesignMethod', 'window', 'Window', {@kaiser,3}, 'SampleRate',Fs);

Filter the data and plot the result.
yl = filter(Hd,x);

plot(t,x,t,yl)
xlim([0 0.1])

xlabel('Time (s)")

ylabel('Amplitude")
legend('Original Signal', 'Filtered Data')
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Lowpass FIR Filter with Filter Designer

This example shows how to design and implement a lowpass FIR filter using the window method with
the interactive Filter Designer app.

2-42

Start the app by entering filterDesigner at the command line.

Set the Response Type to Lowpass.

Set the Design Method to FIR and select the Window method.

Under Filter Order, select Specify order. Set the order to 20.

Under Frequency Specifications, set Units to Hz, Fs to 1000, and Fc to 150.
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! |Differentiator .

| Design Method— || Window: | Kaiser
Beta: 0s

) Bandpass
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@ FIR |window

Design Filter

Designing Filter ... Done

* Click Design Filter.

* Select File > Export... to export your FIR filter to the MATLAB® workspace as coefficients or a
filter object. In this example, export the filter as an object. Specify the variable name as Hd.
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i N
4. Export = %
— Export To
Workspace -
— Export As
Objects =

— “ariable Hames

Dizcrete Fiter: |Hd

|:| Owerwrite Wariables

[Expnrt] [C.Ins.e] [ Help ]

* Click Export.

* Filter the input signal in the command window with the exported filter object. Plot the result for
the first ten periods of the 100 Hz sinusoid.

y2 = filter(Hd,x);

plot(t,x,t,y2)
x1im([® 0.1])

xlabel('Time (s)')

ylabel('Amplitude")
legend('Original Signal', 'Filtered Data')
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* Select File > Generate MATLAB Code > Filter Design Function to generate a MATLAB
function to create a filter object using your specifications.

You can also use the interactive tool filterBuilder to design your filter.
Bandpass Filters - Minimum-Order FIR and IIR Systems

This example shows how to design a bandpass filter and filter data with minimum-order FIR
equiripple and IIR Butterworth filters. You can model many real-world signals as a superposition of
oscillating components, a low-frequency trend, and additive noise. For example, economic data often
contain oscillations, which represent cycles superimposed on a slowly varying upward or downward
trend. In addition, there is an additive noise component, which is a combination of measurement
error and the inherent random fluctuations in the process.

In these examples, assume you sample some process every day for one year. Assume the process has
oscillations on approximately one-week and one-month scales. In addition, there is a low-frequency
upward trend in the data and additive N(0, 1/4) white Gaussian noise.

Create the signal as a superposition of two sine waves with frequencies of 1/7 and 1/30 cycles/day.
Add a low-frequency increasing trend term and N(0, 1/4) white Gaussian noise. Reset the random
number generator for reproducible results. The data is sampled at 1 sample/day. Plot the resulting
signal and the power spectral density (PSD) estimate.

rng default

Fs = 1;
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n = 1:365;

X = €0S(2*pi*(1/7)*n)+cos(2*pi*(1/30)*n-pi/4);
trend = 3*sin(2*pi*(1/1480)*n);

y = x+trend+0.5*randn(size(n));

[pxx,f] = periodogram(y,[],[]1,Fs);
subplot(2,1,1)

plot(n,y)

xlim([1 365])

xlabel('Days")

grid

subplot(2,1,2)
plot(f,10*1ogl0O(pxx))
xlabel('Cycles/day")
ylabel('dB")

grid
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The low-frequency trend appears in the power spectral density estimate as increased low-frequency
power. The low-frequency power appears approximately 10 dB above the oscillation at 1/30 cycles/

day. Use this information in the specifications for the filter stopbands.
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Design minimum-order FIR equiripple and IIR Butterworth filters with the following specifications:
passband from [1/40,1/4] cycles/day and stopbands from [0,1/60] and [1/4,1/2] cycles/day. Set both
stopband attenuations to 10 dB and the passband ripple tolerance to 1 dB.

Hd1l = designfilt('bandpassfir',
'StopbandFrequencyl',1/60, 'PassbandFrequencyl',1/40,
'PassbandFrequency2',1/4 , 'StopbandFrequency2',1/2 ,
'StopbandAttenuationl', 10, 'PassbandRipple’,1,
'StopbandAttenuation2',10, 'DesignMethod', 'equiripple', 'SampleRate',Fs);
Hd2 = designfilt('bandpassiir', .
'StopbandFrequencyl',1/60, 'PassbandFrequencyl',1/40,
'PassbandFrequency2',1/4 ,'StopbandFrequency2',1/2 ,
'StopbandAttenuationl', 10, 'PassbandRipple’,1,
'StopbandAttenuation2',10, 'DesignMethod', 'butter', 'SampleRate',Fs);

Compare the order of the FIR and IIR filters and the unwrapped phase responses.

fprintf('The
The order of
fprintf('The
The order of

[phifir,w]
[phiiir,w]

figure

order of the FIR filter is %d\n',filtord(Hd1))
the FIR filter is 78
order of the IIR filter is %d\n',filtord(Hd2))
the IIR filter is 8

phasez(Hd1,[],1);
phasez(Hd2,[],1);

plot(w,unwrap(phifir))

hold on

plot(w,unwrap(phiiir))

hold off

xlabel('Cycles/Day"')
ylabel('Radians')
legend('FIR Equiripple Filter','IIR Butterworth Filter')

grid
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The IIR filter has a much lower order that the FIR filter. However, the FIR filter has a linear phase
response over the passband, while the IIR filter does not. The FIR filter delays all frequencies in the
filter passband equally, while the IIR filter does not.

Additionally, the rate of change of the phase per unit of frequency is greater in the FIR filter than in
the IIR filter.

Design a lowpass FIR equiripple filter for comparison. The lowpass filter specifications are: passband
[0,1/4] cycles/day, stopband attenuation equal to 10 dB, and the passband ripple tolerance set to 1
dB.

Hdlow = designfilt('lowpassfir',
'PassbandFrequency',1/4, 'StopbandFrequency',1/2,
'PassbandRipple’', 1, 'StopbandAttenuation', 10,
'DesignMethod’, 'equiripple’, 'SampleRate',1);

Filter the data with the bandpass and lowpass filters.

yfir = filter(Hd1l,y);
yiir = filter(Hd2,y);
ylow = filter(Hdlow,y);

Plot the PSD estimate of the bandpass IIR filter output. You can replace yiir with yfir in the
following code to view the PSD estimate of the FIR bandpass filter output.

[pxx,f] = periodogram(yiir,[],[]1,Fs);
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plot(f,10*1ogl0O(pxx))

xlabel('Cycles/day"')
ylabel('dB")
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The PSD estimate shows the bandpass filter attenuates the low-frequency trend and high-frequency
noise.

Plot the first 120 days of FIR and IIR filter output.
plot(n,yfir,n,yiir)

axis([1 120 -2.8 2.8])

xlabel('Days")

legend('FIR bandpass filter output', 'IIR bandpass filter output',
'Location', 'SouthEast')
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The increased phase delay in the FIR filter is evident in the filter output.

Plot the lowpass FIR filter output superimposed on the superposition of the 7-day and 30-day cycles
for comparison.

plot(n,x,n,ylow)
xlim([1 365])

xlabel('Days"')
legend('7-day and 30-day cycles', 'FIR lowpass filter output', ...

'"Location', 'NorthWest"')
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You can see in the preceding plot that the low-frequency trend is evident in the lowpass filter output.
While the lowpass filter preserves the 7-day and 30-day cycles, the bandpass filters perform better in
this example because the bandpass filters also remove the low-frequency trend.

Zero-Phase Filtering
This example shows how to perform zero-phase filtering.

Repeat the signal generation and lowpass filter design with firl and designfilt. You do not have
to execute the following code if you already have these variables in your workspace.

rng default

Fs = 1000;
t = linspace(0,1,Fs);
X = €0s(2*pi*100*t)+0.5*randn(size(t));

% Using firl

fc = 150;

Wn = (2/Fs)*fc;

b = firl(20,Wn, 'low',kaiser(21,3));

% Using designfilt
Hd = designfilt('lowpassfir', 'FilterOrder',20, ' 'CutoffFrequency', 150,
'DesignMethod', 'window', 'Window', {@kaiser,3}, 'SampleRate',Fs);

Filter the data using filter. Plot the first 100 points of the filter output along with a superimposed
sinusoid with the same amplitude and initial phase as the input signal.
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yout = filter(Hd,x);
xin = cos(2*pi*100*t);

plot(t,xin,t,yout)
xlim([0 0.1])

xlabel('Time (s)"')
ylabel('Amplitude")

legend('Input Sine Wave', 'Filtered Data')
grid
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157 | II
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Looking at the initial 0.01 seconds of the filtered data, you see that the output is delayed with respect

to the input. The delay appears to be approximately 0.01 seconds, which is almost 1/2 the length of
the FIR filter in samples (10 x 0.001).

This delay is due to the filter's phase response. The FIR filter in these examples is a type I linear-
phase filter. The group delay of the filter is 10 samples.

Plot the group delay.
[gd,f] = grpdelay(Hd,[],Fs);
plot(f,gd)

xlabel('Frequency (Hz)")

ylabel('Group Delay (samples)"')
grid
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In many applications, phase distortion is acceptable. This is particularly true when phase response is
linear. In other applications, it is desirable to have a filter with a zero-phase response. A zero-phase

response is not technically possibly in a noncausal filter. However, you can implement zero-phase
filtering using a causal filter with filtfilt.

Filter the input signal using filtfilt. Plot the responses to compare the filter outputs obtained
with filter and filtfilt.

yzp = filtfilt(Hd,x);

plot(t,xin,t,yout,t,yzp)

xlim([0 0.1])

xlabel('Time (s)')

ylabel('Amplitude")

legend('100-Hz Sine Wave', 'Filtered Signal', 'Zero-phase Filtering',...
'Location', 'NorthEast')
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In the preceding figure, you can see that the output of filtfilt does not exhibit the delay due to
the phase response of the FIR filter.
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3 Designing a Filter in fdesign — Process Overview

Process Flow Diagram and Filter Design Methodology

3-2

In this section...

“Exploring the Process Flow Diagram” on page 3-2
“Selecting a Response” on page 3-4

“Selecting a Specification” on page 3-4

“Selecting an Algorithm” on page 3-5

“Customizing the Algorithm” on page 3-6

“Designing the Filter” on page 3-6

“Design Analysis” on page 3-7

“Realize or Apply the Filter to Input Data” on page 3-7

Note You must minimally have the Signal Processing Toolbox installed to use fdesign and design.
Some of the features described below may be unavailable if your installation does not additionally
include the DSP System Toolbox™ license. The DSP System Toolbox significantly expands the
functionality available for the specification, design, and analysis of filters. You can verify the presence
of both toolboxes by typing ver at the command prompt.

Exploring the Process Flow Diagram

The process flow diagram shown in the following figure lists the steps and shows the order of the
filter design process.
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Select Response
help fdesignéesponses

Select Specification
setizpecOhbj, 'specification”)

> Specifications Object

Select Algorithm
designmethods(zpecObj)

llllllllllllllllll+llllllllllllllllllllllllllllli

Customize Algorithm | ~
help (spechj, hutter’) i
Design Filter |
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: IR
< | Analysis and Realize or . i
= | Verification Apply Filter E : _ )
i Ee:p dfitianalysis to Input . : . Implementation Object
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The first four steps of the filter design process relate to the filter Specifications Object, while the last
two steps involve the filter Implementation Object. Both of these objects are discussed in more detail
in the following sections. Step 5 - the design of the filter, is the transition step from the filter
Specifications Object to the Implementation object. The analysis and verification step is completely
optional. It provides methods for the filter designer to ensure that the filter complies with all design
criteria. Depending on the results of this verification, you can loop back to steps 3 and 4, to either
choose a different algorithm, or to customize the current one. You may also wish to go back to steps 3
or 4 after you filter the input data with the designed filter (step 7), and find that you wish to tweak
the filter or change it further.

The diagram shows the help command for each step. Enter the help line at the MATLAB command
prompt to receive instructions and further documentation links for the particular step. Not all of the
steps have to be executed explicitly. For example, you could go from step 1 directly to step 5, and the
interim three steps are done for you by the software.

The following are the details for each of the steps shown above.
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Selecting a Response
If you type:
help fdesign/responses

at the MATLAB command prompt, you see a list of all available filter responses. The responses
marked with an asterisk require the DSP System Toolbox.

You must select a response to initiate the filter. In this example, a bandpass filter Specifications
Object is created by typing the following:

d = fdesign.bandpass
Selecting a Specification

A specification is an array of design parameters for a given filter. The specification is a property of the
Specifications Object.

Note A specification is not the same as the Specifications Object. A Specifications Object contains a
specification as one of its properties.

When you select a filter response, there are a number of different specifications available. Each one
contains a different combination of design parameters. After you create a filter Specifications Object,
you can query the available specifications for that response. Specifications marked with an asterisk
require the DSP System Toolbox.

d = fdesign.bandpass;
set(d, 'specification')

ans =

'"Fstl,Fpl,Fp2,Fst2,Astl,Ap,Ast2’
'N,F3dB1,F3dB2'
'N,F3dB1,F3dB2,Ap"
'N,F3dB1,F3dB2,Ast'
'N,F3dB1,F3dB2,Astl,Ap,Ast2"’
'N,F3dB1,F3dB2,BWp"
'N,F3dB1,F3dB2,BWst"
'"N,Fcl,Fc2'

'N,Fpl,Fp2,Ap'
"N,Fpl,Fp2,Astl,Ap,Ast2’
'N,Fstl,Fpl,Fp2,Fst2'
'N,Fstl,Fpl,Fp2,Fst2,Ap’
'N,Fstl,Fst2,Ast"
'Nb,Na,Fstl,Fpl,Fp2,Fst2'

d = fdesign.arbmag;
set(d, 'specification')



Process Flow Diagram and Filter Design Methodology

The set command can be used to select one of the available specifications as follows:

d = fdesign.lowpass;
set(d, 'specification', 'N,Fc")

If you do not perform this step explicitly, fdesign returns the default specification for the response
you chose in “Select a Response” on page 4-2, and provides default values for all design
parameters included in the specification.

Selecting an Algorithm

The availability of algorithms depends the chosen filter response, the design parameters, and the
availability of the DSP System Toolbox. In other words, for the same lowpass filter, changing the
specification also changes the available algorithms. In the following example, for a lowpass filter and
a specification of 'N, Fc', only one algorithm is available—window.

set (d, 'specification', 'N,Fc')
designmethods (d) %step3: get available algorithms

Design Methods for class fdesign.lowpass (N,Fc):

window

However, for a specification of 'Fp,Fst,Ap,Ast’, a number of algorithms are available. If the user
has only the Signal Processing Toolbox installed, the following algorithms are available:

set(d, 'specification', 'Fp,Fst,Ap,Ast"')
designmethods(d)

Design Methods for class fdesign.lowpass (Fp,Fst,Ap,Ast):

butter
chebyl
cheby?2
ellip
equiripple
kaiserwin

If the user additionally has the DSP System Toolbox installed, the number of available algorithms for
this response and specification increases:

set(d, 'specification', 'Fp,Fst,Ap,Ast"')
designmethods(d)

Design Methods for class fdesign.lowpass (Fp,Fst,Ap,Ast):

butter
chebyl
cheby?2
ellip
equiripple
ifir
kaiserwin
multistage

The user chooses a particular algorithm and implements the filter with the design function.



3 Designing a Filter in fdesign — Process Overview

3-6

Hd=design(d, 'butter');
The preceding code actually creates the filter. If you do not perform this step explicitly, design
automatically selects the optimum algorithm for the chosen response and specification.

Customizing the Algorithm

The customization options available for any given algorithm depend not only on the algorithm itself,
selected in “Selecting an Algorithm” on page 3-5, but also on the specification selected in “Selecting
a Specification” on page 3-4. To explore all the available options, type the following at the MATLAB
command prompt:

help(d, 'algorithm-name")

where d is the Filter Specification Object, and algorithm-name is the name of the algorithm in
single quotes, such as 'butter' or 'chebyl’.

The application of these customization options takes place while “Designing the Filter” on page 3-
6, because these options are the properties of the filter Implementation Object, not the
Specification Object.

If you do not perform this step explicitly, the optimum algorithm structure is selected.

Designing the Filter

To create a filter, use the design command:
Hd = design(d);

where d is the Specifications Object. This code creates a filter without specifying the algorithm. When
the algorithm is not specified, the software selects the best available one.

To apply the algorithm chosen in “Selecting an Algorithm” on page 3-5, use the same design
command, but specify the Butterworth algorithm as follows:

Hd = design(d, 'butter');
To obtain help and see all the available options, type:
help fdesign/design

This help command describes not only the options for the design command itself, but also options
that pertain to the method or the algorithm. If you are customizing the algorithm, you apply these
options in this step. In the following example, you design a bandpass filter, and then modify the filter
structure:

Hd

design(d, 'butter', 'FilterStructure', 'df2sos')

Hd

FilterStructure: 'Direct-Form II, Second-Order Sections'
Arithmetic: 'double'
sosMatrix: [13x6 double]
ScaleValues: [14x1 double]
OptimizeScaleValues: true
PersistentMemory: false
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The filter design step, just like the first task of choosing a response, must be performed explicitly. The
filter is created only when design is called.

Design Analysis

After the filter is designed you may wish to analyze it to determine if the filter satisfies the design
criteria. Filter analysis is broken into three main sections:

* Frequency domain analysis — Includes the magnitude response, group delay, and pole-zero plots.
* Time domain analysis — Includes impulse and step response
* Implementation analysis — Includes quantization noise and cost

To display help for analysis of a discrete-time filter, type:
>> help dfilt/analysis

To display help for analysis of a farrow filter, type:

>> help farrow/functions

To analyze your filter, you must explicitly perform this step.

Realize or Apply the Filter to Input Data

After the filter is designed and optimized, it can be used to filter actual input data. The basic filter
command takes input data x, filters it through the Filter Object, and produces output y:

>> y = filter (FilterObj, x)

This step is never automatically performed for you. To filter your data, you must explicitly execute
this step. To understand how the filtering commands work, type:

>> help dfilt/filter

Note If you have Simulink®, you have the option of exporting this filter to a Simulink block using the
realizemdl command. To get help on this command, type:

>> help realizemdl
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* “Filter Builder Design Process” on page 4-2

* “Compensate for Delay and Distortion Introduced by Filters” on page 4-9
* “Comparison of Analog IIR Lowpass Filters” on page 4-16

* “Frequency Response of Lowpass Bessel Filter” on page 4-18

* “Speaker Crossover Filters” on page 4-20
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Filter Builder Design Process
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In this section...

“Introduction to Filter Builder” on page 4-2
“Design a Filter Using Filter Builder” on page 4-2
“Select a Response” on page 4-2

“Select a Specification” on page 4-4

“Select an Algorithm” on page 4-5

“Customize the Algorithm” on page 4-5

“Analyze the Design” on page 4-6

“Realize or Apply the Filter to Input Data” on page 4-7

Introduction to Filter Builder

The filterBuilder function provides a graphical interface to the fdesign object-oriented filter
design paradigm and is intended to reduce development time during the filter design process.
filterBuilder uses a specification-centered approach to find the best algorithm for the desired
response.

Note filterBuilder requires the Signal Processing Toolbox. The DSP System Toolbox product
greatly expands the functionality of filterBuilder. Many of the features described or displayed on
this page are only available if the DSP System Toolbox is installed. You may verify your installation by
typing ver at the command prompt.

Design a Filter Using Filter Builder

The basic workflow in using filterBuilder is to choose the constraints and specifications of the
filter, and to use those constraints as a starting point in the design. Postponing the choice of
algorithm for the filter allows the best design method to be determined automatically, based on the
desired performance criteria. The following are the details of each of the steps for designing a filter
with filterBuilder.

Select a Response

When you open the filterBuilder tool by typing:
filterBuilder

at the MATLAB command prompt, the Response Selection dialog box appears, listing all possible
filter responses available in DSP System Toolbox.
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e B
u Response Selection L == ﬂ

Select a fiter response:

Lowpass -
Highpass

Bandpass

Bandstop

Differentiator

Hilbert Transformer

Arbitrary Response

Pulse Shaping

OK l [ Cancel

Note This step cannot be skipped because it is not automatically completed for you by the software.
You must select a response to initiate the filter design process.

After you choose a response, say bandpass, you start the design of the Specifications Object, and the
Bandpass Design dialog box appears. This dialog box contains a Main pane, a Data Types pane, and
a Code Generation pane. The specifications of your filter are generally set in the Main pane of the
dialog box.

The Data Types pane provides settings for precision and data types, and the Code Generation pane
contains options for various implementations of the completed filter design.

For the initial design of your filter, you mostly use the Main pane.
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4\ Bandpass Design @

Bandpass Design

Design a bandpass filter.

Filter output variable name: Hbp2 View Filter Response

Main Code Generation

Filter specifications

Impulse response: ’F]R v]

Order mode: lMinimum v]

Frequency specifications

Frequency units: ’Normalized (0to 1) V]
Stopband frequency 1: .35 Passband frequency 1: .45
Passband frequency 2: .55 Stopband frequency 2: .65

Magnitude specifications

Magnitude units: dB -

Stopband attenuation 1: 60 Passband ripple: 1

Stopband attenuation 2: 60

Algorithm

Design method: | Equiripple -

» Design options

Filter implementation

Structure: | Direct-form FIR -

[ 0K H Cancel H Help ] Apply

L o

The Bandpass Design dialog box contains all the parameters necessary to determine the
specifications of a bandpass filter. The parameters listed in the Main pane depend upon the type of
filter you are designing. However, no matter what type of filter you have chosen in the Response
Selection dialog box, the filter design dialog box contains the Main, Data Types, and Code
Generation panes.

Select a Specification

To choose the specification for the bandpass filter, you can begin by selecting an Impulse Response,
Order Mode, and Filter Type in the Filter Specifications frame of the Main Pane. You can further
specify the response of your filter by setting frequency and magnitude specifications in the
appropriate frames on the Main Pane.

Note Frequency, Magnitude, and Algorithm specifications are interdependent and might change
based on your Filter Specifications selections. When choosing specifications for your filter, select
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your Filter Specifications first and work your way down the dialog box. This approach ensures that
the best settings for dependent specifications display as available in the dialog box.

Select an Algorithm

The algorithms available for your filter depend upon the filter response and design parameters you
have selected in the previous steps. For example, in the case of a bandpass filter, if the impulse
response selected is IIR and the Order Mode field is set to Minimum, the design methods available
are Butterworth, Chebyshev type [ or II, or ELliptic. If the Order Mode field is set to Specify,
the design method available is IIR least p-norm.

4\ Bandpass Design ﬁ

Bandpass Design

Design a bandpass filter.

Filter output variable name: Hbp2 View Filter Response

Main Code Generation

Filter specifications

Impulse response: []IIR 'l

Order mode: [Minimum 'l

Frequency specifications

Frequency units: [Normalized (0to1) ']
Stopband frequency 1: .35 Passband frequency 1: .45
Passband frequency 2: .55 Stopband frequency 2: .65

Magnitude specifications

Magnitude units: dB -

Stopband attenuation 1: &0 Passband ripple: 1

Stopband attenuation 2: 60

Algorithm

Design method: | Butterworth -

» Design options

Filter implementation

Structure: | Direct-form I SOS 'l

[ 0K H Cancel H Help ” Apply ]

Customize the Algorithm

By expanding the Design options section of the Algorithm frame, you can further customize the
algorithm specified. The options available depend upon the algorithm and settings that have already
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been selected in the dialog box. In the case of a bandpass IIR filter using the Butterworth method,
design options such as Match Exactly are available, as shown in the following figure.

© ™
4\ Bandpass Design ‘ u

Bandpass Design

Design a bandpass filter.

Filter output variable name: Hbp2 View Filter Response

Main Code Generation

Filter specifications

Impulse response: []IIR 'l

Order mode: [Minimum 'l

Frequency specifications

Frequency units: [Normalized (0to1) ']
Stopband frequency 1: .35 Passband frequency 1: .45
Passband frequency 2: .55 Stopband frequency 2: .65

Magnitude specifications

Magnitude units: dB -

Stopband attenuation 1: &0 Passband ripple: 1

Stopband attenuation 2: 60

Algorithm

Design method: [Euti:emrori:h 'l

¥ Design options

Match exactly: l Stopband - ]

Filter implementation

Structure: lDirect—form I S05 v]

[ 0K ][ Cancel ” Help H Apply l

Analyze the Design

To analyze the filter response, click the View Filter Response button. The Filter Visualization Tool
(FVTool) opens displaying the magnitude plot of the filter response.
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Realize or Apply the Filter to Input Data

When you have achieved the desired filter response through design iterations and analysis using the
Filter Visualization Tool, apply the filter to the input data. Again, this step is never automatically
performed for you by the software. To filter your data, you must explicitly execute this step. In the
Bandpass Design dialog box, click OK and the Signal Processing Toolbox software creates the filter
coefficients and exports it to the MATLAB workspace.

The filter is then ready to be used to filter actual input data. The basic filter command takes input
data x, filters it through the Filter Object, and produces output y:

y = filter(Hbs,x)
To understand how the filtering command works, type:

help dfilt/filter

Tip If you have Simulink, you have the option of exporting this filter to a Simulink block using the
realizemdl command. To get help on this command, type:

help realizemdl
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See Also
FVTool
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Compensate for Delay and Distortion Introduced by Filters

Filtering a signal introduces a delay. This means that the output signal is shifted in time with respect
to the input.

When the shift is constant, you can correct for the delay by shifting the signal in time.

Sometimes the filter delays some frequency components more than others. This phenomenon is called
phase distortion. To compensate for this effect, you can perform zero-phase filtering using the
filtfilt function.

Take an electrocardiogram reading sampled at 500 Hz for 1 s. Add random noise. Reset the random
number generator for reproducible results

Fs = 500;
N = 500;

rng default

xn
tn

ecg(N)+0.1*randn([1 N]);
(0:N-1)/Fs;

Remove some of the noise using a filter that stops frequencies above 75 Hz. Use designfilt to
design an FIR filter of order 70.

Nfir = 70;
Fst = 75;

firf = designfilt('lowpassfir', 'FilterOrder', Nfir,
'CutoffFrequency',Fst, 'SampleRate',Fs);

Filter the signal and plot it. The result is smoother than the original, but lags behind it.
xf = filter(firf,xn);

plot(tn,xn,tn,xf)

title 'Electrocardiogram'

xlabel 'Time (s)'
legend('Original', 'FIR Filtered')
grid
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Use grpdelay to check that the delay caused by the filter equals half the filter order.

grpdelay(firf,N,Fs)
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Group delay

EAVISICEA)

Group delay (in samples)
(#1]
o
|

345 ! L |
0 50 100 150

Freguency (Hz)

delay = mean(grpdelay(firf))

delay = 35

200

Line up the data. Shift the filtered signal by removing its first delay samples. Remove the last delay

samples of the original and of the time vector.

tt = tn(l:end-delay);
sn = xn(l:end-delay);
sf = xf;

sf(l:delay) = [];
Plot the signals and verify that they are aligned.

plot(tt,sn,tt,sf)

title 'Electrocardiogram'

xlabel('Time (s)"')

legend('Original Signal', 'Filtered Shifted Signal')
grid
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Electrocardiogram
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Repeat the computation using a 7th-order IIR filter.
Niir = 7;

iir = designfilt('lowpassiir', 'FilterOrder', Niir,
'"HalfPowerFrequency',Fst, 'SampleRate',Fs);

Filter the signal. The filtered signal is cleaner than the original, but lags in time with respect to it. It
is also distorted due to the nonlinear phase of the filter.

xfilter = filter(iir,xn);
plot(tn,xn,tn,xfilter)

title 'Electrocardiogram’
xlabel 'Time (s)'
legend('Original', 'Filtered")

axis([0.25 0.55 -1 1.5])
grid
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Electrocardiogram
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Alook at the group delay introduced by the filter shows that the delay is frequency-dependent.
grpdelay(iir,N,Fs)
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Filter the signal using filtfilt. The delay and distortion have been effectively removed.

filtfilt when it is critical to keep the phase information of a signal intact.
xfiltfilt = filtfilt(iir,xn);

plot(tn,xn)

hold on
plot(tn,xfilter)
plot(tn,xfiltfilt)

title 'Electrocardiogram'
xlabel 'Time (s)'

legend('Original', ' "' 'filter''"',"""filtfilt'"'")
axis([0.25 0.55 -1 1.5])
grid

Use
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Comparison of Analog IIR Lowpass Filters

4-16

Design a bth-order analog Butterworth lowpass filter with a cutoff frequency of 2 GHz. Multiply by 2
to convert the frequency to radians per second. Compute the frequency response of the filter at 4096
points.

5 .

n H
2e9;

f

[zb,pb,kb] = butter(n,2*pi*f,'s');
[bb,ab] = zp2tf(zb,pb,kb);
[hb,wb] = freqs(bb,ab,4096);

Design a bth-order Chebyshev Type I filter with the same edge frequency and 3 dB of passband
ripple. Compute its frequency response.

[z1,pl,k1] = chebyl(n,3,2*pi*f,'s");
[bl,al] zp2tf(z1,pl,kl);
[h1l,wl] freqs(bl,al,4096);

Design a 5th-order Chebyshev Type II filter with the same edge frequency and 30 dB of stopband
attenuation. Compute its frequency response.

[z2,p2,k2] = cheby2(n,30,2*pi*f,'s"');
[b2,a2] zp2tf(z2,p2,k2);
[h2,w2] freqs(b2,a2,4096);

Design a bth-order elliptic filter with the same edge frequency, 3 dB of passband ripple, and 30 dB of
stopband attenuation. Compute its frequency response.

[ze,pe,ke] = ellip(n,3,30,2*%pi*f,'s");
[be,ae] zp2tf(ze,pe,ke);
[he,we] freqs(be,ae,4096);

Plot the attenuation in decibels. Express the frequency in gigahertz. Compare the filters.

plot(wb/(2e9*pi),mag2db(abs(hb)))
hold on
plot(wl/(2e9*pi),mag2db(abs(hl))
plot(w2/(2e9*pi),mag2db(abs(h2)))
plot(we/ (2e9*pi),mag2db(abs(he)))

axis([0 4 -40 5])

grid

xlabel('Frequency (GHz)"')
ylabel('Attenuation (dB)"')
legend('butter', 'chebyl', 'cheby2', 'ellip"')

—~ e~~~
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The Butterworth and Chebyshev Type 1I filters have flat passbands and wide transition bands. The
Chebyshev Type I and elliptic filters roll off faster but have passband ripple. The frequency input to
the Chebyshev Type II design function sets the beginning of the stopband rather than the end of the
passband.

See Also
butter | chebyl | cheby2 | ellip | freqs | zp2tf
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Frequency Response of Lowpass Bessel Filter

Design a fifth-order analog lowpass Bessel filter with approximately constant group delay up to 104
rad/second. Plot the magnitude and phase responses of the filter using freqs.

[b,a] = besself(5,10000);
freqs(b,a)
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Compute the group delay response of the filter as the derivative of the unwrapped phase response.
Plot the group delay to verify that it is approximately constant up to the cutoff frequency.

[h,w] = fregs(b,a,1000);
grpdel = diff(unwrap(angle(h)))./diff(w);

clf
semilogx(w(2:end),grpdel)
xlabel('Frequency (rad/s)")
ylabel('Group delay (s)")
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See Also
besself | freqs
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Speaker Crossover Filters

4-20

This example shows how to devise a simple model of a digital three-way loudspeaker. The system
splits the audio input into low-, mid-, and high-frequency bands that correspond respectively to the
woofer, the midrange driver, and the tweeter. Typical values for the normalized crossover frequencies
that delimit the bands are 0. 136 rad/sample and 0.317r rad/sample.

Create lowpass, bandpass, and highpass filters to generate the low-frequency, mid-frequency, and
high-frequency bands. Specify the frequencies.

0.136;
0.317;

lo
hi

Use a 6th-order Chebyshev Type I design for each filter. Specify a passband ripple of 1 dB, larger
than the value for real speakers. The cheby1 function doubles the order of bandpass designs. Make
all filters have the same order by halving the order of the bandpass filter. Return the zeros, poles, and
gain of each filter.

ord = 6;

rip = 1;

[zw, pw,kw] = chebyl(ord, rip,l0);
[zm,pm,km] = chebyl(ord/2,rip,[lo hil]);
[zt,pt,kt] = chebyl(ord,rip,hi, 'high");

Visualize the zeros and poles of the filters.

zplane([zw zm zt], [pw pm pt])
1g = legend('Woofer', 'Midrange', 'Tweeter');
1g.Box = 'off';
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» Woofer: The zeros at z = — 1 suppress high frequencies. The poles enhance the magnitude

response between 0 and the lower crossover frequency.

* Midrange: The zeros at z = 0 and z = 1 suppress high and low frequencies. The poles enhance the
magnitude response between the lower and higher crossover frequencies.

* Tweeter: The zeros at z = 1 suppress low frequencies. The poles enhance the magnitude response
between the higher crossover frequency and .

Plot the magnitude responses on the unit circle to see the effect of the different poles and zeros. Use
linear units. Represent the filters as second-order sections.

sw = zp2sos(zw, pw, kw) ;
sm = zp2sos(zm,pm,km);
st = zp2sos(zt,pt,kt);
nf = 1024;

[hw, fw] = freqz(sw,nf, 'whole');
hm = freqz(sm,nf, 'whole');

ht = freqz(st,nf, 'whole');
plot3(cos(fw),sin(fw), [abs(hw) abs(hm) abs(ht)])
xlabel('Real')

ylabel('Imaginary")

view(75,30)

grid
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Imaginary

Plot the magnitude responses in dB using fvtool.

hfvt = fvtool(sw,sm,st);
legend (hfvt, 'Woofer', 'Mid-range', 'Tweeter"')
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Load an audio file containing a fragment of Handel's "Hallelujah Chorus" sampled at 8192 Hz. Split
the signal into three frequency bands by filtering. Plot the bands.

load handel % To hear, type soundsc(y,Fs)
yw = sosfilt(sw,y); % To hear, type soundsc(yw,Fs)
ym = sosfilt(sm,y); % To hear, type soundsc(ym,Fs)
yt = sosfilt(st,y); % To hear, type soundsc(yt,Fs)

plot((0:1length

( 1)/Fs, [yw ym yt])
xlabel('Time (s

y)-
)")
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% To hear all the frequency ranges, type soundsc(yw+ym+yt,Fs)

References

Orfanidis, Sophocles J. Introduction to Signal Processing. Englewood Cliffs, NJ: Prentice Hall, 1996.

See Also
chebyl | freqz | FVIool | sosfilt | zp2sos | zplane

4-24



Filter Designer: A Filter Design and
Analysis App

* “Filter Design Methods” on page 5-2

» “Using the Filter Designer App” on page 5-4

* “Analyzing Filter Responses” on page 5-5

* “Filter Designer App Panels” on page 5-6

* “Getting Help” on page 5-7

» “Getting Started with Filter Designer” on page 5-8

* “Importing a Filter Design” on page 5-21

* “FIR Bandpass Filter with Asymmetric Attenuation” on page 5-24
* “Arbitrary Magnitude Filter” on page 5-26



5 Filter Designer: A Filter Design and Analysis App

Filter Design Methods

The Filter Designer app is a user interface for designing and analyzing filters quickly. The app
enables you to design digital FIR or IIR filters by setting filter specifications, by importing filters from
your MATLAB workspace, or by adding, moving or deleting poles and zeros. It also provides tools for
analyzing filters, such as magnitude and phase response and pole-zero plots.

The Filter Designer app gives you access to the following Signal Processing Toolbox filter design

methods.
Design Method Function
Butterworth butter
Chebyshev Type I chebyl
Chebyshev Type II cheby?2
Elliptic ellip
Maximally Flat maxflat
Equiripple firpm
Least-squares firls
Constrained least-squares fircls
Complex equiripple cfirpm
Window firl

When using the window method, all Signal Processing Toolbox window functions are available, and
you can specify a user-defined window by entering its function name and input parameter.

Advanced Filter Design Methods

The following advanced filter design methods are available if you have DSP System Toolbox software.

Design Method Function
Constrained equiripple FIR firceqrip
Constrained-band equiripple FIR fircband
Generalized remez FIR firgr
Equiripple halfband FIR firhalfband
Least P-norm optimal FIR firlpnorm
Equiripple Nyquist FIR firnyquist
Interpolated FIR ifir

IIR comb notching or peaking iircomb
Allpass filter (given group delay) iirgrpdelay
Least P-norm optimal IIR iirlpnorm
Constrained least P-norm IIR iirlpnormc
Second-order IIR notch iirnotch
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Second-order IIR peaking (resonator) iirpeak
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Using the Filter Designer App

There are different ways that you can design filters using the Filter Designer app. For example:

* You can first choose a response type, such as bandpass, and then choose from the available FIR or
IIR filter design methods.

* You can specify the filter by its type alone, along with certain frequency- or time-domain
specifications such as passband frequencies and stopband frequencies. The filter you design is
then computed using the default filter design method and filter order.



Analyzing Filter Responses

Analyzing Filter Responses

Once you have designed your filter, you can display the filter coefficients and detailed filter
information, export the coefficients to the MATLAB workspace, or create a C header file containing
the coefficients.

You also can analyze different filter responses in the app or in a separate Filter Visualization Tool

(FVTool). The following filter responses are available:

Magnitude response (freqz)
Phase response (phasez)

Group delay (grpdelay)

Phase delay (phasedelay)
Impulse response (impz)

Step response (stepz)

Pole-zero plots (zplane)
Zero-phase response (zerophase)
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Filter Designer App Panels

The Filter Designer app has sidebar buttons that display particular panels in the lower half. The
panels are:

Design Filter. See “Choosing a Filter Design Method” on page 5-9 for more information. You use

this panel to

* Design filters from scratch.

* Modify existing filters designed with the app.

* Analyze filters.

Import filter. You use this panel to

* Import previously saved filters or filter coefficients that you have stored in the MATLAB
workspace.

* Analyze imported filters.

Pole-Zero Editor. See “Editing the Filter Using the Pole-Zero Editor” on page 5-13. You use this
panel to add, delete, and move poles and zeros in your filter design.

If you also have DSP System Toolbox product installed, additional panels are available:

Set quantization parameters — Use this panel to quantize double-precision filters that you design
with Filter Designer, quantize double-precision filters that you import into the app, and analyze
quantized filters.

Transform filter — Use this panel to change a filter from one response type to another.

Multirate filter design — Use this panel to create a multirate filter from your existing FIR design,
create CIC filters, and linear and hold interpolators.

If you have Simulink installed, this panel is available:

Realize Model — Use this panel to create a Simulink block containing the filter structure.



Getting Help

Getting Help

At any time, you can right-click or click the What's this? button, E to get information. You can also
use the Help menu to see complete Help information.
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Getting Started with Filter Designer

The Filter Designer app enables you to design and analyze digital filters. You can also import and
modify existing filter designs.

To open the Filter Designer app, type

filterDesigner

at the MATLAB command prompt.

The Filter Designer app opens with the Design Filter panel displayed.

i '

File Edit Analysis Targets View Window Help
NEHER @<« i0 0EUOM2 40 B0 W

— Fitter Specifications

rCurrent Filter Infoermation

Mag. (dB)

Structure: Direct-Form FIR
Order: 50

Stable: Yes

Source: Designed

Fe2  f(H2)

[ Store Filter ...

[ Filter Manager ...

—ResponseType— __ Filter Order — Freguency Specifications — Magnitude Specifications
@ Lowpass | () Specify order: [10 Units: |Hz | Units: |dB
(") Highpass

(@ Minimum order Fe:  |48000
) Bandpass Apass |1

() Bandstop — Options Fpass (%600

: _ Astop B0
! | Differentiator | Density Factor: |20 Fstop 12000
|- Design Method

IR | Butterworth

@ FR |Eguiripple

Design Filter

Note that when you open Filter Designer, Design Filter is not enabled. You must make a change to
the default filter design in order to enable Design Filter. This is true each time you want to change
the filter design. Changes to radio button items or drop down menu items such as those under
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Response Type or Filter Order enable Design Filter immediately. Changes to specifications in text
boxes such as Fs, Fpass, and Fstop require you to click outside the text box to enable Design Filter.

Choosing a Response Type

You can choose from several response types:

* Lowpass

* Raised cosine

* Highpass

* Bandpass

* Bandstop

» Differentiator

* Multiband

* Hilbert transformer
* Arbitrary magnitude

Additional response types are available if you have DSP System Toolbox software installed.

Note Not all filter design methods are available for all response types. Once you choose your
response type, this may restrict the filter design methods available to you. Filter design methods that
are not available for a selected response type are removed from the Design Method region of the app.

Choosing a Filter Design Method

You can use the default filter design method for the response type that you've selected, or you can
select a filter design method from the available FIR and IIR methods listed in the app.

To select the Remez algorithm to compute FIR filter coefficients, select the FIR radio button and
choose Equiripple from the list of methods.

Setting the Filter Design Specifications

Viewing Filter Specifications

The filter design specifications that you can set vary according to response type and design method.
The display region illustrates filter specifications when you select Analysis > Filter Specifications

or when you click the Filter Specifications toolbar button.

You can also view the filter specifications on the Magnitude plot of a designed filter by selecting View
> Specification Mask.

Filter Order

You have two mutually exclusive options for determining the filter order when you design an
equiripple filter:

* Specify order: You enter the filter order in a text box.
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* Minimum order: The filter design method determines the minimum order filter.

Note that filter order specification options depend on the filter design method you choose. Some filter
methods may not have both options available.

Options

The available options depend on the selected filter design method. Only the FIR Equiripple and FIR
Window design methods have settable options. For FIR Equiripple, the option is a Density Factor.
See firpm for more information. For FIR Window the options are Scale Passband, Window
selection, and for the following windows, a settable parameter:

Window Parameter

Chebyshev (chebwin) Sidelobe attenuation
Gaussian (gausswin) Alpha

Kaiser (kaiser) Beta

Taylor (taylorwin) Nbar and Sidelobe level
Tukey (tukeywin) Alpha

User Defined Function Name, Parameter

You can view the window in the Window Visualization Tool (WVTool) by clicking the View button.
Bandpass Filter Frequency Specifications
For a bandpass filter, you can set

* Units of frequency:

e Hz

* kHz

e MHz

* Normalized (0 to 1)
* Sample rate
* Passband frequencies
* Stopband frequencies

You specify the passband with two frequencies. The first frequency determines the lower edge of the
passband, and the second frequency determines the upper edge of the passband.

Similarly, you specify the stopband with two frequencies. The first frequency determines the upper
edge of the first stopband, and the second frequency determines the lower edge of the second
stopband.

Bandpass Filter Magnitude Specifications

For a bandpass filter, you can specify the following magnitude response characteristics:

* Units for the magnitude response (dB or linear)
» Passband ripple
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* Stopband attenuation

Computing the Filter Coefficients

Now that you've specified the filter design, click the Design Filter button to compute the filter
coefficients.

Note The Design Filter button is disabled once you've computed the coefficients for your filter
design. This button is enabled again once you make any changes to the filter specifications.

Analyzing the Filter
Displaying Filter Responses

You can view the following filter response characteristics in the display region or in a separate
window.

* Magnitude response

* Phase response

* Magnitude and Phase responses

* Group delay response

* Phase delay response

* Impulse response

* Step response

* Pole-zero plot

» Zero-phase response — available from the y-axis context menu in a Magnitude or Magnitude and
Phase response plot.

Note If you have DSP System Toolbox product installed, two other analyses are available: magnitude
response estimate and round-off noise power. These two analyses are the only ones that use filter
internals.

For descriptions of the above responses and their associated toolbar buttons and other Filter
Designer toolbar buttons, see FVTool.

You can display two responses in the same plot by selecting Analysis > Overlay Analysis and
selecting an available response. A second y-axis is added to the right side of the response plot. (Note
that not all responses can be overlaid on each other.)

You can also display the filter coefficients and detailed filter information in this region.

For all the analysis methods, except zero-phase response, you can access them from the Analysis
menu, the Analysis Parameters dialog box from the context menu, or by using the toolbar buttons. For
zero-phase, right-click the y-axis of the plot and select Zero-phase from the context menu.

You can overlay the filter specifications on the Magnitude plot by selecting View > Specification
Mask.
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Using Data Tips

You can click the response to add plot data tips that display information about particular points on the
response.

For information on using data tips, see “Interactively Explore Plotted Data”.
Drawing Spectral Masks

To add spectral masks or rejection area lines to your magnitude plot, click View > User-defined
Spectral Mask.

The mask is defined by a frequency vector and a magnitude vector. These vectors must be the same
length.
* Enable Mask — Select to turn on the mask display.

* Normalized Frequency — Select to normalize the frequency between 0 and 1 across the
displayed frequency range.

* Frequency Vector — Enter a vector of x-axis frequency values.

* Magnitude Units — Select the desired magnitude units. These units should match the units used
in the magnitude plot.

* Magnitude Vector — Enter a vector of y-axis magnitude values.
Changing the Sample Rate

To change the sample rate of your filter, right-click any filter response plot and select Sampling
Frequency from the context menu.

To change the filter name, type the new name in Filter name. (In FVTool, if you have multiple filters,
select the desired filter and then enter the new name.)

To change the sample rate, select the desired unit from Units and enter the sample rate in Fs. (For
each filter in FVTool, you can specify a different sample rate or you can apply the sample rate to all
filters.)

To save the displayed parameters as the default values to use when Filter Designer or FVTool is
opened, click Save as Default.

To restore the default values, click Restore Original Defaults.
Displaying the Response in FVTool
To display the filter response characteristics in a separate window, select View > Filter

Visualization Tool (available if any analysis, except the filter specifications, is in the display region)
or click the Full View Analysis button. This starts the Filter Visualization Tool (FVTool).

Note If Filter Specifications are shown in the display region, clicking the Full View Analysis toolbar
button launches a MATLAB figure window instead of FVTool. The associated menu item is Print to
Figure, which is enabled only if the filter specifications are displayed.
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You can use this tool to annotate your design, view other filter characteristics, and print your filter
response. You can link Filter Designer and FVTool so that changes made in Filter Designer are
immediately reflected in FVTool. See FVTool for more information.

Editing the Filter Using the Pole-Zero Editor
Displaying the Pole-Zero Plot

You can edit a designed or imported filter's coefficients by moving, deleting, or adding poles or zeros
or both using the Pole-Zero Editor panel.

Note You cannot generate MATLAB code (File > Generate MATLAB code) if your filter was
designed or edited with the Pole-Zero Editor.

You cannot move quantized poles and zeros. You can only move the reference poles and zeros.

Click the Pole-Zero Editor button in the sidebar or select Edit > Pole-Zero Editor to display the
Pole-Zero Editor panel.

Poles are shown using "x" symbols and zeros are shown using "o0" symbols.
Changing the Pole-Zero Plot

Plot mode buttons are located to the left of the pole-zero plot. Select one of the buttons to change the
mode of the pole-zero plot. The Pole-Zero Editor has these buttons from left to right: Move Pole-
Zero, Add Pole, Add Zero, and Delete Pole-Zero.

Note For filters with orders larger than approximately 100, the Pole-Zero Editor might encounter
numerical problems when computing transfer function polynomials. As a result, the displayed filter
responses might be different than expected. To inspect poles and zeros without attempting to
compute high-order polynomials, select Analysis > Pole-Zero Plot. You cannot edit a filter in this
view.

The following plot parameters and controls are located to the left of the pole-zero plot and below the
plot mode buttons.

» Filter gain — factor to compensate for the filter's pole(s) and zero(s) gains

* Coordinates — units (Polar or Rectangular) of the selected pole or zero

* Magnitude — if polar coordinates is selected, magnitude of the selected pole or zero

* Angle — if polar coordinates is selected, angle of selected pole(s) or zero(s)

* Real — if rectangular coordinates is selected, real component of selected pole(s) or zero(s)

* Imaginary — if rectangular coordinates is selected, imaginary component of selected pole or zero
* Section — for multisection filters, number of the current section

* Conjugate — creates a corresponding conjugate pole or zero or automatically selects the
conjugate pole or zero if it already exists.

* Auto update — immediately updates the displayed magnitude response when poles or zeros are
added, moved, or deleted.
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The Edit > Pole-Zero Editor has items for selecting multiple poles or zeros, for inverting and
mirroring poles or zeros, and for deleting, scaling and rotating poles or zeros.

*  When you select a pole or zero from a conjugate pair, the Conjugate check box and the conjugate
are automatically selected.

Converting the Filter Structure
Converting to a New Structure

You can use Edit > Convert Structure to convert the current filter to a new structure. All filters can
be converted to the following representations:

* Direct-form I

* Direct-form II

* Direct-form I transposed

* Direct-form II transposed

* Lattice ARMA

Note If you have DSP System Toolbox product installed, you will see additional structures in the
Convert structure dialog box.

In addition, the following conversions are available for particular classes of filters:

* Minimum phase FIR filters can be converted to Lattice minimum phase
* Maximum phase FIR filters can be converted to Lattice maximum phase
» Allpass filters can be converted to Lattice allpass

+ [IR filters can be converted to Lattice ARMA

Note Converting from one filter structure to another might produce a result with different
characteristics than the original. This is due to the computer's finite-precision arithmetic and the
variations in the conversion's round-off computations.

For example:

* Select Edit > Convert Structure to open the Convert structure dialog box.
* Select Direct-form I in the list of filter structures.

Converting to Second-Order Sections

You can use Edit > Convert to Second-Order Sections to store the converted filter structure as a
collection of second-order sections rather than as a monolithic higher-order structure.

Note The following options are also used for Edit > Reorder and Scale Second-Order Sections,
which you use to modify an SOS filter structure.

The following Scale options are available when converting a direct-form II structure only:
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* None (default)
e L-2(L?norm)
e L-infinity (L” norm)

The Direction (Up or Down) determines the ordering of the second-order sections. The optimal
ordering changes depending on the Scale option selected.

For example:

* Select Edit > Convert to Second-Order Sections to open the Convert to SOS dialog box.
* Select L-infinity from the Scale menu for L* norm scaling.

* Leave Up as the Direction option.

Note To convert from second-order sections back to a single section, use Edit > Convert to Single
Section.

Exporting a Filter Design
Exporting Coefficients or Objects to the Workspace

You can save the filter either as filter coefficients variables or as a filter object variable. To save the
filter to the MATLAB workspace:
1  Select File > Export. The Export dialog box appears.

Select Workspace from the Export To menu.

Select Coefficients from the Export As menu to save the filter coefficients or select Objects
to save the filter in a filter object.

4  For coefficients, assign variable names using the Numerator (for FIR filters) or Numerator and
Denominator (for IIR filters), or SOS Matrix and Scale Values (for IIR filters in second-order
section form) text boxes in the Variable Names region.

For objects, assign the variable name in the Discrete Filter text box. If you have variables with
the same names in your workspace and you want to overwrite them, select the Overwrite
Variables check box.

5 Click the Export button.
Exporting Coefficients to an ASCII File

To save filter coefficients to a text file,

Select File > Export. The Export dialog box appears.
Select Coefficients File (ASCII) from the Export To menu.
Click the Export button. The Export Filter Coefficients to FCF File dialog box appears.

A W N R

Choose or enter a file name and click the Save button.

The coefficients are saved in the text file that you specified, and the MATLAB Editor opens to display
the file. The text file also contains comments with the MATLAB version number, the Signal Processing
Toolbox version number, and filter information.
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Exporting Coefficients or Objects to a MAT-File

To save filter coefficients or a filter object as variables in a MAT-ile:

6

Select File > Export. The Export dialog box appears.
Select MAT - file from the Export To menu.

Select Coefficients from the Export As menu to save the filter coefficients or select Objects
to save the filter in a filter object.

For coefficients, assign variable names using the Numerator (for FIR filters) or Numerator and
Denominator (for IIR filters), or SOS Matrix and Scale Values (for IIR filters in second-order
section form) text boxes in the Variable Names region.

For objects, assign the variable name in the Discrete Filter (or Quantized Filter) text box. If
you have variables with the same names in your workspace and you want to overwrite them,
select the Overwrite Variables check box.

Click the Export button. The Export to a MAT-File dialog box appears.
Choose or enter a file name and click the Save button.

Exporting to a Simulink Model

If you have the Simulink product installed, you can export a Simulink block of your filter design and
insert it into a new or existing Simulink model.

You can export a filter designed using any filter design method available in Filter Designer.

Note If you have the DSP System Toolbox and Fixed-Point Designer™ installed, you can export a CIC
filter to a Simulink model.

After designing your filter, click the Realize Model sidebar button or select File > Export to
Simulink Model. The Realize Model panel is displayed.

Specify the name to use for your block in Block name.

To insert the block into the current (most recently selected) Simulink model, set the Destination
to Current. To inset the block into a new model, select New. To insert the block into a user-
defined subsystem, select User defined.

If you want to overwrite a block previously created from this panel, check Overwrite generated
“Filter' block.

If you select the Build model using basic elements check box, your filter is created as a
subsystem (Simulink) block, which uses separate sub-elements. In this mode, the following
optimization(s) are available:

* Optimize for zero gains — Removes zero-valued gain paths from the filter structure.

* Optimize for unity gains — Substitutes a wire (short circuit) for gains equal to 1 in the
filter structure.

* Optimize for negative gains — Substitutes a wire (short circuit) for gains equal to -1
and changes corresponding additions to subtractions in the filter structure.

* Optimize delay chains — Substitutes delay chains composed of n unit delays with a
single delay of n.
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* Optimize for unity scale values — Removes multiplications for scale values equal to
1 from the filter structure.

The following illustration shows the effects of some of the optimizations:
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Note The Build model using basic elements check box is enabled only when you have a DSP
System Toolbox license and your filter can be designed using a Biquad Filter block or a Discrete

FIR Filter block. For more information, see the Filter Realization Wizard topic in the DSP System
Toolbox documentation.

6 Set the Input processing parameter to specify whether the generated filter performs sample- or
frame-based processing on the input. Depending on the type of filter you design, one or both of
the following options may be available:

* Columns as channels (frame based) — When you select this option, the block treats
each column of the input as a separate channel.

* Elements as channels (sample based) — When you select this option, the block treats
each element of the input as a separate channel.

7  Click the Realize Model button to create the filter block. When the Build model using basic
elements check box is selected, Filter Designer implements the filter as a subsystem block
using Add, Gain, and Delay blocks.

If you double-click the Simulink Filter block, the filter structure is displayed.
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Generating a C Header File

You may want to include filter information in an external C program. To create a C header file with
variables that contain filter parameter data, follow this procedure:
1 Select Targets > Generate C Header. The Generate C Header dialog box appears.

2 Enter the variable names to be used in the C header file. The particular filter structure
determines the variables that are created in the file.

Filter Structure Variable Parameter

Direct-form I Numerator, Numerator length, Denominator,
Denominator length

Direct-form II
Direct-form I transposed

Direct-form II transposed

Lattice ARMA Lattice coeff., Lattice coeff. length, Ladder coeff., Ladder
coeff. length

Lattice MA Lattice coeff., Lattice coeff. length, and Number of
sections (inactive if filter has only one section)

Direct-form FIR Direct- Numerator, Numerator length, and Number of sections

form FIR transposed (inactive if filter has only one section)

Length variables contain the total number of coefficients of that type.

Note Variable names cannot be C language reserved words, such as for.

3 Select Export Suggested to use the suggested data type or select Export As and select the
desired data type from the pull-down.

Note If you do not have DSP System Toolbox software installed, selecting any data type other
than double-precision floating point results in a filter that does not exactly match the one you
designed in the Filter Designer. This is due to rounding and truncating differences.

4 Click Generate to save the file and leave the dialog box open for additional C header file
definitions. To close the dialog box, click Close.

Generating MATLAB Code

You can generate MATLAB code that constructs the filter you designed in Filter Designer from the
command line. Select File > Generate MATLAB Code > Filter Design Function and specify the
file name in the Generate MATLAB code dialog box.

Note You cannot generate MATLAB code (File > Generate MATLAB Code > Filter Design
Function) if your filter was designed or edited with the Pole-Zero Editor.

The following is generated MATLAB code for the default lowpass filter in Filter Designer.
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function Hd = ExFilter
%SEXFILTER Returns a discrete-time filter object.

MATLAB Code
Generated by MATLAB(R) 7.11 and the Signal Processing Toolbox 6.14.

Generated on: 17-Feb-2010 14:15:37

0° o° 0% P o° o°

o°

Equiripple Lowpass filter designed using the FIRPM function.

o°

All frequency values are in Hz.
Fs = 48000; % Sample Rate

Fpass = 9600; % Passband Frequency
Fstop = 12000; % Stopband Frequency
Dpass = 0.057501127785; % Passband Ripple
Dstop = 0.0001; % Stopband Attenuation
dens = 20; % Density Factor

% Calculate the order from the parameters using FIRPMORD.
[N, Fo, Ao, W] = firpmord([Fpass, Fstopl/(Fs/2), [1 0], [Dpass, Dstopl);

% Calculate the coefficients using the FIRPM function.
b = firpm(N, Fo, Ao, W, {dens});

Hd = dfilt.dffir(b);

% [EOF]

Managing Filters in the Current Session

You can store filters designed in the current Filter Designer session for cascading together,
exporting to FVTool or for recalling later in the same or future Filter Designer sessions.

You store and access saved filters with the Store Filter and Filter Manager buttons, respectively, in
the Current Filter Information pane.

Store Filter — Displays the Store Filter dialog box in which you specify the filter name to use when
storing the filter in the Filter Manager. The default name is the type of the filter.

Filter Manager — Opens the Filter Manager.
The current filter is listed below the list box. To change the current filter, highlight the desired filter.
If you select Edit current filter, Filter Designer displays the currently selected filter specifications.

If you make any changes to the specifications, the stored filter is updated immediately.

To cascade two or more filters, highlight the desired filters and press Cascade. A new cascaded filter
is added to the Filter Manager.

To change the name of a stored filter, press Rename. The Rename filter dialog box is displayed.
To remove a stored filter from the Filter Manager, press Delete.

To export one or more filters to FVTool, highlight the filter(s) and press FVTool.
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Saving and Opening Filter Design Sessions
You can save your filter design session as a MAT-file and return to the same session another time.

Select the Save Session button to save your session as a MAT-file. The first time you save a session, a
Save Filter Design Session browser opens, prompting you for a session name.

The . fda extension is added automatically to all filter design sessions you save.

Note You can also use File > Save Session and File > Save Session As to save a session.

You can load existing sessions into Filter Designer by selecting the Open Session button or File >
Open Session . A Load Filter Design Session browser opens that allows you to select from your
previously saved filter design sessions.

5-20



Importing a Filter Design

Importing a Filter Design

In this section...

“Import Filter Panel” on page 5-21
“Filter Structures” on page 5-21

Import Filter Panel

The Import Filter panel allows you to import a filter. You can access this region by clicking the
Import Filter button in the sidebar.

— Filter Coefficient

Filker Structure: Sampling Frequency:

| Direct form I transposed x| Mumerator [[0.028 0.0530.071 0.0530.028] Clear | Units' [Momalzed (0t 1] 7|
I Import as second-order-sections  D'enominator: |11 000 -2.026 2,148 -1.159 0.279) Clear | Fs: [Fs

Import Filker |

The imported filter can be in any of the representations listed in the Filter Structure pull-down
menu. You can import a filter as second-order sections by selecting the check box.

Specify the filter coefficients in Numerator and Denominator, either by entering them explicitly or
by referring to variables in the MATLAB workspace.

Select the frequency units from the following options in the Units menu, and for any frequency unit
other than Normalized, specify the value or MATLAB workspace variable of the sample rate in the Fs
field.

To import the filter, click the Import Filter button. The display region is automatically updated when
the new filter has been imported.

You can edit the imported filter using the Pole-Zero Editor panel.

Filter Structures

The available filter structures are:
» Direct Form, which includes direct-form I, direct-form II, direct-form I transposed, direct-form II
transposed, and direct-form FIR

* Lattice, which includes lattice allpass, lattice MA min phase, lattice MA max phase, and lattice
ARMA

» Discrete-time Filter (dfilt object)

The structure that you choose determines the type of coefficients that you need to specify in the text
fields to the right.
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Direct-form

For direct-form I, direct-form II, direct-form I transposed, and direct-form II transposed, specify the
filter by its transfer function representation

_ b(1) +b2)z~  +b3)z™% + ..b(m + 1)z™™

H(Z) -1 -3 —
al) +a)z”* +a3)Z"° + ...aln+ D)z"

* The Numerator field specifies a variable name or value for the numerator coefficient vector b,
which contains m+1 coefficients in descending powers of z.

* The Denominator field specifies a variable name or value for the denominator coefficient vector
a, which contains n+1 coefficients in descending powers of z. For FIR filters, the Denominator
is 1.

Filters in transfer function form can be produced by all of the Signal Processing Toolbox filter design
functions (such as firl, fir2, firpm, butter, yulewalk). See “Transfer Function” on page 1-33
for more information.

Importing as second-order sections

For all direct-form structures, except direct-form FIR, you can import the filter in its second-order
section representation:

L bok + blkl_l + b2k2_2

Hi2) =G 5

k=1 dok + a1x2” T+ agkz”

The Gain field specifies a variable name or a value for the gain G, and the SOS Matrix field specifies
a variable name or a value for the L-by-6 SOS matrix

bo1 b1y b1 1 app ap

boa b1z by 1 ajp ap
SOS =

bor, bir bpr, 1 ayg, ayyp,

whose rows contain the numerator and denominator coefficients b, and a;; of the second-order
sections of H(z).

Filters in second-order section form can be produced by functions such as tf2sos, zp2s0s, ss2s0s,
and sosfilt. See “Second-Order Sections (SOS)” on page 1-35 for more information.

Lattice

For lattice allpass, lattice minimum and maximum phase, and lattice ARMA filters, specify the filter
by its lattice representation:

+ For lattice allpass, the Lattice coeff field specifies the lattice (reflection) coefficients, k(1) to
k(N), where N is the filter order.

+ For lattice MA (minimum or maximum phase), the Lattice coeff field specifies the lattice
(reflection) coefficients, k(1) to k(N), where N is the filter order.
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» For lattice ARMA, the Lattice coeff field specifies the lattice (reflection) coefficients, k(1) to
k(N), and the Ladder coeff field specifies the ladder coefficients, v(1) to v(N+1), where N is the
filter order.

Filters in lattice form can be produced by tf2latc. See “Lattice Structure” on page 1-36 for more
information.

Discrete-time Filter (dfilt object)

For Discrete-time filter, specify the name of the dfilt object.
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FIR Bandpass Filter with Asymmetric Attenuation

Use the Filter Designer app to create a 50th-order equiripple FIR bandpass filter to be used with
signals sampled at 1 kHz.

N = 50;
Fs = 1e3;

Specify that the passband spans frequencies of 200-300 Hz and that the transition region on either
side has a width of 50 Hz.

Fstopl = 150;
Fpassl = 200;
Fpass2 = 300;
Fstop2 = 350;

Specify weights for the optimization fit:

* 3 for the low-frequency stopband
* 1 for the passband
* 100 for the high-frequency stopband

Open the Filter Designer app.

Wstopl = 3;
Wpass = 1;
Wstop2 = 100;
filterDesigner

Use the app to design the rest of the filter. To specify the frequency constraints and magnitude
specifications, use the variables you created.

Set Response Type to Bandpass.

Set Design Method to FIR. From the drop-down list, select Equiripple.

Under Filter Order, specify the order as N.

Under Frequency Specifications, specify Fs as Fs.

Click Design Filter.

ga A W N R
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FIR Bandpass Filter with Asymmetric Attenuation

-
3 Filter Designer - [untitled.fda *] E‘_lg

File Edit Analysis Targets View Window Help

BEHSR Q< id D HEENE# 40 Bk R

rCurrent Filter Information

— Magnitude Response (dB)

Structure: Direct-Form FIR
Order: 50

Stable: Yes
Source: Designed

ra
(=
_‘_,-"'

YY) -

Magnitude (dB)
& &
G G

80t Y " . | A ATATATATAY
[ Store Filter ... |

0 200 250 300 350 400 450
[ Fiter Manager ... |

Frequency (Hz)

— Response Type

— Fitter Order

— Frequency Specifications — Magnitude Specifications
@ Specify order. |N Units: |Hz

Enter a weight value for
= each band below.
() Minimum order Fs: |Fs

Wstop1: |Wstop1
— Options Fstop1. |Fstopt

Differentiator Density Factor: |20

Wpass: VWpass
] Fpass1: |Fpassi
|- Design Method —————

Wstop2: |Wstop2
= 7 Fpazs2: |Fpass2
VIR | Butterworth |

= 7 Fstop2: |Fstop2
@ FIR |Equiripple |

Design Filter
Designing Filter ... Done

See Also

Apps
Filter Designer

Functions
designfilt
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Arbitrary Magnitude Filter

5-26

Design an FIR filter with the following piecewise frequency response:

* A sinusoid between 0 and 0.19m rad/sample.

F
A

1
1

0:0.01:0.19;
0.5+sin(2*pi*7.5*F1)/4;

* A piecewise linear section between 0.2 rad/sample and 0.78m rad/sample.

F
A

[0.2 0.38 0.4 0.55 0.562 0.585 0.6 0.78];

2
2 [0.52.311 -0.2 -0.211],;

* A quadratic section between 0.791 rad/sample and the Nyquist frequency.

F
A

0.79:0.01:1;

3 =
3 =0.2+418*%(1-F3)."2;

Specify a filter order of 50. Consolidate the frequency and amplitude vectors. To give all bands equal
weights during the optimization fit, specify a weight vector of all ones. Open the Filter Designer

app.

N = 50;

FregVect = [F1 F2 F3];
AmplVect = [Al A2 A3];
WghtVect = ones(1,N/2);
filterDesigner

Use the app to design the filter.

1

Under Response Type, select the button next to Differentiator. From the drop-down list,
choose Arbitrary Magnitude.

Set Design Method to FIR. From the drop-down list, select Least-squares.
Under Filter Order, specify the order as the variable N.
Under Frequency and Magnitude Specifications, specify the variables you created:

* Freq. vector — FregVect.

* Mag. vector — AmplVect.

* Weight vector — WghtVect.
Click Design Filter.

Right-click the y-axis of the plot and select Magnitude to express the magnitude response in
linear units.



Arbitrary Magnitude Filter

i '

File Edit Analysis Targets View Window Help

DedSh Q< i D BN # S 00— Bk |8

~Current Filter Information ————— — Magnitude Response
2t A .
[
Structure: Direct-Form FIR \
ﬂJ - 1 -
Order: 50 'g 1.5 ’/ |
Stabler  Yes = \_,
Spurce:  Designed % 1r / "x_/\"nl \\_/"‘\_.~ i
E - III|
| .
osf \/ ]
D _ 1 1 1 1 1 L 1 1 1 1 -\-:
[ Store Fitter ... | 0O 01 02 03 04 05 06 07 08 09
[ Filter Manager .. | MNormalized Frequency (= rad/sample)

— Response Type————— __Filter Order — Freguency and Magnitude Specifications

) |Lowpass | {@ Specify order: |N Frequency Units | Normalized (0to 1)
() Highpass

= Kinimum order Freq. vector |FreqVWect
(") Bandpass

(") Bandstop — Options Mag. vector  |AmpMect
© | Arbitrary Magnitude v |

: ey Ta &) There are no optional Weight vector |Wghtvect
eE e parameters for this design
method.

IR |Butterwaorth

@ FIR |Least-squares

Design Filter
Designing Filter ... Done

See Also

Apps
Filter Designer

Functions
designfilt
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Filter Visualization Tool

* “Modifying the Axes” on page 6-2
* “Modifying the Plot” on page 6-4
* “Controlling FVTool from the MATLAB Command Line” on page 6-6
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Modifying the Axes

You can change the x- or y-axis units by right-clicking the mouse on the axis label or by right-clicking
on the plot and selecting Analysis Parameters.

Linear Frequency

Plot X-Axis Units Y-Axis Units
Magnitude Normalized Frequency Magnitude
Linear Frequency Magnitude (dB)
Magnitude squared
Zero-Phase
Phase Normalized Frequency Phase
Linear Frequency Continuous Phase
Degrees
Radians
Magnitude and Phase Normalized Frequency (y-axis on left side)

Magnitude
Magnitude (dB)
Magnitude squared
Zero-Phase

(y-axis on right side)
Phase
Continuous Phase

Degrees
Radians
Group Delay Normalized Frequency Samples
Linear Frequency Time
Phase Delay Normalized Frequency Degrees
Linear Frequency Radians
Impulse Response Samples Amplitude
Time
Step Response Samples Amplitude
Time
Pole-Zero Real Part Imaginary Part
See Also
Apps

Signal Analyzer | Filter Designer

Functions

designfilt | digitalFilter

Related Examples

. “Filter Analysis Using FVTool” on page 25-204




Modifying the Axes

More About
. “Modifying the Plot” on page 6-4
. “Controlling FVTool from the MATLAB Command Line” on page 6-6
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Modifying the Plot

6-4

In FVTool, you can interactively change view settings, set analysis parameters, and specify sampling
frequency for the displayed analysis. In the toolstrip, select an option from the View or Analysis
sections. You can also access the analysis parameters and sampling frequency menus by right-
clicking on the plot.

To change the properties of a plot, first click the Send to Figure button in the toolstrip to open a
new figure window and then use any of the buttons in the plot editing toolbar.

Analysis Parameters contains parameter settings applicable to the displayed analysis. If more than
one analysis is displayed, FVTool shows only the parameters specific to the current plot. You can
modify any of these parameter settings.

* Normalized Frequency — Check the box to normalize the frequency between 0 and 1. If not
checked, the frequency is in hertz.
* Frequency Scale — Set the frequency scale of the y-axis scale to Linear or Log.

+ Frequency Range — Set the range of the frequency axis or select Specify freq. vector to
specify a frequency vector.

* Number of Points — Specify the number of samples to use to compute the response.

* Frequency Vector — Specify the frequency vector to use for plotting, if Specify freq.
vector is selected in Frequency Range.

* Magnitude Display — Set they-axis units for magnitude to Magnitude, Magnitude (dB),
Magnitude squared, or Zero-Phase.

* Phase Units — Set the y-axis units for phase to Degrees or Radians.

* Phase Display — Specify the type of phase plot as Phase or Continuous Phase.

* Group Delay Units — Set they-axis units for group delay to Samples or Time.

* Specify Length — Specify the length of the impulse or step response as Default or Specified.

* Length — Specify the number of points to use for the impulse or step response.

Note Not all of these analysis fields are available for all types of plots.

In addition to these analysis parameters, you can

* change the plot type for the Impulse Response and Step Response plots by right-clicking and
selecting Line with Marker, Stem or Line from the context menu.

* change the x-axis units by right-clicking the x-axis label and selecting Samples or Time.

* save the displayed parameters as the default values to use when Filter Designer or FVTool is
opened by clicking Save as Default. To restore the default values, click Restore Original
Defaults.

+ display information about a particular point in the plot. For more information on data tips, see
“Interactively Explore Plotted Data”.

* zoom to the passband region. To use passband zoom, your filter must have been designed using
fdesign or Filter Designer. Passband zoom is not provided for cascaded integrator-comb (CIC)
filters because CICs do not have conventional passbands.
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Note If you have the DSP System Toolbox software, FVTool displays a specification mask along with
your designed filter on a magnitude plot.

See Also

Apps
Signal Analyzer | Filter Designer

Functions
designfilt |digitalFilter

Related Examples
. “Filter Analysis Using FVTool” on page 25-204

More About
. “Modifying the Axes” on page 6-2
. “Controlling FVTool from the MATLAB Command Line” on page 6-6
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Controlling FVTool from the MATLAB Command Line

6-6

After you obtain the handle for FVTool, you can control some aspects of FVTool from the command
line. In addition to the standard Handle Graphics® properties (see Handle Graphics in the MATLAB
documentation), FVTool has these properties.

* Analysis — Displays the specified type of analysis plot. This table lists all analysis types and how
to invoke them. Note that the only analyses that use filter internals are magnitude response
estimate and round-off noise power, which are available only with the DSP System Toolbox

product.
Analysis Type Analysis Option
Magnitude plot "magnitude”
Phase plot "phase"
Magnitude and phase plot "freq"
Group delay plot "grpdelay"
Phase delay plot "phasedelay"
Impulse response plot "impulse"
Step response plot "step"
Pole-zero plot "polezero"
Filter coefficients "coefficients"
Filter information "info"
Magnitude response estimate "magestimate"
(Available only with the DSP System Toolbox
product. For more information, see
freqrespest.)
Round-off noise power "“noisepower"
(Available only with the DSP System Toolbox
product. For more information, see
noisepsd.)

* Grid — Controls whether the grid is "on" or "off".
* Legend — Controls whether the legend is "on" or "off".

* Fs — Controls the sampling frequency of filters in FVTool. The sampling frequency vector must be
of the same length as the number of filters or a scalar value. If it is a vector, FVTool applies each
value to its corresponding filter. If it is a scalar, FVTool applies the same value to all filters.

* SosViewSettings — (This option is available only if you have the DSP System Toolbox product.)
For second-order sections filters, this controls how the filter is displayed. The SOSViewSettings
property contains an object so you must use this syntax to set it:
set(h.S0SViewSettings,View=viewtype), where viewtype is one of these:

* Complete — Displays the complete response of the overall filter.

* Individual — Displays the response of each section separately.

* Cumulative — Displays the response for each section accumulated with each prior section. If
your filter has three sections, the first plot shows section one, the second plot shows the
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accumulation of sections one and two, and the third plot show the accumulation of all three
sections.

You can also specify secondary scaling, which determines where the sections should be split.
The secondary scaling points are the scaling locations between the recursive and the
nonrecursive parts of the section. By default, the display does not use secondary scaling. To
turn on secondary scaling, use this syntax.
set(h.S0SViewSettings,View="Cumulative",SecondaryScaling=true)

* UserDefined — Allows you to define which sections to display and the order in which to
display them. Enter a cell array where each section is represented by its index. If you enter one
index, only that section is plotted. If you enter a range of indices, the combined response of
that range of sections is plotted. For example, if your filter has four sections, entering {1:4}
plots the combined response for all four sections, and entering {1, 2, 3,4} plots the response
for each section individually.

Note You can change other properties of FVTool from the command line using the set function. Use
get (h) to view property tags and current property settings.

You can use these methods with the FVTool handle.

addfilter(h,filtobj) adds a new filter to FVTool. The new filter, filtobj, must be a dfilt
filter object. You can specify the sampling frequency of the new filter with
addfilter(h,filtobj,Fs=10).

setfilter(h, filtobj) replaces the filter in FVTool with the filter specified in filtobj. You can
set the sampling frequency as described above.

deletefilter(h,index) deletes the filter at the FVTool cell array index location.

legend(h,strl,str2,...) creates alegend in FVTool by associating strl with filter 1, str2 with
filter 2, etc. For more information, see legend.

See Also

Apps
Signal Analyzer | Filter Designer

Functions
designfilt | digitalFilter

Related Examples
. “Filter Analysis Using FVTool” on page 25-204

More About
. “Modifying the Axes” on page 6-2
. “Modifying the Plot” on page 6-4






Statistical Signal Processing

The following chapter discusses statistical signal processing tools and applications, including

correlations, covariance, and spectral estimation.

“Correlation and Covariance” on page 7-2

“Spectral Analysis” on page 7-5

“Nonparametric Methods” on page 7-8

“Parametric Methods” on page 7-27

“MUSIC and Eigenvector Analysis Methods” on page 7-37
“Selected Bibliography” on page 7-39
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Correlation and Covariance

7-2

In this section...

“Background Information” on page 7-2
“Using xcorr and xcov Functions” on page 7-2
“Bias and Normalization” on page 7-3

“Multiple Channels” on page 7-3

Background Information
The cross-correlation sequence for two wide-sense stationary random process, x(n) and y(n) is

Ryy(m) = E{x(n + m)y*(n)},

where the asterisk denotes the complex conjugate and the expectation is over the ensemble of
realizations that constitute the random processes.

Note that cross-correlation is not commutative, but a Hermitian (conjugate) symmetry property holds
such that:

Ryy(m) = Ri'jx( - m).
The cross-covariance between x(n) and y(n) is:

ny E{ (n+m) - py) (y(n) - Ily } ny m) — HxHy™ .

For zero-mean wide-sense stationary random processes, the cross-correlation and cross-covariance
are equivalent.

In practice, you must estimate these sequences, because it is possible to access only a finite segment
of the infinite-length random processes. Further, it is often necessary to estimate ensemble moments
based on time averages because only a single realization of the random processes are available. A
common estimate based on N samples of x(n) and y(n) is the deterministic cross-correlation sequence
(also called the time-ambiguity function)

~ g x(n + m)y*(n), m =z 0,
ny(m) = =

n
Ii;(— m), m < 0.

where we assume for this discussion that x(n) and y(n) are indexed from 0 to N - 1, and R Xy(m) from -
(N-1)toN-1.

Using xcorr and xcov Functions

The functions xcorr and xcov estimate the cross-correlation and cross-covariance sequences of
random processes. They also handle autocorrelation and autocovariance as special cases. The xcorr
function evaluates the sum shown above with an efficient FFT-based algorithm, given inputs x(n) and
y(n) stored in length N vectors x and y. Its operation is equivalent to convolution with one of the two
subsequences reversed in time.
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For example:

X [11111]";
y =X
Xyc = xcorr(x,y)

Notice that the resulting sequence length is one less than twice the length of the input sequence.
Thus, the Nth element is the correlation at lag 0. Also notice the triangular pulse of the output that
results when convolving two square pulses.

The xcov function estimates autocovariance and cross-covariance sequences. This function has the

same options and evaluates the same sum as xcorr, but first removes the means of x and y.

Bias and Normalization

An estimate of a quantity is biased if its expected value is not equal to the quantity it estimates. The
expected value of the output of xcorr is

E{Ryy(m)} = (N = [m|)Ry,(m).

xcorr provides the unbiased estimate, dividing by N - |m| when you specify an 'unbiased' flag
after the input sequences.

xcorr(x,y, 'unbiased")

Although this estimate is unbiased, the end points (near -(N - 1) and N - 1) suffer from large variance
because xcorr computes them using only a few data points. A possible trade-off is to simply divide by
N using the 'biased' flag:

xcorr(x,y, 'biased")

With this scheme, only the sample of the correlation at zero lag (the Nth output element) is unbiased.
This estimate is often more desirable than the unbiased one because it avoids random large
variations at the end points of the correlation sequence.

xcorr provides one other normalization scheme. The syntax
xcorr(x,y, 'coeff")

divides the output by norm(x)*norm(y) so that, for autocorrelations, the sample at zero lag is 1.

Multiple Channels

For a multichannel signal, xcorr and xcov estimate the autocorrelation and cross-correlation and
covariance sequences for all of the channels at once. If S is an M-by-N signal matrix representing N
channels in its columns, xcorr(S) returns a (2M - 1)-by-N? matrix with the autocorrelations and
cross-correlations of the channels of S in its N? columns. If S is a three-channel signal

S = [s1 s2 s3]
then the result of xcorr(S) is organized as

R = [Rslsl Rs1s2 Rs1s3 Rs2sl Rs2s2 Rs2s3 Rs3sl Rs3s2 Rs3s3]
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Two related functions, cov and corrcoef, are available in the standard MATLAB environment. They
estimate covariance and normalized covariance respectively between the different channels at lag 0
and arrange them in a square matrix.



Spectral Analysis

Spectral Analysis

In this section...
“Background Information” on page 7-5
“Spectral Estimation Method” on page 7-6

Background Information

The goal of spectral estimation is to describe the distribution (over frequency) of the power contained
in a signal, based on a finite set of data. Estimation of power spectra is useful in a variety of
applications, including the detection of signals buried in wideband noise.

The power spectral density (PSD) of a stationary random process x(n) is mathematically related to the
autocorrelation sequence by the discrete-time Fourier transform. In terms of normalized frequency,
this is given by

1 .
Py (w) = 20 2 Ryx(m)e™J/@m,
m= —

o0

This can be written as a function of physical frequency f (for example, in hertz) by using the relation
w = 20f | f,, where f; is the sampling frequency:

Pw(f) = L E Rxx(m)e_jznmf/fs-

Fsm 2
The correlation sequence can be derived from the PSD by use of the inverse discrete-time Fourier
transform:
is fsl2 '
Ram) = [ Po@eindo= [ Pyt dr.
- _fs/2

The average power of the sequence x(n) over the entire Nyquist interval is represented by

fsl2

hig
Ry (0) = f P (w)dw = f Po(f)df .
- —fsl2

The average power of a signal over a particular frequency band [w;, w,], 0 < w; < w, < 1, can be
found by integrating the PSD over that band:

— w2 -w1
P[‘*’LWZ] = ﬁl PXX(w) dw = fwz Pxx(w) dw .

You can see from the above expression that P, (w) represents the power content of a signal in an
infinitesimal frequency band, which is why it is called the power spectral density.

The units of the PSD are power (e.g., watts) per unit of frequency. In the case of P,,(w), this is watts/
radian/sample or simply watts/radian. In the case of P,,(f), the units are watts/hertz. Integration of
the PSD with respect to frequency yields units of watts, as expected for the average power.

7-5
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For real-valued signals, the PSD is symmetric about DC, and thus P,,(w) for 0 < w < m is sufficient to
completely characterize the PSD. However, to obtain the average power over the entire Nyquist
interval, it is necessary to introduce the concept of the one-sided PSD.

The one-sided PSD is given by

Pone-sided(w) = {2}3 ()
xx\W),

The average power of a signal over the frequency band, [w;,w,] with 0 < w; < w, < m, can be
computed using the one-sided PSD as

_ wy
Play,wp1= [,; Pone-sided(@)dw .

Spectral Estimation Method

The various methods of spectrum estimation available in the toolbox are categorized as follows:

* Nonparametric methods
* Parametric methods
* Subspace methods

Nonparametric methods are those in which the PSD is estimated directly from the signal itself. The
simplest such method is the periodogram. Other nonparametric techniques such as Welch's
method [8], the multitaper method (MTM) reduce the variance of the periodogram.

Parametric methods are those in which the PSD is estimated from a signal that is assumed to be
output of a linear system driven by white noise. Examples are the Yule-Walker autoregressive (AR)
method and the Burg method. These methods estimate the PSD by first estimating the parameters
(coefficients) of the linear system that hypothetically generates the signal. They tend to produce
better results than classical nonparametric methods when the data length of the available signal is
relatively short. Parametric methods also produce smoother estimates of the PSD than nonparametric
methods, but are subject to error from model misspecification.

Subspace methods, also known as high-resolution methods or super-resolution methods, generate
frequency component estimates for a signal based on an eigenanalysis or eigendecomposition of the
autocorrelation matrix. Examples are the multiple signal classification (MUSIC) method or the
eigenvector (EV) method. These methods are best suited for line spectra — that is, spectra of
sinusoidal signals — and are effective in the detection of sinusoids buried in noise, especially when
the signal to noise ratios are low. The subspace methods do not yield true PSD estimates: they do not
preserve process power between the time and frequency domains, and the autocorrelation sequence
cannot be recovered by taking the inverse Fourier transform of the frequency estimate.

All three categories of methods are listed in the table below with the corresponding toolbox function
names. More information about each function is on the corresponding function reference page. See
“Parametric Modeling” on page 8-18 for details about 1pc and other parametric estimation
functions.
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Spectral Estimation Methods/Functions

Method

Description

Functions

Periodogram

Power spectral density estimate

periodogram

Welch

Averaged periodograms of
overlapped, windowed signal
sections

pwelch, cpsd, tfestimate,
mscohere

Multitaper

Spectral estimate from combination
of multiple orthogonal windows (or
“tapers”)

pmtm

Yule-Walker AR

Autoregressive (AR) spectral
estimate of a time-series from its
estimated autocorrelation function

pyulear

Burg

Autoregressive (AR) spectral
estimation of a time-series by
minimization of linear prediction
erTors

pburg

Covariance

Autoregressive (AR) spectral
estimation of a time-series by
minimization of the forward
prediction errors

pcov

Modified Covariance

Autoregressive (AR) spectral
estimation of a time-series by
minimization of the forward and
backward prediction errors

pmcov

MUSIC

Multiple signal classification

pmusic

Eigenvector

Pseudospectrum estimate

peig

7-7
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Nonparametric Methods

The following sections discuss the periodogram on page 7-8, modified periodogram on page 7-15,
Welch on page 7-17, and multitaper on page 7-20 methods of nonparametric estimation, along with
the related CPSD function on page 7-23, transfer function estimate on page 7-24, and coherence
function on page 7-25.

Periodogram

In general terms, one way of estimating the PSD of a process is to simply find the discrete-time
Fourier transform of the samples of the process (usually done on a grid with an FFT) and
appropriately scale the magnitude squared of the result. This estimate is called the periodogram.

The periodogram estimate of the PSD of a signal x;(n) of length L is
-1 ] 2

2 XL(n)e—JZan/Fs '

=0

where Fs is the sampling frequency.

In practice, the actual computation of P,,(f) can be performed only at a finite number of frequency

points, and usually employs an FFT. Most implementations of the periodogram method compute the
N-point PSD estimate at the frequencies

kF
fk=Ws, k=0,1,..,N—1.

In some cases, the computation of the periodogram via an FFT algorithm is more efficient if the
number of frequencies is a power of two. Therefore it is not uncommon to pad the input signal with
zeros to extend its length to a power of two.

As an example of the periodogram, consider the following 1001-element signal xn, which consists of
two sinusoids plus noise:

fs = 1000; % Sampling frequency

t = (0:fs)/fs; % One second worth of samples
A=1[12]; % Sinusoid amplitudes (row vector)

f = [150;140]; % Sinusoid frequencies (column vector)

= A¥sin(2*pi*f*t) + 0.1l*randn(size(t));
The three last lines are equivalent to
Xn = sin(2*pi*150*t) + 2*sin(2*pi*140*t) + 0.1*randn(size(t));

o° o° X
>

The periodogram estimate of the PSD can be computed using periodogram. In this case, the data
vector is multiplied by a Hamming window to produce a modified periodogram.

[Pxx,F] = periodogram(xn,hamming(length(xn)),length(xn),fs);
plot(F,10*10ogl0(Pxx))

xlabel('Hz")

ylabel('dB")

title('Modified Periodogram Power Spectral Density Estimate')
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Modified Periodogram Power Spectral Density Estimate
1 D T T T T T T T T T

dB

1 | dl L [ -l
‘i k‘l’M (W“ / ‘1 f |R J'h 'lw'n | \ﬂ it

_a D i i i i i i i i i
0 50 100 150 200 250 300 350 400 450 500

Hz

Algorithm

Periodogram computes and scales the output of the FFT to produce the power vs. frequency plot as
follows.

1 [f the input signal is real-valued, the magnitude of the resulting FFT is symmetric with respect to
zero frequency (DC). For an even-length FFT, only the first (1 + nfft/2) points are unique.
Determine the number of unique values and keep only those unique points.

2  Take the squared magnitudes of the unique FFT values. Scale the squared magnitudes (except
for DC) by 2/(FsN), where N is the length of signal prior to any zero padding. Scale the DC value

by 1/(FsN).
3 Create a frequency vector from the number of unique points, the nfft and the sampling frequency.
Plot the resulting magnitude squared FFT against the frequency.

Performance of the Periodogram

The following sections discuss the performance of the periodogram with regard to the issues of
leakage, resolution, bias, and variance.

Spectral Leakage

Consider the PSD of a finite-length (length L) signal x;(n). It is frequently useful to interpret x; (n) as
the result of multiplying an infinite signal, x(n), by a finite-length rectangular window, wg(n):
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xg(n) = x(n)wg(n).

Because multiplication in the time domain corresponds to convolution in the frequency domain, the
expected value of the periodogram in the frequency domain is

Fs/2 sin(L(f — f')/Fs)

PXX ’ d "
Fsl2 1 sin®(a(f - £)/F,) (rydf

EPN} =5 [

showing that the expected value of the periodogram is the convolution of the true PSD with the
square of the Dirichlet kernel.

The effect of the convolution is best understood for sinusoidal data. Suppose that x(n) is composed of
a sum of M complex sinusoids:

N .
x(n)= > Al
k=1
Its spectrum is

N
X(w)= D Ablw - wy),
k=1

which for a finite-length sequence becomes

=

The preceding equation is equal to

N
> Arble — wy) |Wr(w - €) de.
k=1

N
X(w) = > AWgrw—wy).
k=1

So in the spectrum of the finite-length signal, the Dirac deltas have been replaced by terms of the
form Wg(w — wg), which corresponds to the frequency response of a rectangular window centered on

the frequency wy.

The frequency response of a rectangular window has the shape of a periodic sinc:

L = 32;
[h,w] = freqz(rectwin(L)/L,1);
y = diric(w,L);

plot(w/pi,20*loglO(abs(h)))

hold on

plot(w/pi,20*logl@O(abs(y)),'--")

hold off

ylim([-40,0])

legend('Frequency Response', 'Periodic Sinc')
xlabel('\omega / \pi')
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Frequency Response
5F — — —Periodic Sinc
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w/lm

The plot displays a mainlobe and several sidelobes, the largest of which is approximately 13.5 dB
below the mainlobe peak. These lobes account for the effect known as spectral leakage. While the
infinite-length signal has its power concentrated exactly at the discrete frequency points f%, the

windowed (or truncated) signal has a continuum of power "leaked" around the discrete frequency
points fy.

Because the frequency response of a short rectangular window is a much poorer approximation to the
Dirac delta function than that of a longer window, spectral leakage is especially evident when data
records are short. Consider the following sequence of 100 samples:

fs = 1000; % Sampling frequency

t = (0:fs/10)/fs; % One-tenth second worth of samples
A=1[12]; % Sinusoid amplitudes

f = [150;140]; % Sinusoid frequencies

xn = A*sin(2*pi*f*t) + 0.l*randn(size(t));
periodogram(xn, rectwin(length(xn)), 1024, fs)

7-11
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7-12

Periodogram Power Spectral Density Estimate
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It is important to note that the effect of spectral leakage is contingent solely on the length of the data
record. It is not a consequence of the fact that the periodogram is computed at a finite number of
frequency samples.

Resolution

Resolution refers to the ability to discriminate spectral features, and is a key concept on the analysis
of spectral estimator performance.

In order to resolve two sinusoids that are relatively close together in frequency, it is necessary for the
difference between the two frequencies to be greater than the width of the mainlobe of the leaked
spectra for either one of these sinusoids. The mainlobe width is defined to be the width of the
mainlobe at the point where the power is half the peak mainlobe power (i.e., 3 dB width). This width
is approximately equal to f/L.

In other words, for two sinusoids of frequencies f1 and f5, the resolvability condition requires that

Fs
fa-fi>1-
In the example above, where two sinusoids are separated by only 10 Hz, the data record must be

greater than 100 samples to allow resolution of two distinct sinusoids by a periodogram.

Consider a case where this criterion is not met, as for the sequence of 67 samples below:

fs = 1000; % Sampling frequency
t = (0:fs/15)/fs; % 67 samples
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A
f

[1 2]1; % Sinusoid amplitudes
[150;140]; % Sinusoid frequencies
xn = A*¥sin(2*pi*f*t) + 0.1*randn(size(t));
periodogram(xn, rectwin(length(xn)), 1024, fs)

Periodogram Power Spectral Density Estimate
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The above discussion about resolution did not consider the effects of noise since the signal-to-noise
ratio (SNR) has been relatively high thus far. When the SNR is low, true spectral features are much
harder to distinguish, and noise artifacts appear in spectral estimates based on the periodogram. The
example below illustrates this:

fs = 1000; % Sampling frequency

t = (0:fs/10)/fs; % One-tenth second worth of samples
A=1[12]; % Sinusoid amplitudes

f = [150;140]; % Sinusoid frequencies

xn = A*sin(2*pi*f*t) + 2*randn(size(t));
periodogram(xn, rectwin(length(xn)), 1024, fs)

7-13
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Periodogram Power Spectral Density Estimate
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Bias of the Periodogram

The periodogram is a biased estimator of the PSD. Its expected value was previously shown to be

E{P(f)} Py (f)df .

L sin’(La(f - f)/Fy)
F, F5/2Lsm (z(f = f)/Fs)

The periodogram is asymptotically unbiased, which is evident from the earlier observation that as the
data record length tends to infinity, the frequency response of the rectangular window more closely
approximates the Dirac delta function. However, in some cases the periodogram is a poor estimator of
the PSD even when the data record is long. This is due to the variance of the periodogram, as
explained below.

Variance of the Periodogram

The variance of the periodogram can be shown to be

PL(f), 0<f<Fy?2,

Var(Pxx(f)) = 2
2P(f), [ =0, Fs/2,
which indicates that the variance does not tend to zero as the data length L tends to infinity. In
statistical terms, the periodogram is not a consistent estimator of the PSD. Nevertheless, the
periodogram can be a useful tool for spectral estimation in situations where the SNR is high, and
especially if the data record is long.
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The Modified Periodogram

The modified periodogram windows the time-domain signal prior to computing the DFT in order to
smooth the edges of the signal. This has the effect of reducing the height of the sidelobes or spectral
leakage. This phenomenon gives rise to the interpretation of sidelobes as spurious frequencies
introduced into the signal by the abrupt truncation that occurs when a rectangular window is used.
For nonrectangular windows, the end points of the truncated signal are attenuated smoothly, and
hence the spurious frequencies introduced are much less severe. On the other hand, nonrectangular
windows also broaden the mainlobe, which results in a reduction of resolution.

The periodogram allows you to compute a modified periodogram by specifying the window to be
used on the data. For example, compare a default rectangular window and a Hamming window.
Specify the same number of DFT points in both cases.

fs = 1000; % Sampling frequency

t = (0:fs/10)/fs; % One-tenth second worth of samples
A=1[12]; % Sinusoid amplitudes

f = [150;140]; % Sinusoid frequencies

nfft = 1024

= A¥sin(2*pi*f*t) + 0.1l*randn(size(t));
periodogram(xn, rectwin(length(xn)),nfft,fs)

Periodogram Power Spectral Density Estimate
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periodogram(xn,hamming(length(xn)),nfft,fs)
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Periodogram Power Spectral Density Estimate
_1 D T T II"\'l T T T T T T T

40 A | | A

Fowerffrequency (dB/Hz)

IR |
e ‘ ‘ 'Il |IJ'I' I|| R

0 50 100 150 200 250 300 350 400 450 500
Frequency (Hz)

You can verify that although the sidelobes are much less evident in the Hamming-windowed

periodogram, the two main peaks are wider. In fact, the 3 dB width of the mainlobe corresponding to
a Hamming window is approximately twice that of a rectangular window. Hence, for a fixed data
length, the PSD resolution attainable with a Hamming window is approximately half that attainable
with a rectangular window. The competing interests of mainlobe width and sidelobe height can be

resolved to some extent by using variable windows such as the Kaiser window.

Nonrectangular windowing affects the average power of a signal because some of the time samples
are attenuated when multiplied by the window. To compensate for this, periodogram and pwelch
normalize the window to have an average power of unity. This ensures that the measured average
power is generally independent of window choice. If the frequency components are not well resolved

by the PSD estimators, the window choice does affect the average power.

The modified periodogram estimate of the PSD is

~ 2
Putp) = KDL

where U is the window normalization constant:

NGt 2
U=+ > |wn).
n=0

=

For large values of L, U tends to become independent of window length. The addition of U as a
normalization constant ensures that the modified periodogram is asymptotically unbiased.

7-16



Nonparametric Methods

Welch's Method

An improved estimator of the PSD is the one proposed by Welch. The method consists of dividing the
time series data into (possibly overlapping) segments, computing a modified periodogram of each
segment, and then averaging the PSD estimates. The result is Welch's PSD estimate. The toolbox
function pwelch implements Welch's method.

The averaging of modified periodograms tends to decrease the variance of the estimate relative to a
single periodogram estimate of the entire data record. Although overlap between segments
introduces redundant information, this effect is diminished by the use of a nonrectangular window,
which reduces the importance or weight given to the end samples of segments (the samples that
overlap).

However, as mentioned above, the combined use of short data records and nonrectangular windows
results in reduced resolution of the estimator. In summary, there is a tradeoff between variance
reduction and resolution. One can manipulate the parameters in Welch's method to obtain improved
estimates relative to the periodogram, especially when the SNR is low. This is illustrated in the
following example.

Consider a signal consisting of 301 samples:

fs = 1000; % Sampling frequency

t = (0:0.3*%fs)/fs; % 301 samples

A= [2 8]; % Sinusoid amplitudes (row vector)

f = [150;140]; % Sinusoid frequencies (column vector)

xn = A*sin(2*pi*f*t) + 5*randn(size(t));
periodogram(xn, rectwin(length(xn)), 1024, fs)

7-17



7 statistical Signal Processing

Periodogram Power Spectral Density Estimate
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We can obtain Welch's spectral estimate for 3 segments with 50% overlap using a rectangular
window.

pwelch(xn, rectwin(150),50,512,fs)
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In the periodogram above, noise and the leakage make one of the sinusoids essentially
indistinguishable from the artificial peaks. In contrast, although the PSD produced by Welch's method
has wider peaks, you can still distinguish the two sinusoids, which stand out from the "noise floor."

However, if we try to reduce the variance further, the loss of resolution causes one of the sinusoids to
be lost altogether.

pwelch(xn, rectwin(100),75,512,fs)
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Welch Power Spectral Density Estimate
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Bias and Normalization in Welch's Method

Welch's method yields a biased estimator of the PSD. The expected value of the PSD estimate is:

1 Fs/2 2 N
E[PWelch(f)} = 510 f WU = PPl dF

where L is the length of the data segments, U is the same normalization constant present in the
definition of the modified periodogram, and W(f) is the Fourier transform of the window function. As
is the case for all periodograms, Welch's estimator is asymptotically unbiased. For a fixed length data
record, the bias of Welch's estimate is larger than that of the periodogram because the length of the
segments is less than the length of the entire data sample.

The variance of Welch's estimator is difficult to compute because it depends on both the window used
and the amount of overlap between segments. Basically, the variance is inversely proportional to the
number of segments whose modified periodograms are being averaged.

Multitaper Method

The periodogram can be interpreted as filtering a length L signal, x;(n), through a filter bank (a set of
filters in parallel) of L FIR bandpass filters. The 3 dB bandwidth of each of these bandpass filters can
be shown to be approximately equal to fs/L. The magnitude response of each one of these bandpass

filters resembles that of a rectangular window. The periodogram can thus be viewed as a computation
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of the power of each filtered signal (i.e., the output of each bandpass filter) that uses just one sample
of each filtered signal and assumes that the PSD of x;(n) is constant over the bandwidth of each

bandpass filter.

As the length of the signal increases, the bandwidth of each bandpass filter decreases, making it a
more selective filter, and improving the approximation of constant PSD over the bandwidth of the
filter. This provides another interpretation of why the PSD estimate of the periodogram improves as
the length of the signal increases. However, there are two factors apparent from this standpoint that
compromise the accuracy of the periodogram estimate. First, the rectangular window yields a poor
bandpass filter. Second, the computation of the power at the output of each bandpass filter relies on a
single sample of the output signal, producing a very crude approximation.

Welch's method can be given a similar interpretation in terms of a filter bank. In Welch's
implementation, several samples are used to compute the output power, resulting in reduced variance
of the estimate. On the other hand, the bandwidth of each bandpass filter is larger than that
corresponding to the periodogram method, which results in a loss of resolution. The filter bank model
thus provides a new interpretation of the compromise between variance and resolution.

Thompson's multitaper method (MTM) builds on these results to provide an improved PSD estimate.
Instead of using bandpass filters that are essentially rectangular windows (as in the periodogram
method), the MTM method uses a bank of optimal bandpass filters to compute the estimate. These
optimal FIR filters are derived from a set of sequences known as discrete prolate spheroidal
sequences (DPSSs, also known as Slepian sequences).

In addition, the MTM method provides a time-bandwidth parameter with which to balance the
variance and resolution. This parameter is given by the time-bandwidth product, NW and it is directly
related to the number of tapers used to compute the spectrum. There are always 2NW — 1 tapers
used to form the estimate. This means that, as NW increases, there are more estimates of the power
spectrum, and the variance of the estimate decreases. However, the bandwidth of each taper is also
proportional to NW, so as NW increases, each estimate exhibits more spectral leakage (i.e., wider
peaks) and the overall spectral estimate is more biased. For each data set, there is usually a value for
NW that allows an optimal trade-off between bias and variance.

The Signal Processing Toolbox™ function that implements the MTM method is pmtm. Use pmtm to
compute the PSD of a signal.

fs = 1000; % Sampling frequency

t = (0:fs)/fs; % One second worth of samples
A=1[12]; % Sinusoid amplitudes

f = [150;140]; % Sinusoid frequencies

xn = A*¥sin(2*pi*f*t) + 0.1*randn(size(t));
pmtm(xn,4,[],fs)
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Thomson Multitaper Power Spectral Density Estimate
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By lowering the time-bandwidth product, you can increase the resolution at the expense of larger
variance.

pmtm(xn,1.5,[1,fs)
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Thomson Multitaper Power Spectral Density Estimate
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This method is more computationally expensive than Welch's method due to the cost of computing the
discrete prolate spheroidal sequences. For long data series (10,000 points or more), it is useful to
compute the DPSSs once and save them in a MAT-file. dpsssave, dpssload, dpssdir, and
dpssclear are provided to keep a database of saved DPSSs in the MAT-file dpss.mat.

Cross-Spectral Density Function

The PSD is a special case of the cross spectral density (CPSD) function, defined between two signals
x(n) and y(n) as

0

1 .
ny((l)) = E 2 ny(m)e Jwm
m= —o

As is the case for the correlation and covariance sequences, the toolbox estimates the PSD and CPSD
because signal lengths are finite.

To estimate the cross-spectral density of two equal length signals x and y using Welch's method, the
cpsd function forms the periodogram as the product of the FFT of x and the conjugate of the FFT of
y. Unlike the real-valued PSD, the CPSD is a complex function. cpsd handles the sectioning and
windowing of x and y in the same way as the pwelch function:

Sxy = cpsd(x,y,nwin,noverlap,nfft,fs)
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Transfer Function Estimate

One application of Welch's method is nonparametric system identification. Assume that H is a linear,
time invariant system, and x(n) and y(n) are the input to and output of H, respectively. Then the
power spectrum of x(n) is related to the CPSD of x(n) and y(n) by

Pyx(w) = H(w)Pxx(w) .

An estimate of the transfer function between x(n) and y(n) is

This method estimates both magnitude and phase information. The tfestimate function uses
Welch's method to compute the CPSD and power spectrum, and then forms their quotient for the
transfer function estimate. Use tfestimate the same way that you use the cpsd function.

Generate a signal consisting of two sinusoids embedded in white Gaussian noise.

rng('default')

fs = 1000; % Sampling frequency

t = (0:fs)/fs; % One second worth of samples
A=1[12]; % Sinusoid amplitudes

f = [150;140]; % Sinusoid frequencies

xn = A*¥sin(2*pi*f*t) + 0.1*randn(size(t));

Filter the signal xn with an FIR moving-average filter. Compute the actual magnitude response and
the estimated response.

h = ones(1,10)/10; % Moving-average filter
yn = filter(h,1,xn);

[HEST,f] = tfestimate(xn,yn, 256,128,256, fs);
H = freqz(h,1,f,fs);

Plot the results.

subplot(2,1,1)

plot(f,abs(H))

title('Actual Transfer Function Magnitude')
yl = ylim;

grid

subplot(2,1,2)

plot(f,abs(HEST))

title('Transfer Function Magnitude Estimate')
xlabel('Frequency (Hz)"')

ylim(y1l)

grid
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Actual Transfer Function Magnitude
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Coherence Function

The magnitude-squared coherence between two signals x(n) and y(n) is

_ Py
Co©) = B ()P @)

This quotient is a real number between 0 and 1 that measures the correlation between x(n) and y(n)
at the frequency w.

The mscohere function takes sequences xn and yn, computes their power spectra and CPSD, and
returns the quotient of the magnitude squared of the CPSD and the product of the power spectra. Its
options and operation are similar to the cpsd and tfestimate functions.

Generate a signal consisting of two sinusoids embedded in white Gaussian noise. The signal is
sampled at 1 kHz for 1 second.

rng(‘'default"')

fs = 1000;

t = (0:fs)/fs;

A=1[12]; % Sinusoid amplitudes
f = [150;140]; % Sinusoid frequencies

xn = A*¥sin(2*pi*f*t) + 0.1*randn(size(t));
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Filter the signal xn with an FIR moving-average filter. Compute and plot the coherence function of xn
and the filter output yn as a function of frequency.

h = ones(1,10)/10;
yn = filter(h,1,xn);

mscohere(xn,yn, 256,128,256, fs)

Coherence Estimate via Welch
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If the input sequence length, window length, and number of overlapping data points in a window are
such that mscohere operates on only a single record, the function returns all ones. This is because
the coherence function for linearly dependent data is one.

See Also

Apps
Signal Analyzer

Functions
cpsd | mscohere | periodogram | pmtm | pwelch | tfestimate
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Parametric Methods

Parametric methods can yield higher resolutions than nonparametric methods in cases when the
signal length is short. These methods use a different approach to spectral estimation; instead of
trying to estimate the PSD directly from the data, they model the data as the output of a linear system
driven by white noise, and then attempt to estimate the parameters of that linear system.

The most commonly used linear system model is the all-pole model, a filter with all of its zeroes at the
origin in the z-plane. The output of such a filter for white noise input is an autoregressive (AR)
process. For this reason, these methods are sometimes referred to as AR methods of spectral
estimation.

The AR methods tend to adequately describe spectra of data that is “peaky,” that is, data whose PSD
is large at certain frequencies. The data in many practical applications (such as speech) tends to have
“peaky spectra” so that AR models are often useful. In addition, the AR models lead to a system of
linear equations which is relatively simple to solve.

Signal Processing Toolbox AR methods for spectral estimation include:

* Yule-Walker AR method (autocorrelation method) on page 7-28
* Burg method on page 7-30

* Covariance method on page 7-34

* Modified covariance method on page 7-34

All AR methods yield a PSD estimate given by
—~ 1 &p

P( = - —
1 - E a\p(k)e—JZka/FS

5]

The different AR methods estimate the parameters slightly differently, yielding different PSD
estimates. The following table provides a summary of the different AR methods.
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AR Methods
Burg Covariance Modified Yule-Walker
Covariance
Characteristics Does not apply Does not apply Does not apply Applies window to
window to data window to data window to data data
Minimizes the Minimizes the Minimizes the Minimizes the
forward and forward prediction |forward and forward prediction
backward prediction |error in the least backward prediction |error in the least
errors in the least squares sense errors in the least squares sense
squares sense, with squares sense
the AR coefficients (also called
constrained to satisfy “Autocorrelation
the L-D recursion method”)
Advantages High resolution for |Better resolution High resolution for |Performs as well as
short data records than Y-W for short short data records other methods for
data records (more large data records
accurate estimates)
Always produces a |Able to extract Able to extract Always produces a
stable model frequencies from frequencies from stable model
data consisting of p |data consisting of p
or more pure or more pure
sinusoids sinusoids
Does not suffer
spectral line-splitting
Disadvantages Peak locations highly | May produce May produce Performs relatively

dependent on initial
phase

unstable models

unstable models

poorly for short data
records

May suffer spectral
line-splitting for
sinusoids in noise, or
when order is very
large

Frequency bias for
estimates of
sinusoids in noise

Frequency bias for
estimates of
sinusoids in noise

Peak locations
slightly dependent
on initial phase

Frequency bias for
estimates of
sinusoids in noise

Minor frequency bias
for estimates of
sinusoids in noise

Conditions for
Nonsingularity

Order must be less
than or equal to half
the input frame size

Order must be less
than or equal to 2/3
the input frame size

Because of the
biased estimate, the
autocorrelation
matrix is guaranteed
to positive-definite,
hence nonsingular

Yule-Walker AR Method

The Yule-Walker AR method of spectral estimation computes the AR parameters by solving the
following linear system, which give the Yule-Walker equations in matrix form:
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r@0  r(d) - rle=Dfa®] [r1)
ry @ - r(p-2))ja@)) _|r@2)|

rip-=1) r(p-2) - r0) [la(p)] [r(p)

In practice, the biased estimate of the autocorrelation is used for the unknown true autocorrelation.
The Yule-Walker AR method produces the same results as a maximum entropy estimator.

The use of a biased estimate of the autocorrelation function ensures that the autocorrelation matrix
above is positive definite. Hence, the matrix is invertible and a solution is guaranteed to exist.
Moreover, the AR parameters thus computed always result in a stable all-pole model. The Yule-Walker
equations can be solved efficiently using Levinson’s algorithm, which takes advantage of the
Hermitian Toeplitz structure of the autocorrelation matrix.

The toolbox function pyulear implements the Yule-Walker AR method. For example, compare the
spectrum of a speech signal using Welch's method and the Yule-Walker AR method. Initially compute
and plot the Welch periodogram.

load mtlb
pwelch(mtlb,hamming(256),128,1024,Fs)

Welch Power Spectral Density Estimate
_2D 1 1 1 L] 1 1

40|/ |/

Fowerffrequency (dB/Hz)
¢n
=
.;_;P

0 0.5 1 15 2 25 3 35
Frequency (kHz)

The Yule-Walker AR spectrum is smoother than the periodogram because of the simple underlying all-
pole model.

order = 14;
pyulear(mtlb,order,1024,Fs)
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Yule-Walker Power Spectral Density Estimate
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Burg Method

The Burg method for AR spectral estimation is based on minimizing the forward and backward
prediction errors while satisfying the Levinson-Durbin recursion. In contrast to other AR estimation
methods, the Burg method avoids calculating the autocorrelation function, and instead estimates the
reflection coefficients directly.

The primary advantages of the Burg method are resolving closely spaced sinusoids in signals with low
noise levels, and estimating short data records, in which case the AR power spectral density
estimates are very close to the true values. In addition, the Burg method ensures a stable AR model
and is computationally efficient.

The accuracy of the Burg method is lower for high-order models, long data records, and high signal-
to-noise ratios (which can cause line splitting, or the generation of extraneous peaks in the spectrum
estimate). The spectral density estimate computed by the Burg method is also susceptible to
frequency shifts (relative to the true frequency) resulting from the initial phase of noisy sinusoidal
signals. This effect is magnified when analyzing short data sequences.

The toolbox function pburg implements the Burg method. Compare the spectrum estimates of a
speech signal generated by both the Burg method and the Yule-Walker AR method. Initially compute
and plot the Burg estimate.

load mtlb
order = 14;
pburg(mtlb(1:512),0order,1024,Fs)
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Burg Power Spectral Density Estimate
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The Yule-Walker estimate is very similar if the signal is long enough.

pyulear(mtlb(1:512),order,1024,Fs)
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Yule-Walker Power Spectral Density Estimate
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Compare the spectrum of a noisy signal computed using the Burg method and the Welch method.
Create a two-component sinusoidal signal with frequencies 140 Hz and 150 Hz embedded in white
Gaussian noise of variance 0.12. The second component has twice the amplitude of the first
component. The signal is sampled at 1 kHz for 1 second. Initially compute and plot the Welch
spectrum estimate.

fs = 1000;
t = (0:fs)/fs;
A=1[12];
f = [140;150];

xn = A*cos(2*pi*f*t) + 0.1*randn(size(t));

pwelch(xn,hamming(256),128,1024,fs)
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Welch Power Spectral Density Estimate
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Compute and plot the Burg estimate using a model of order 14.

pburg(xn, 14,1024, fs)
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Burg Power Spectral Density Estimate
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Covariance and Modified Covariance Methods
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The covariance method for AR spectral estimation is based on minimizing the forward prediction
error. The modified covariance method is based on minimizing the forward and backward prediction
errors. The toolbox functions pcov and pmcov implement the respective methods.

Compare the spectrum of a speech signal generated by both the covariance method and the modified
covariance method. First compute and plot the covariance method estimate.

load mtlb

pcov(mtlb(1:64),14,1024,Fs)
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Covariance Power Spectral Density Estimate
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The modified covariance method estimate is nearly identical, even for a short signal length.

pmcov(mtlb(1:64),14,1024,Fs)
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Modified Covariance Power Spectral Density Estimate
—4 D T T T T T T T
/\

1

o

n
T
I

60 | -

Fowerffrequency (dB/Hz)
én
n

Wy

—QD i i i i i i
0 0.5 1 1.5 2 25 3 3.5

Frequency (kHz)

See Also

Functions
pburg | pcov | pmcov | pyulear
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MUSIC and Eigenvector Analysis Methods

The pmusic and peig functions provide two related spectral analysis methods:

* pmusic provides the multiple signal classification (MUSIC) method developed by Schmidt.
* peig provides the eigenvector (EV) method developed by Johnson.

Both of these methods are frequency estimator techniques based on eigenanalysis of the
autocorrelation matrix. This type of spectral analysis categorizes the information in a correlation or
data matrix, assigning information to either a signal subspace or a noise subspace.

Eigenanalysis Overview

Consider a number of complex sinusoids embedded in white noise. You can write the autocorrelation
matrix R for this system as the sum of the signal autocorrelation matrix (S) and the noise
autocorrelation matrix (W): R = S + W. There is a close relationship between the eigenvectors of the
signal autocorrelation matrix and the signal and noise subspaces. The eigenvectors v of S span the
same signal subspace as the signal vectors. If the system contains M complex sinusoids and the order
of the autocorrelation matrix is p, eigenvectors vy, through v,., span the noise subspace of the
autocorrelation matrix.

Frequency Estimator Functions

To generate their frequency estimates, eigenanalysis methods calculate functions of the vectors in the
signal and noise subspaces. Both the MUSIC and EV techniques choose a function that goes to
infinity (denominator goes to zero) at one of the sinusoidal frequencies in the input signal. Using
digital technology, the resulting estimate has sharp peaks at the frequencies of interest; this means
that there might not be infinity values in the vectors.

The MUSIC estimate is given by the formula
1

M 2
> e
=%

Pymusic(f) =

’

k +1

where the v, are the eigenvectors of the noise subspace and e(f) is a vector of complex sinusoids:
e(f) = [1 21 e4nf  gi2M=Duf]",

Here v represents the eigenvectors of the input signal's correlation matrix; vy is the kth eigenvector.
H is the conjugate transpose operator. The eigenvectors used in the sum correspond to the smallest
eigenvalues and span the noise subspace (p is the size of the signal subspace).

The expression v,e(f) is equivalent to a Fourier transform (the vector e(f) consists of complex
exponentials). This form is useful for numeric computation because the FFT can be computed for
each vy and then the squared magnitudes can be summed.

The EV method weights the summation by the eigenvalues of the correlation matrix:
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The pmusic and peig functions interpret their first input either as a signal matrix or as a correlation
matrix (if the 'corr' input flag is set). In the former case, the singular value decomposition of the
signal matrix is used to determine the signal and noise subspaces. In the latter case, the eigenvalue
decomposition of the correlation matrix is used to determine the signal and noise subspaces.

See Also

Functions
peig | pmusic
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Windows

8-2

In this section...

“Why Use Windows?” on page 8-2
“Available Window Functions” on page 8-2

“Graphical User Interface Tools” on page 8-2

“Basic Shapes” on page 8-3

Why Use Windows?

In both digital filter design and spectral estimation, the choice of a windowing function can play an
important role in determining the quality of overall results. The main role of the window is to damp
out the effects of the Gibbs phenomenon that results from truncation of an infinite series.

Available Window Functions

Window Function
Bartlett-Hann window barthannwin
Bartlett window bartlett
Blackman window blackman
Blackman-Harris window blackmanharris
Bohman window bohmanwin
Chebyshev window chebwin

Flat Top window flattopwin
Gaussian window gausswin
Hamming window hamming
Hann window hann

Kaiser window kaiser
Nuttall's Blackman-Harris window nuttallwin
Parzen (de la Vallée-Poussin) window parzenwin
Rectangular window rectwin
Tapered cosine window tukeywin
Triangular window triang

Graphical User Interface Tools

Two graphical user interface tools are provided for working with windows in the Signal Processing

Toolbox product:

* Window Designer app
* Window Visualization Tool (WVTool)

Refer to the reference pages for detailed information.




Windows

Basic Shapes

The basic window is the rectangular window, a vector of ones of the appropriate length. A
rectangular window of length 50 is

n
w

50;
rectwin(n);

Signal Processing Toolbox stores windows in column vectors by convention, so an equivalent
expression is

w = ones(50,1);
To use the Window Designer app to create this window, type

windowDesigner

The app opens with a default Hamming window. To visualize the rectangular window, set Type =
Rectangular and Length = 50 in the Current Window Information panel and then press Apply.

The Bartlett (or triangular) window is the convolution of two rectangular windows. The functions
bartlett and triang compute similar triangular windows, with three important differences. The
bartlett function always returns a window with two zeros on the ends of the sequence, so that for n
odd, the center section of bartlett(n+2) is equivalent to triang(n):

Bartlett = bartlett(7);
isequal(Bartlett(2:end-1),triang(5))

ans =
1

For n even, bartlett is still the convolution of two rectangular sequences. There is no standard
definition for the triangular window for n even; the slopes of the line segments of the triang result
are slightly steeper than those of bartlett in this case:

w = bartlett(8);
[w(2:7) triang(6)]

You can see the difference between odd and even Bartlett windows in Window Designer.
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File View Tools Window Help u
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The final difference between the Bartlett and triangular windows is evident in the Fourier transforms
of these functions. The Fourier transform of a Bartlett window is negative for n even. The Fourier
transform of a triangular window, however, is always nonnegative.

The following figure, which plots the zero-phase responses of 8-point Bartlett and Triangular
windows, illustrates the difference.

zerophase(bartlett(8))

hold on

zerophase(triang(8))
legend('Bartlett', 'Triangular')
axis([0.3 1 -0.2 0.5])
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This difference can be important when choosing a window for some spectral estimation techniques,
such as the Blackman-Tukey method. Blackman-Tukey forms the spectral estimate by calculating the
Fourier transform of the autocorrelation sequence. The resulting estimate might be negative at some
frequencies if the window's Fourier transform is negative.

See Also

Apps
Window Designer

Functions
bartlett | triang | rectwin | WVTool
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Get Started with Window Designer

Typing windowDesigner at the command line opens the Window Designer app for designing and
analyzing spectral windows. The app opens with a default 64-point Hamming window.

Note A related tool, WVTool, is available for displaying, annotating, or printing windows.

i T

File View Tools Window Help u
D&k | D a<w dOE

Window Viewer

Time domain a0 Frequency domain
2 _
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< g
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0 : : : : : : <100 : : : :
20 40 60 80 100 120 0 50 100 150 200
Time (ms) Frequency (Hz)
Leakage Factor: 0.04 % Relative sidelobe attenuation: -42.4 dB Mainlobe width (-3dB). 10.254 Hz
Windowr List Current Window Information
Select windows to display: Name: window_1 | -
wingow g ... N
[ Add a new window ] Type: Hamming d
[ copy window |
| Saveto workspace | I:I
|Symmetriu: v]
( Delete |
Z | Apply |
The app has three panels:
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Window Viewer displays the time domain and frequency domain representations of the selected
window(s). The currently active window is shown in bold. Three window measurements are shown
below the plots.

* Leakage factor — ratio of power in the sidelobes to the total window power

* Relative sidelobe attenuation — difference in height from the mainlobe peak to the highest
sidelobe peak

* Mainlobe width (-3dB) — width of the mainlobe at 3 dB below the mainlobe peak
Window List lists the windows available for display in the Window Viewer. Highlight one or more
windows to display them. The Window List buttons are:

* Add a new window — Adds a default Hamming window with length 64 and symmetric
sampling. You can change the information for this window by applying changes made in the
Current Window Information panel.

* Copy window — Copies the selected window(s).

* Save to workspace — Saves the selected window(s) as vector(s) to the MATLAB workspace.
The name of the window is used as the vector name.

* Delete — Removes the selected window(s) from the window list.

Current Window Information displays information about the currently active window. The active
window name is shown in the Name field. To make another window active, select its name from the
Name menu.

Window Parameters

Each window is defined by the parameters in the Current Window Information panel. You can change
the current window's characteristics by changing its parameters and clicking Apply. The parameters
of the current window are

Name — Name of the window. The name is used for the legend in the Window Viewer, in the
Window List, and for the vector saved to the workspace. You can either select a name from the
menu or type the desired name in the edit box.

Type — Algorithm for the window. Select the type from the menu. All Signal Processing Toolbox
windows are available.

MATLAB code — Any valid MATLAB expression that returns a vector defining the window if
Type = User Defined.

Length — Number of samples.

Parameter — Additional parameter for windows that require it, such as Chebyshev, which
requires you to specify the sidelobe attenuation. Note that the title “Parameter” changes to the
appropriate parameter name.

Sampling — Type of sampling to use for generalized cosine windows (Hamming, Hann, and
Blackman) — Periodic or Symmetric. Periodic computes a length n+1 window and returns
the first n points, and Symmetric computes and returns the n points specified in Length.

Window Designer Menus

In addition to the usual menu items, Window Designer contains these menu commands:

File menu:
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» Export — Exports window coefficient vectors to the MATLAB workspace, a text file, or a MAT-file.

In the Window List in, highlight the window(s) you want to export and then select File > Export.
For exporting to the workspace or a MAT-file, specify the variable name for each set of window
coefficients. To overwrite variables in the workspace, select the Overwrite variables check box.

* Full View Analysis — Copies the windows shown in both plots to a separate WVTool figure
window. This is useful for printing and annotating. This option is also available with the Full View
Analysis toolbar button.

View menu:

* Time domain — Select to show the time domain plot in the Window Viewer panel.
* Frequency domain — Select to show the frequency domain plot in the Window Viewer panel.

* Legend — Toggles the window name legend on and off. This option is also available with the
Legend toolbar button.

* Analysis Parameters — Controls the response plot parameters, including number of points,
range, x- and y-axis units, sampling frequency, and normalized magnitude.

You can also access the Analysis Parameters by right-clicking the x-axis label of a plot in the
Window Viewer panel. The x-axis units for the time domain plot depend on the selected Sampling
Frequency units.

Frequency Domain Time Domain
Hz S
kHz ms
MHz Bs
GHz ns
Tools menu:

* Zoom In — Zooms in along both x- and y-axes.

* Zoom X — Zooms in along the x-axis only. Drag the mouse in the x direction to select the zoom
area.

* Zoom Y — Zooms in along the y-axis only. Drag the mouse in the y direction to select the zoom
area.

¢ Full View — Returns to full view.

See Also

Functions
WVTool
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Generalized Cosine Windows

Blackman, flat top, Hamming, Hann, and rectangular windows are all special cases of the generalized
cosine window. These windows are combinations of sinusoidal sequences with frequencies that are
multiples of 2m/(N - 1), where N is the window length. One special case is the Blackman window:

N = 128;

A = 0.42;

B =20.5;

C =0.08;

ind = (0:N-1)'*2*pi/(N-1);

w = A - B*cos(ind) + C*cos(2*ind);

Changing the values of the constants A, B, and C in the previous expression generates different
generalized cosine windows like the Hamming and Hann windows. Adding additional cosine terms of
higher frequency generates the flat top window. The concept behind these windows is that by
summing the individual terms to form the window, the low frequency peaks in the frequency domain
combine in such a way as to decrease sidelobe height. This has the side effect of increasing the
mainlobe width.

The Hamming and Hann windows are two-term generalized cosine windows, given by A = 0.54,
B = 0.46 for the Hamming and A = 0.5, B = 0.5 for the Hann.

Note that the definition of the generalized cosine window shown in the earlier MATLAB code yields
zeros at samples 1 and nfor A=0.5and B=0.5.

This Window Designer screen shot compares Blackman, Hamming, Hann, and Flat Top windows.
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See Also

Apps
Window Designer

Functions
blackman | flattopwin | hamming | hann | WVTool
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Kaiser Window

The Kaiser window is an approximation to the prolate spheroidal window, for which the ratio of the
mainlobe energy to the sidelobe energy is maximized. For a Kaiser window of a particular length, the
parameter B controls the relative sidelobe attenuation. For a given f3, the relative sidelobe attenuation
is fixed with respect to window length. The statement kaiser(n,beta) computes a length n Kaiser
window with parameter beta.

As B increases, the relative sidelobe attenuation decreases and the mainlobe width increases. This
screen shot shows how the relative sidelobe attenuation stays approximately the same for a fixed j8
parameter as the length is varied.

Examples of Kaiser windows with length 50 and 3 parameters of 1, 4, and 9 are shown in this
example.
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To create these Kaiser windows using the MATLAB command line, type the following:

n = 50;

wl = kaiser(n,1);
w2 = kaiser(n,4);
w3 = kaiser(n,9);

[W1,f] = freqz(wl/sum(wl),1,512,2);

[wW2,f] freqz(w2/sum(w2),1,512,2);

[W3,f] freqz(w3/sum(w3),1,512,2);
plot(f,20*1oglO(abs([W1 W2 W3])))

grid

legend('\beta = 1','\beta = 4','\beta = 9')
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To create these Kaiser windows using the MATLAB command line, type the following:

kaiser(50,4);

w2 kaiser(20,4);

w3 kaiser(101,4);

[Wl,f] freqz(wl/sum(wl),1,512,2);

[W2,f] freqz(w2/sum(w2),1,512,2);

[W3,f] freqz(w3/sum(w3),1,512,2);
plot(f,20*1ogl0O(abs([W1 W2 W3])))

grid

legend('length = 50', 'length = 20', 'length = 101")

wl
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Kaiser Windows in FIR Design

There are two design formulas that can help you design FIR filters to meet a set of filter

specifications using a Kaiser window. To achieve a relative sidelobe attenuation of -a dB, the 8 (beta)
parameter is

0.1102(a - 8.7), a > 50,
B=10.5842(a —21)%*+0.07886(x - 21), 50 = a = 21,
0, a<?2l.

For a transition width of Aw rad/sample, use the length

Filters designed using these heuristics will meet the specifications approximately, but you should
verify this. To design a lowpass filter with cutoff frequency 0.5m rad/sample, transition width 0.2
r rad/sample, and 40 dB of attenuation in the stopband, try
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[n,wn,beta] = kaiserord([0.4 0.6]*pi,[1 0],[0.01 0.01],2*pi);
h = firl(n,wn,kaiser(n+1,beta), 'noscale');

The kaiserord function estimates the filter order, cutoff frequency, and Kaiser window beta
parameter needed to meet a given set of frequency domain specifications.

The ripple in the passband is roughly the same as the ripple in the stopband. As you can see from the
frequency response, this filter nearly meets the specifications:

fvtool(h,1)

-30 | \ .

Magnitude (dB)

40 \ .

50 |- |\ /N .

| | | | | | |
0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9
Normalized Frequency (xn rad/sample)

See Also

Apps
Window Designer

Functions
freqz | kaiser | kaiserord | WVTool
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Chebyshev Window

The Chebyshev window minimizes the mainlobe width, given a particular sidelobe height. It is
characterized by an equiripple behavior. Its sidelobes all have the same height.

Generate and display a 50-point Chebyshev window with a sidelobe attenuation of 40 dB.

w = chebwin(50,40);
wvtool(w)

TFI-_‘I'II-%| Window YVisualization Toal | = ” (=] ” 2 |

File Edit View Inset Tools Window Help
S K OTNNN\NW & @ afg N

Windove Yiewwer
Time domaln

Frequency domaln

Amplitude
Magnitude (dB)

0 - - - - -80 - - - -
10 20 30 40 50 o 02 04 06 0B
Samples Momalized Frequency (== rad/sample)
Leakage Factor: 0,18 % Felative sidelobe attenuation: -40 dE Mainlobe width (-3dBY 0046875

As shown in the time-domain plot, the Chebyshev window has large spikes at its outer samples.

See Also

Apps
Window Designer

Functions
chebwin | WVTool
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Parametric Modeling

In this section...

“What is Parametric Modeling” on page 8-18
“Available Parametric Modeling Functions” on page 8-18
“Time-Domain Based Modeling” on page 8-19

“Frequency-Domain Based Modeling” on page 8-21

What is Parametric Modeling

Parametric modeling techniques find the parameters for a mathematical model describing a signal,
system, or process. These techniques use known information about the system to determine the
model. Applications for parametric modeling include speech and music synthesis, data compression,
high-resolution spectral estimation, communications, manufacturing, and simulation.

Available Parametric Modeling Functions

The toolbox parametric modeling functions operate with the rational transfer function model. Given
appropriate information about an unknown system (impulse or frequency response data, or input and
output sequences), these functions find the coefficients of a linear system that models the system.

One important application of the parametric modeling functions is in the design of filters that have a
prescribed time or frequency response.

Here is a summary of the parametric modeling functions in this toolbox.

Domain Functions Description
Time arburg Generate all-pole filter coefficients that model an input
data sequence using the Levinson-Durbin algorithm.
arcov Generate all-pole filter coefficients that model an input
data sequence by minimizing the forward prediction
erTor.
armcov Generate all-pole filter coefficients that model an input

data sequence by minimizing the forward and backward
prediction errors.

aryule Generate all-pole filter coefficients that model an input
data sequence using an estimate of the autocorrelation
function.

lpc, levinson Linear Predictive Coding. Generate all-pole recursive

filter whose impulse response matches a given sequence.

prony Generate IIR filter whose impulse response matches a
given sequence.

stmch Find IIR filter whose output, given a specified input
sequence, matches a given output sequence.

Frequency invfreqz, invfreqs |Generate digital or analog filter coefficients given
complex frequency response data.
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Time-Domain Based Modeling

The 1lpc, prony, and stmcb functions find the coefficients of a digital rational transfer function that
approximates a given time-domain impulse response. The algorithms differ in complexity and
accuracy of the resulting model.

Linear Prediction

Linear prediction modeling assumes that each output sample of a signal, x(k), is a linear
combination of the past n outputs (that is, it can be linearly predicted from these outputs), and that
the coefficients are constant from sample to sample:

x(k) = —a2)x(k = 1) —aB)x(k = 2) — - —a(n+ 1)x(k — n).
An nth-order all-pole model of a signal x is
a = lpc(x,n)

To illustrate 1pc, create a sample signal that is the impulse response of an all-pole filter with additive
white noise:

x = impz(1,[1 0.1 0.1 0.1 0.1],10) + randn(10,1)/10;
The coefficients for a fourth-order all-pole filter that models the system are
a = lpc(x,4)

1pc first calls xcorr to find a biased estimate of the correlation function of x, and then uses the
Levinson-Durbin recursion, implemented in the levinson function, to find the model coefficients a.
The Levinson-Durbin recursion is a fast algorithm for solving a system of symmetric Toeplitz linear
equations. 1pc's entire algorithm for n = 4 is

r = xcorr(x);
r(l:length(x)-1
n(r

) = [1; % Remove corr. at negative lags
a = levinso ,4)

You could form the linear prediction coefficients with other assumptions by passing a different
correlation estimate to levinson, such as the biased correlation estimate:

r = xcorr(x, 'biased');

r(l:length(x)-1) = []; % Remove corr. at negative lags
a = levinson(r,4)

Prony's Method (ARMA Modeling)

The prony function models a signal using a specified number of poles and zeros. Given a sequence X
and numerator and denominator orders n and m, respectively, the statement

[b,a] = prony(x,n,m)

finds the numerator and denominator coefficients of an IIR filter whose impulse response
approximates the sequence x.

The prony function implements the method described in [4] Parks and Burrus. This method uses a
variation of the covariance method of AR modeling to find the denominator coefficients a, and then
finds the numerator coefficients b for which the resulting filter's impulse response matches exactly
the first n + 1 samples of x. The filter is not necessarily stable, but it can potentially recover the
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coefficients exactly if the data sequence is truly an autoregressive moving-average (ARMA) process of
the correct order.

Note The functions prony and stmcb (described next) are more accurately described as ARX models
in system identification terminology. ARMA modeling assumes noise only at the inputs, while ARX
assumes an external input. prony and stmcb know the input signal: it is an impulse for prony and is
arbitrary for stmcb.

A model for the test sequence x (from the earlier 1pc example) using a third-order IIR filter is
[b,a] = prony(x,3,3)
The impz command shows how well this filter's impulse response matches the original sequence:

format long
[x impz(b,a,10)]

Notice that the first four samples match exactly. For an example of exact recovery, recover the
coefficients of a Butterworth filter from its impulse response:

[b,a]l] = butter(4,.2);
h = impz(b,a,26);
[bb,aa] = prony(h,4,4);

Try this example; you'll see that bb and aa match the original filter coefficients to within a tolerance
of 1013,

Steiglitz-McBride Method (ARMA Modeling)

The stmcb function determines the coefficients for the system b(z)/a(z) given an approximate impulse
response X, as well as the desired number of zeros and poles. This function identifies an unknown
system based on both input and output sequences that describe the system's behavior, or just the
impulse response of the system. In its default mode, stmcb works like prony.

[b,a] = stmcb(x,3,3)
stmcb also finds systems that match given input and output sequences:

y = filter(1,[1 11,x); % Create an output signal.
[b,a] = stmcb(y,x,0,1)

In this example, stmcb correctly identifies the system used to create y from x.

The Steiglitz-McBride method is a fast iterative algorithm that solves for the numerator and
denominator coefficients simultaneously in an attempt to minimize the signal error between the filter
output and the given output signal. This algorithm usually converges rapidly, but might not converge
if the model order is too large. As for prony, stmcb's resulting filter is not necessarily stable due to
its exact modeling approach.

stmcb provides control over several important algorithmic parameters; modify these parameters if
you are having trouble modeling the data. To change the number of iterations from the default of five
and provide an initial estimate for the denominator coefficients:
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n = 10; % Number of iterations
a = lpc(x,3); % Initial estimates for denominator
[b,a] = stmcb(x,3,3,n,a);

The function uses an all-pole model created with prony as an initial estimate when you do not
provide one of your own.

To compare the functions lpc, prony, and stmcb, compute the signal error in each case:

[b2,a2] prony(x,3,3);
[b3,a3] stmcb(x,3,3);
[x-impz(1,al,10) x-impz(b2,a2,10) x-impz(b3,a3,10)]

1 = 1pc(x,3);

In comparing modeling capabilities for a given order IIR model, the last result shows that for this
example, stmcb performs best, followed by prony, then 1pc. This relative performance is typical of
the modeling functions.

Frequency-Domain Based Modeling

The invfreqs and invfreqz functions implement the inverse operations of freqs and freqz; they
find an analog or digital transfer function of a specified order that matches a given complex
frequency response. Though the following examples demonstrate invfreqz, the discussion also
applies to invfreqs.

To recover the original filter coefficients from the frequency response of a simple digital filter:

[b,a] = butter(4,0.4) % Design Butterworth lowpass
[h,w] = freqz(b,a,64); % Compute frequency response
[b4,ad4] = invfreqz(h,w,4,4) % Model: n =4, m =4

The vector of frequencies w has the units in rad/sample, and the frequencies need not be equally
spaced. invfreqz finds a filter of any order to fit the frequency data; a third-order example is

[b4,a4] = invfreqz(h,w,3,3) % Find third-order IIR

Both invfreqs and invfreqz design filters with real coefficients; for a data point at positive
frequency f, the functions fit the frequency response at both f and - f.

By default invfreqz uses an equation error method to identify the best model from the data. This
finds b and a in

n
min z wiky|hik)Aluw(k)) — Bluik))|2
hoa
T ra1

by creating a system of linear equations and solving them with the MATLAB \ operator. Here A(w(k))
and B(w(k)) are the Fourier transforms of the polynomials a and b respectively at the frequency w(k),
and n is the number of frequency points (the length of h and w). wt(k) weights the error relative to the
error at different frequencies. The syntax

invfreqz(h,w,n,m,wt)

includes a weighting vector. In this mode, the filter resulting from invfreqz is not guaranteed to be
stable.
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invfreqz provides a superior ("output-error") algorithm that solves the direct problem of minimizing
the weighted sum of the squared error between the actual frequency response points and the desired

response
. Biuwik))2
min wtkihik) - © ‘
b.aka J‘ ' Awik))

To use this algorithm, specify a parameter for the iteration count after the weight vector parameter:

wt = ones(size(w)); % Create unit weighting vector
[b30,a30] = invfreqz(h,w,3,3,wt,30) % 30 iterations

The resulting filter is always stable.

Graphically compare the results of the first and second algorithms to the original Butterworth filter
with FVTool (and select the Magnitude and Phase Responses):

fvtool(b,a,b4,a4,b30,a30)
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a0 —---—--;—---——-E ------- I ------ :-------é-------'--- : ——----:-------:- ----- -120
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2 i i i i i D
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To verify the superiority of the fit numerically, type
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sum(abs (h-freqz(b4,a4,w)).”2)
sum(abs (h-freqz(b30,a30,w))."2)

otal error, algorithm 1
otal error, algorithm 2

— -

)
“©
[)

“©
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Resampling

8-24

In this section...

“resample Function” on page 8-24
“decimate and interp Functions” on page 8-25
“upfirdn Function” on page 8-25

“spline Function” on page 8-25

Signal Processing Toolbox provides a number of functions that resample a signal at a higher or lower
rate.

Operation Function
Apply FIR filter with resampling upfirdn
Cubic spline interpolation spline
Decimation decimate
Interpolation interp
Other 1-D interpolation interpl
Resample at new rate resample

For examples, see

* “Reconstructing Missing Data” on page 25-27

* “Resampling Uniformly Sampled Signals” on page 25-38

* “Resampling Nonuniformly Sampled Signals” on page 25-46

* “Resample and Filter a Nonuniformly Sampled Signal” on page 21-69

resample Function

The resample function changes the sample rate for a sequence to any rate that is proportional to the
original by a ratio of two integers. The basic syntax for resample is

y = resample(x,p,q)

where the function resamples the sequence x at p/q times the original sample rate. The length of the
result y is p/q times the length of x.

One resampling application is the conversion of digitized audio signals from one sample rate to
another, such as from 48 kHz (the digital audio tape standard) to 44.1 kHz (the compact disc
standard). See “Convert from DAT Rate to CD Sample Rate” for an example.

resample applies a lowpass filter to the input sequence to prevent aliasing during resampling. The
function designs this filter using the firls function with a Kaiser window. You can control the filter
length and the beta parameter of the Kaiser window. Alternatively, you can use the function intfilt
to design an interpolation filter.



Resampling

decimate and interp Functions
The decimate and interp functions are equivalent to resample with p = 1 and q = 1, respectively.

These functions provide different antialiasing filtering options, and they incur a slight signal delay
due to filtering.

upfirdn Function
The toolbox also contains a function, upfirdn, that applies an FIR filter to an input sequence and

outputs the filtered sequence at a sample rate different than its original. See “Multirate Filter Bank
Implementation” on page 1-6.

spline Function
The standard MATLAB environment contains a function, spline, that works with irregularly spaced

data. The function interpl performs interpolation, or table lookup, using various methods including
linear and cubic interpolation.

See Also

Apps
Signal Analyzer

Functions
decimate | interp | interpl | resample | spline | upfirdn
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Cepstrum Analysis
What Is a Cepstrum?

Cepstrum analysis is a nonlinear signal processing technique with a variety of applications in areas
such as speech and image processing.

The complex cepstrum of a sequence x is calculated by finding the complex natural logarithm of the
Fourier transform of x, then the inverse Fourier transform of the resulting sequence:

X= —I log[X(e/®)]1e/*" dw .

The toolbox function cceps performs this operation, estimating the complex cepstrum for an input
sequence. It returns a real sequence the same size as the input sequence.

Try using cceps in an echo detection application. First, create a 45 Hz sine wave sampled at 100 Hz.
Add an echo of the signal, with half the amplitude, 0.2 seconds after the beginning of the signal.

= 0:0.01:1.27;
sl = sin(2*pi*45*t);
s2 = sl + 0.5*%[zeros(1,20) s1(1:108)];

Compute and plot the complex cepstrum of the new signal.

Cc = cceps(s2);
plot(t,c)

0.51 il
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The complex cepstrum shows a peak at 0.2 seconds, indicating the echo.

The real cepstrum of a signal x, sometimes called simply the cepstrum, is calculated by determining
the natural logarithm of magnitude of the Fourier transform of x, then obtaining the inverse Fourier
transform of the resulting sequence:

Cx = %1Z10g|X(ej“’)|ejw” dw.

The toolbox function rceps performs this operation, returning the real cepstrum for a sequence. The
returned sequence is a real-valued vector the same size as the input vector.

The rceps function also returns a unique minimum-phase sequence that has the same real cepstrum
as the input. To obtain both the real cepstrum and the minimum-phase reconstruction for a sequence,
use [y,ym] = rceps(x), where y is the real cepstrum and ym is the minimum phase reconstruction
of x. The following example shows that one output of rceps is a unique minimum-phase sequence
with the same real cepstrum as x.

y = [4 1 5]; % Non-minimum phase sequence
[xhat,yhat] = rceps(y);
xhat2 = rceps(yhat);
[xhat' xhat2']
ans = 3x2
1.6225 1.6225

0.3400 0.3400
0.3400 0.3400

Inverse Complex Cepstrum

To invert the complex cepstrum, use the icceps function. Inversion is complicated by the fact that
the cceps function performs a data-dependent phase modification so that the unwrapped phase of its
input is continuous at zero frequency. The phase modification is equivalent to an integer delay. This
delay term is returned by cceps if you ask for a second output:

x =1:10;
[xhat,delay] = cceps(x)

xhat = 1Ix10

2.2428 -0.0420 -0.0210 0.0045 0.0366 0.0788 0.1386 0.2327 0.4114 0.

delay =1

To invert the complex cepstrum, use icceps with the original delay parameter:
icc = icceps(xhat,?2)

icc = 1Ix10

2.0000 3.0000 4.0000 5.0000 6.0000 7.0000 8.0000 9.0000 10.0000 1.¢
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As shown in the above example, with any modification of the complex cepstrum, the original delay
term may no longer be valid. You will not be able to invert the complex cepstrum exactly.

See Also
cceps | icceps | rceps
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FFT-Based Time-Frequency Analysis

The Signal Processing Toolbox™ product provides functions that return the time-dependent Fourier
transform for a sequence, or displays this information as a spectrogram. The time-dependent Fourier
transform is the discrete-time Fourier transform for a sequence, computed using a sliding window.
This form of the Fourier transform, also known as the short-time Fourier transform (STFT), has
numerous applications in speech, sonar, and radar processing. The spectrogram of a sequence is the
magnitude of the time-dependent Fourier transform versus time.

To display the spectrogram of a signal, you can use the pspectrum function. For example, generate
two seconds of a signal sampled at 10 kHz. Specify the instantaneous frequency of the signal as a
triangular function of time. To compute the spectrogram, divide the signal into segments of duration
0.0256 second and specify 86% segment-to-segment overlap. The leakage measures the ability of the
sliding window to detect a weak tone from noise in the presence of a neighboring strong tone. Specify
a leakage of 0.875.

fs = 10000;
t =0:1/fs:2;
x = vco(sawtooth(2*pi*t,0.75),[0.1 0.4]*fs,fs);

pspectrum(x, fs, 'spectrogram’,
'TimeResolution',0.0256, 'Overlap',86, 'Leakage',0.875)

Fres = 53.1206 Hz, Tres = 25.6 ms

4.5
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- ha e
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Power (dB}

=4
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The persistence spectrum of a signal is a time-frequency view that shows the percentage of the time
that a given frequency is present in a signal. The persistence spectrum is a histogram in power-
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frequency space. The longer a particular frequency persists in a signal as the signal evolves, the
higher its time percentage and thus the brighter or "hotter" its color in the display.

Compute and display the persistence spectrum of the signal. Specify a time resolution of 0.01 second,
50% overlap between adjoining segments, and a leakage of 0.5.

pspectrum(x, fs, 'persistence’, .
'TimeResolution',0.01, 'Overlap',50, 'Leakage',0.5)

Fres = 256.6745 Hz, Tres = 10 ms

-50

=100

Density( %}

-150

Fower Spectrum {(dB)

-200 B

Frequency (kHz)

See Also

Apps
Signal Analyzer

Functions
fsst|ifsst | pspectrum|spectrogram| tfridge | xspectrogram

Related Examples

. “Practical Introduction to Time-Frequency Analysis” on page 25-269

“Detect Closely Spaced Sinusoids” on page 16-25
. “Hilbert Transform and Instantaneous Frequency” on page 16-18
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Cross-Spectrogram of Complex Signals

Cross-Spectrogram of Complex Signals

Generate two signals, each sampled at 3 kHz for 1 second. The first signal is a quadratic chirp whose
frequency increases from 300 Hz to 1300 Hz during the measurement. The chirp is embedded in
white Gaussian noise. The second signal, also embedded in white noise, is a chirp with sinusoidally
varying frequency content.

fs = 3000;
t =0:1/fs:1-1/fs;

x1 = chirp(t,300,t(end), 1300, 'quadratic')+randn(size(t))/100;
X2 = exp(2j*pi*100*cos(2*pi*2*t))+randn(size(t))/100;

Compute and plot the cross-spectrogram of the two signals. Divide the signals into 256-sample
segments with 255 samples of overlap between adjoining segments. Use a Kaiser window with shape
factor B = 30 to window the segments. Use the default number of DFT points. Center the cross-
spectrogram at zero frequency.

nwin = 256;

xspectrogram(x1l,x2,kaiser(nwin,30),nwin-1,[],fs, 'centered', 'yaxis"')

1.5

1

W

E 0.5 %

> =

= g

g :

=] D

3 E
L

05 g

100 200 300 400 500 600 700 BOD 900
Time (ms)

Compute the power spectrum instead of the power spectral density. Set to zero the values smaller
than -40 dB. Center the plot at the Nyquist frequency.
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xspectrogram(x1,x2,kaiser(nwin,30),nwin-1,[],fs,
'power', 'MinThreshold', -40, 'yaxis')
title('Cross-Spectrogram of Quadratic Chirp and Complex Chirp')

Cross-Spectrogram of Quadratic Chirp and Complex Chirp
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The thresholding further highlights the regions of common frequency.

See Also
spectrogram | xspectrogram
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Median Filtering

The function medfiltl implements one-dimensional median filtering, a nonlinear technique that
applies a sliding window to a sequence. The median filter replaces the center value in the window
with the median value of all the points within the window [5]. In computing this median, medfiltl
assumes zeros beyond the input points.

When the number of elements n in the window is even, medfilt1 sorts the numbers, then takes the
average of the n/2 and n/2 + 1 elements.

Two simple examples with fourth- and third-order median filters are

medfiltl([4 3 52 8 9 1],4)
ans =

1.500 3.500 3.50
medfiltl([4 3 52 8
ans =

3 4 3 5 8 8 1

4.000 6.500 5.000 4.500

0
9 1],3)

See the medfilt2 function in the Image Processing Toolbox™ for information on two-dimensional
median filtering.
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Communications Applications
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In this section...

“Modulation” on page 8-34
“Demodulation” on page 8-35

“Voltage Controlled Oscillator” on page 8-36

Modulation

Modulation varies the amplitude, phase, or frequency of a carrier signal with reference to a message
signal. The modulate function modulates a message signal with a specified modulation method.

The basic syntax for the modulate function is
y = modulate(x, fc,fs, 'method',opt)
where:

* X is the message signal.

» fc is the carrier frequency.

+ fs is the sampling frequency.

* method is a flag for the desired modulation method.

* opt is any additional argument that the method requires. (Not all modulation methods require an
option argument.)

The table below summarizes the modulation methods provided; see the documentation for modulate,
demod, and vco for complete details on each.

Method Description

amdsb-sc or am Amplitude modulation, double sideband, suppressed carrier
amdsb-tc Amplitude modulation, double sideband, transmitted carrier
amssb Amplitude modulation, single sideband

fm Frequency modulation

pm Phase modulation

ppm Pulse position modulation

pwm Pulse width modulation

gam Quadrature amplitude modulation

If the input x is an array rather than a vector, nodulate modulates each column of the array.

To obtain the time vector that modulate uses to compute the modulated signal, specify a second
output parameter:

[y,t]l = modulate(x,fc,fs, 'method',opt)
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Demodulation

The demod function performs demodulation, that is, it obtains the original message signal from the
modulated signal:

The syntax for demod is
x = demod(y, fc,fs, 'method',opt)

demod uses any of the methods shown for modulate, but the syntax for quadrature amplitude
demodulation requires two output parameters:

[X1,X2] = demod(y,fc,fs, 'qam"')
If the input y is an array, demod demodulates all columns.

Try modulating and demodulating a signal. A 50 Hz sine wave sampled at 1000 Hz is

t
X

(0:1/1000:2);
sin(2*pi*50*t);

With a carrier frequency of 200 Hz, the modulated and demodulated versions of this signal are

modulate(x,200,1000, 'am');
demod(y,200,1000, 'am');

y
z

To plot portions of the original, modulated, and demodulated signal:

figure; plot(t(1:150),x(1:150)); title('Original Signal');
figure; plot(t(1:150),y(1:150)); title('Modulated Signal');
figure; plot(t(1:150),z(1:150)); title('Demodulated Signal');
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Note The demodulated signal is attenuated because demodulation includes two steps: multiplication
and lowpass filtering. The multiplication produces a component with frequency centered at 0 Hz and
a component with frequency at twice the carrier frequency. The filtering removes the higher
frequency component of the signal, producing the attenuated result.

Voltage Controlled Oscillator

The voltage controlled oscillator function vco creates a signal that oscillates at a frequency
determined by the input vector. The basic syntax for vco is

y = vco(x,fc,fs)
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where fc is the carrier frequency and fs is the sampling frequency.
To scale the frequency modulation range, use
y = vco(x, [Fmin Fmax], fs)

In this case, vco scales the frequency modulation range so values of x on the interval [-1 1] map to
oscillations of frequency on [Fmin Fmax].

If the input x is an array, vco produces an array whose columns oscillate according to the columns
of x.

See “FFT-Based Time-Frequency Analysis” on page 8-29 for an example using the vco function.
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Deconvolution

Deconvolution, or polynomial division, is the inverse operation of convolution. Deconvolution is useful
in recovering the input to a known filter, given the filtered output. This method is very sensitive to
noise in the coefficients, however, so use caution in applying it.

The syntax for deconv is

[g,r] = deconv(b,a)

where b is the polynomial dividend, a is the divisor, q is the quotient, and r is the remainder.
To try deconv, first convolve two simple vectors a and b.

[12 3];

[4 5 6];
conv(a,b)

a
b
C

C
4 13 28 27 18

Now use deconv to deconvolve b from c:

[q,r] = deconv(c,a)
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Chirp Z-Transform

The chirp Z-transform (CZT) is useful in evaluating the Z-transform along contours other than the
unit circle. The chirp Z-transform is also more efficient than the DFT algorithm for the computation of
prime-length transforms, and it is useful in computing a subset of the DFT for a sequence. The chirp
Z-transform, or CZT, computes the Z-transform along spiral contours in the z-plane for an input
sequence. Unlike the DFT, the CZT is not constrained to operate along the unit circle, but can

evaluate the Z-transform along contours described by z, = AW~ ' ¢ =0,-,M-1, where A is the

complex starting point, W is a complex scalar describing the complex ratio between points on the
contour, and M is the length of the transform.

One possible spiral is

a
w
m
V4
V4

p

0

0.8*exp(lj*pi/6);
0.995*exp(-1j*pi*.05);
91;
a*(w.”(-(0:m-1)"));

Real Part

czt(x,m,w,a) computes the Z-transform of x on these points.
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An interesting and useful spiral set is m evenly spaced samples around the unit circle, parameterized
by A =1 and W = exp( — ju/M). The Z-transform on this contour is simply the DFT, obtained by czt:

M
m

64;
0:M-1;
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X = sin(2*pi*m/15);
FFT = fft(x);
CZT = czt(x,M,exp(-2j*pi/M),1);

stem(m,abs (FFT))

hold on

stem(m,abs(CZT), '*")

hold off
legend('fft', " 'czt', 'Location', 'north")

3'} T T T T T T

& — fft &
* czt

20

157 7

70

czt may be faster than the fft function for computing the DFT of sequences with certain odd
lengths, particularly long prime-length sequences.

See Also
czt| fft
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Discrete Cosine Transform

The discrete cosine transform (DCT) is closely related to the discrete Fourier transform (DFT). The
DFT is actually one step in the computation of the DCT for a sequence. The DCT, however, has better
energy compaction than the DFT, with just a few of the transform coefficients representing the
majority of the energy in the sequence. This property of the DCT makes it useful in applications such
as data communications and signal coding.

DCT Variants

The DCT has four standard variants. For a signal x of length N, and with 6, the Kronecker delta, the
transforms are defined by:

e DCT-1:
1 mn o _
y( n21X(n \/1 +6n1+5nN\/1+6k1+5kN S(N—l\n Dk 1))
« DCT-2:
1 b1}
n21 TT50 COS(W(ZH 1)(k 1))
« DCT3

o
a
=
B~

n21 cos(iN (2n - 1)(2k - 1))

The Signal Processing Toolbox function dct computes the unitary DCT of an input array.
Inverse DCT Variants
All variants of the DCT are unitary (or, equivalently, orthogonal): To find their inverses, switch k and n

in each definition. DCT-1 and DCT-4 are their own inverses. DCT-2 and DCT-3 are inverses of each
other:

e Inverse of DCT-1:

/ 1 I
2 \/1 +6k1+6kN\/1 +6n1+5nNUOS(N_1(k_1)(n_1))

e Inverse of DCT-2:

\/7 E 1+5 1cos(il\,(k—l)(zn—n)
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* Inverse of DCT-3:

\/7 E y(k cos(iN(Zk -1)(n- 1))

* Inverse of DCT-4:
7 X big
x(n) = ngl y(k)cos(m(Zk -1)2n- 1))
The function idct computes the inverse DCT for an input sequence, reconstructing a signal from a
complete or partial set of DCT coefficients.

Signal Reconstruction Using DCT

Because of the energy compaction property of the DCT, you can reconstruct a signal from only a
fraction of its DCT coefficients. For example, generate a 25 Hz sinusoidal sequence sampled at 1000
Hz.

0:1/1000:1;

t
X = sin(2*pi*25*t);

Compute the DCT of this sequence and reconstruct the signal using only those components with value
greater than 0.1. Determine how many coefficients out of the original 1000 satisfy the requirement.

dct( );

= find(abs(y) < 0.1);
y(y2) = zeros(size(y2));
z = idct(y);

howmany = length(find(y))

howmany 64

Plot the original and reconstructed sequences.

subplot(2,1,1)

plot(t,x)

ax = axis;
title('Original Signal')

subplot(2,1,2)

plot(t,z)

axis(ax)

title('Reconstructed Signal')
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One measure of the accuracy of the reconstruction is the norm of the difference between the original

and reconstructed signals, divided by the norm of the original signal. Compute this estimate and
express it as a percentage.

norm(x-z)/norm(x)*100

ans = 1.,9437

The reconstructed signal retains approximately 98% of the energy in the original signal.

See Also
dct | idct

Related Examples
“DCT for Speech Signal Compression” on page 16-42
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Hilbert Transform
The Hilbert transform facilitates the formation of the analytic signal. The analytic signal is useful in
the area of communications, particularly in bandpass signal processing. The toolbox function
hilbert computes the Hilbert transform for a real input sequence x and returns a complex result of

the same length, y = hilbert(x), where the real part of y is the original real data and the

imaginary part is the actual Hilbert transform. y is sometimes called the analytic signal, in reference
to the continuous-time analytic signal. A key property of the discrete-time analytic signal is that its Z-
transform is 0 on the lower half of the unit circle. Many applications of the analytic signal are related

to this property; for example, the analytic signal is useful in avoiding aliasing effects for bandpass
sampling operations. The magnitude of the analytic signal is the complex envelope of the original

signal.

The Hilbert transform is related to the actual data by a 90-degree phase shift; sines become cosines
and vice versa. To plot a portion of data and its Hilbert transform, use

t =0:1/1024:1,;
X = sin(2*pi*60*t);

y = hilbert(x);
plot(t(1:50),real(y(1:50)))

hold on
plot(t(1:50),imag(y(1:50)))

hold off
axis([0 0.05 -1.1 2])
legend('Real Part', 'Imaginary Part')
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The analytic signal is useful in calculating instantaneous attributes of a time series, the attributes of
the series at any point in time. The procedure requires that the signal be monocomponent.

See Also
hilbert

Related Examples
. “Analytic Signal for Cosine” on page 16-5

. “Envelope Extraction” on page 16-7
. “Analytic Signal and Hilbert Transform” on page 16-13
. “Hilbert Transform and Instantaneous Frequency” on page 16-18
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Walsh-Hadamard Transform
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The Walsh-Hadamard transform is a non-sinusoidal, orthogonal transformation technique that
decomposes a signal into a set of basis functions. These basis functions are Walsh functions, which
are rectangular or square waves with values of +1 or -1. Walsh-Hadamard transforms are also known
as Hadamard (see the hadamard function in the MATLAB software), Walsh, or Walsh-Fourier
transforms.

The first eight Walsh functions have these values:

Index Walsh Function Values

11111111

1111-1-1-1-1

11-1-1-1-111

11-1-111-1-1

1-1-111-1-11

1-1-11-111-1

1-11-1-11-11

N OO | W N~ O

1-11-11-11-1

The Walsh-Hadamard transform returns sequency values. Sequency is a more generalized notion of
frequency and is defined as one half of the average number of zero-crossings per unit time interval.
Each Walsh function has a unique sequency value. You can use the returned sequency values to
estimate the signal frequencies in the original signal.

Three different ordering schemes are used to store Walsh functions: sequency, Hadamard, and
dyadic. Sequency ordering, which is used in signal processing applications, has the Walsh functions in
the order shown in the table above. Hadamard ordering, which is used in controls applications,
arranges them as 0, 4, 6, 2, 3, 7, 5, 1. Dyadic or gray code ordering, which is used in mathematics,
arranges themas 0, 1, 3, 2, 6, 7, 5, 4.

The Walsh-Hadamard transform is used in a number of applications, such as image processing,
speech processing, filtering, and power spectrum analysis. It is very useful for reducing bandwidth
storage requirements and spread-spectrum analysis. Like the FFT, the Walsh-Hadamard transform
has a fast version, the fast Walsh-Hadamard transform (fwht). Compared to the FFT, the FWHT
requires less storage space and is faster to calculate because it uses only real additions and
subtractions, while the FFT requires complex values. The FWHT is able to represent signals with
sharp discontinuities more accurately using fewer coefficients than the FFT. Both the FWHT and the
inverse FWHT (ifwht) are symmetric and thus, use identical calculation processes. The FWHT and
IFWHT for a signal x(t) of length N are defined as:

1 N-1
Yn =1 > XWAL(n, i),
i=0
N-1
Xi= > YaWAL(n,i),
i=0

where i = 0,1, ..., N - 1 and WAL(n,i) are Walsh functions. Similar to the Cooley-Tukey algorithm for
the FFT, the N elements are decomposed into two sets of N/2 elements, which are then combined




Walsh-Hadamard Transform

using a butterfly structure to form the FWHT. For images, where the input is typically a 2-D signal,
the FWHT coefficients are calculated by first evaluating across the rows and then evaluating down
the columns.

For the following simple signal, the resulting FWHT shows that x was created using Walsh functions
with sequency values of 0, 1, 3, and 6, which are the nonzero indices of the transformed x. The
inverse FWHT recreates the original signal.

x=1[422002 -20]
y = fwht(x)
X =
4 2 2 0 0 2 2 0
y =
1 1 0 1 0 0 1 0

x1l = ifwht(y)

x1

See Also
fwht | ifwht

Related Examples

. “Walsh-Hadamard Transform for Spectral Analysis and Compression of ECG Signals” on page 8-
48
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Walsh-Hadamard Transform for Spectral Analysis and
Compression of ECG Signals

8-48

Use an electrocardiogram (ECG) signal to illustrate working with the Walsh-Hadamard transform.
ECG signals typically are very large and need to be stored for analysis and retrieval at a future time.
Walsh-Hadamard transforms are particularly well-suited to this application because they provide
compression and thus require less storage space. They also provide rapid signal reconstruction.

Start with an ECG signal. Replicate it to create a longer signal and insert some additional random
noise.

xe = ecg(512);
xr = repmat(xe,1,8);
X = xr + 0.1.*randn(1,length(xr));

Transform the signal using the fast Walsh-Hadamard transform. Plot the original signal and the
transformed signal.

y = fwht(x);

subplot(2,1,1)

plot(x)

xlabel('Sample index')
ylabel('Amplitude")
title('ECG Signal')

subplot(2,1,2)
plot(abs(y))
xlabel('Sequency index')
ylabel('Magnitude")
title('WHT Coefficients')
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The plot shows that most of the signal energy is in the lower sequency values, below approximately
1100. Store only the first 1024 coefficients (out of 4096). Try to reconstruct the signal accurately
from only these stored coefficients.

y(1025:1length(x)) = 0;
xHat = ifwht(y);

figure

plot(x)

hold on

plot(xHat)

xlabel('Sample Index')

ylabel('ECG Signal Amplitude')
legend('Original', 'Reconstructed')
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The reproduced signal is very close to the original but has been compressed to a quarter of the size.
Storing more coefficients is a tradeoff between increased resolution and increased noise, while
storing fewer coefficients can cause loss of peaks.

See Also
fwht | ifwht
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Eliminate Outliers Using Hampel Identifier

This example shows a naive implementation of the procedure used by hampel to detect and remove
outliers. The actual function is much faster.

Generate a random signal, x, containing 24 samples. Reset the random number generator for
reproducible results.

rng default

x = 24;
X = randn(1,1x);

Generate an observation window around each element of x. Take k = 2 neighbors at either side of the
sample. The moving window that results has a length of 2 x 2 + 1 = 5 samples.

k = 2;
ilo = (1:1x)-k;
iHi = (1:1x)+k;

Truncate the window so that the function computes medians of smaller segments as it reaches the
signal edges.

ilo(iLo<l) = 1;
iHi(iHi>1x) = 1x;

Record the median of each surrounding window. Find the median of the absolute deviation of each
element with respect to the window median.

for j = 1:1x
w = x(iL
medj = m
mmed (j)
mmad ()
end

(3):+iHi(3));

dian(w);

medj ;
median(abs(w-medj));

I noo

Scale the median absolute deviation with

— L <1482

J2erf™ (1/2)
to obtain an estimate of the standard deviation of a normal distribution.
sd = mmad/(erfinv(1/2)*sqrt(2));

Find the samples that differ from the median by more than nd = 2 standard deviations. Replace each
of those outliers by the value of the median of its surrounding window. This is the essence of the
Hampel algorithm.

nd = 2;

ki = abs(x-mmed) > nd*sd;
yu = X;

yu(ki) = mmed(ki);
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Use the hampel function to compute the filtered signal and annotate the outliers. Overlay the filtered

values computed in this example.
hampel(x, k,nd)

hold on
plot(yu, 'o', 'HandleVisibility', 'off"')

25

hold off
4 T T T
original signal
filtered signal
ar outliers
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See Also
hampel
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* “SPTool: An Interactive Signal Processing Environment” on page 9-2
* “Opening SPTool” on page 9-3

* “Getting Context-Sensitive Help” on page 9-4

* “Signal Browser” on page 9-5

» “Filter Visualization Tool” on page 9-7

* “Spectrum Viewer” on page 9-9
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SPTool: An Interactive Signal Processing Environment

9-2

In this section...

“SPTool Overview” on page 9-2

“SPTool Data Structures” on page 9-2

SPTool Overview

SPTool is an interactive GUI for digital signal processing used to

* Analyze signals

* Design filters

* Analyze (view) filters
+ Filter signals

* Analyze signal spectra

You can accomplish these tasks using four GUIs that you access from within SPTool:

* The “Signal Browser” on page 9-5 is for analyzing signals. You can also play signals using your
computer's audio hardware.

» Filter Designer is available for designing or editing FIR and IIR digital filters. Most Signal
Processing Toolbox filter design methods available at the command line are also available in Filter
Designer.

» The “Filter Visualization Tool” on page 9-7 (FVTool) is for analyzing filter characteristics.

* The “Spectrum Viewer” on page 9-9 is for spectral analysis. You can use Signal Processing
Toolbox spectral estimation methods to estimate the power spectral density of a signal.

SPTool Data Structures

You can use SPTool to analyze signals, filters, or spectra that you create at the MATLAB command
line.

You can bring signals, filters, or spectra from the MATLAB workspace into the SPTool workspace
using File > Import. For more information, see “Importing Filters and Spectra” on page 9-22.
Signals, filters, or spectra that you create in (or import into) the SPTool workspace exist as MATLAB
structures. See the MATLAB documentation for more information on MATLAB structures.

When you use File > Export to save signals, filters, and spectra that you create or modify in SPTool,
these are also saved as MATLAB structures. For more information on exporting, see “Exporting
Signals, Filters, and Spectra” on page 9-19.



Opening SPTool

Opening SPTool

To open SPTool, type

sptool
B SPTool: startup.spt E=H =R
File Edit Window | Help | »
Signals Filters Spectra
chirp [vector] PZlp [imported] chirpse [auto]
train [wector] FIRbp [de=ign] trainze [auto]

[ View | View | View |
[ Hew ] [ Create ]
[ Edit I Update ]
[ Apply ]

When you first open SPTool, it contains a collection of default signals, filters, and spectra. To specify
your own preferences for what signals, filters, and spectra to see when SPTool opens see “Setting
Preferences” on page 9-32.

You can access these three GUIs from SPTool by selecting a signal, filter, or spectrum and clicking the
appropriate View button:

* Signal Browser on page 9-5
* Filter Visualization Tool on page 9-7
* Spectrum Viewer on page 9-9

You can access Filter Designer by clicking New to create a new filter or Edit to edit a selected
filter. Clicking Apply applies a selected filter to a selected signal.

Create opens the Spectrum Viewer and creates the power spectral density of the selected signal.
Update opens the Spectrum Viewer for the selected spectrum.

9-3
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Getting Context-Sensitive Help

9-4

To find information on a particular feature or setting of the “Signal Browser” on page 9-5:

* In any Measurements panel, right-click anywhere on the panel and select What's this?.

In any dialog box where you see the \.) icon in the lower left corner, right-click on any
parameter and select What's this?.

To find information on a particular region of Filter Designer or “Spectrum Viewer” on page 9-9:
Click What's this? ﬂ
2 Click on the region of the GUI you want information on.

You can also use Help > What's This? to launch context-sensitive help.



Signal Browser

Signal Browser

In this section...

“Overview of the Signal Browser” on page 9-5
“Opening the Signal Browser” on page 9-5

Overview of the Signal Browser

You can use the Signal Browser to display and analyze signals listed in the Signals list box in SPTool.

Using the Signal Browser, you can:

Analyze and compare vector or array (matrix) signals.
Zoom in on portions of signal data.

Measure a variety of characteristics of signal data.
Compare multiple signals.

Play portions of signal data on audio hardware.

Print signal plots.

Opening the Signal Browser

To open the Signal Browser from SPTool:

1

2

Select one or more signals in the Signals list in SPTool.

Click View under the Signals list.

n Signal Browser EI@

File Tools View Help k]

alaw i O EHAERD $E) S

Amplitude

Time (secs)

The Signal Browser has the following components:
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* A display region for analyzing signals

* A panels section on the right side of the scope window, which shows statistics and information
about your signals

* A toolbar with buttons for convenient access to frequently used functions

For more information on the Signal Browser, see the sptool function reference page.
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Filter Visualization Tool

In this section...

“Connection between FVTool and SPTool” on page 9-7
“Opening the Filter Visualization Tool” on page 9-7

“Analysis Parameters” on page 9-8

Connection between FVTool and SPTool

You can use the Filter Visualization Tool to analyze response characteristics of the selected filter(s).
See FVTool for detailed information about FVTool.

If you start FVTool by clicking the SPTool Filter View button, that FVTool is linked to SPTool. Any
changes made in SPTool to the filter are immediately reflected in FVTool. The FVTool title bar
includes "SPTool" to indicate the link.

If you start an FVTool by clicking the New button or by selecting File > New from within FVTool, that
FVTool is a standalone version and is not linked to SPTool.

Note Every time you click the Filter View button a new, linked FVTool starts. This allows you to view
multiple analyses simultaneously.

Opening the Filter Visualization Tool

You open FVTool from SPTool as follows.

1 Select one or more filters in the Filters list in SPTool.
2 Click the View button under the Filters list.

When you first open FVTool, it displays the selected filter's magnitude plot.
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Analysis Parameters

In the plot area of any filter response plot, right-click and select Analysis Parameters to display
details about the displayed plot. See “Analysis Parameters” in the Filter Designer online help for
more information.

You can change any parameter in a linked FVTool, except the sampling frequency. You can only
change the sampling frequency using the SPTool Edit > Sampling Frequency or the SPTool Filters
Edit button.
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Spectrum Viewer

In this section...

“Spectrum Viewer Overview” on page 9-9

“Opening the Spectrum Viewer” on page 9-9

Spectrum Viewer Overview

You can use the Spectrum Viewer for estimating and analyzing a signal's power spectral density
(PSD). You can use the PSD estimates to understand a signal's frequency content.

The Spectrum Viewer provides the following functionality.

* Analyze and compare spectral density plots.
» Use different spectral estimation methods to create spectra:

* Burg (pburg)

* Covariance (pcov)

o FFT (fft)

* Modified covariance (pmcov)

¢ MTM (multitaper method) (pmtm)
e MUSIC (pmusic)

*  Welch (pwelch)

*  Yule-Walker AR (pyulear)

* Modify power spectral density parameters such as FFT length, window type, and sample
frequency.

* Print spectral plots.

Opening the Spectrum Viewer

To open the Spectrum Viewer and create a PSD estimate from SPTool:

1  Select a signal from the Signal list box in SPTool.
2 C(Click Create in the Spectra list.
3  Click Apply in the Spectrum Viewer.

To open the Spectrum Viewer with a PSD estimate already listed in SPTool:

1  Select a PSD estimate from the Spectra list box in SPTool.
2 Click View in the Spectra list.

For example:

1  Select mtlb in the default Signals list in SPTool.
2 C(Click Create in SPTool to open the Spectrum Viewer.
3 Click Apply in the Spectrum Viewer to plot the spectrum.
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The Spectrum Viewer has the following components:

* A signal identification region that provides information about the signal whose power spectral
density estimate is displayed

* A Parameters region for modifying the PSD parameters

* A display region for analyzing spectra and an Options menu for modifying display characteristics

* Spectrum management controls

* Inherit from menu to inherit PSD specifications from another PSD object listed in the menu
* Revert button to revert to the named PSD's original specifications
* Apply button for creating or updating PSD estimates

* A toolbar with buttons for convenient access to frequently used functions

Icon Description

= Print and print preview

T RIS T A M 0 Zoom the signal in and out

i Select one of several loaded signals

= Set the display color and line style of a signal

™M Toggle the markers on and off
= m s | AW Set marker types
ﬂ Turn on the What's This help
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Filtering and Analysis of Noise

In this section...

“Overview” on page 9-11

“Importing a Signal into SPTool” on page 9-11
“Designing a Filter” on page 9-12

“Applying a Filter to a Signal” on page 9-14

“Analyzing a Signal” on page 9-15

“Spectral Analysis in the Spectrum Viewer” on page 9-17

Overview

The following sections provide an example of using the GUI-based interactive tools to:

* Design and implement an FIR bandpass digital filter
* Apply the filter to a noisy signal
* Analyze signals and their spectra

The steps include:

1 “Importing a Signal into SPTool” on page 9-11

2 Designing a bandpass filter using Filter Designer on page 9-12

3 Applying the filter to the original noise signal to create a bandlimited noise signal on page 9-14
4

Comparing the time domain information of the original and filtered signals using the Signal
Browser on page 9-15

5 Comparing the spectra of both signals using the Spectrum Viewer on page 9-17

Importing a Signal into SPTool

To import a signal into SPTool from the workspace or disk, the signal must be either:

* A special MATLAB signal structure, such as that saved from a previous SPTool session
* Assignal created as a variable (vector or matrix) in the MATLAB workspace

For this example, create a new signal at the command line and then import it as a structure into
SPTool:

1 Create a random signal in the MATLAB workspace by typing

X = randn(5000,1);
2 If SPTool is not already open, open SPTool by typing

sptool

The SPTool window is displayed.
3  Select File > Import. The Import to SPTool dialog opens.

9-11
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The variable X is displayed in the Workspace Contents list. (If it is not, select the From
Workspace radio button to display the contents of the workspace.)

4  Select the signal and import it into the Data field:

Select the signal variable x in the Workspace Contents list.

T 9

Make sure that Signal is selected in the Import As pull-down menu.
Click on the arrow to the left of the Data field or type x in the Data field.
Type 5000 in the Sampling Frequency field.

Name the signal by typing noise in the Name field.

Click OK.

= 0 Q 0n

The signal noise[vector] appears and is selected in SPTool's Signals list.

Note You can import filters on page 9-22 and spectra on page 9-23 into SPTool in much the same
way as you import signals. See “Importing Filters and Spectra” on page 9-22 for specific details.

You can also import signals from MAT-files on your disk, rather than from the workspace. See
“Loading Variables from the Disk” on page 9-25 for more information.

Type help sptool for information about importing from the command line.

Designing a Filter

You can import an existing filter into SPTool, or you can design and edit a new filter using Filter
Designer.

In this example, you

1 Open a default filter in Filter Designer.
2 Specify an equiripple bandpass FIR filter.
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Opening Filter Designer

To open Filter Designer, click New in SPTool. Filter Designer opens with a default filter named
filtl.

Specifying the Bandpass Filter

Design an equiripple bandpass FIR filter with the following characteristics:

Sampling frequency of 5000 Hz

Stopband frequency ranges of [0 500] Hz and [1500 2500] Hz
Passband frequency range of [750 1250] Hz

Ripple in the passband of 0.01 dB

Stopband attenuation of 75 dB

To modify the filter in Filter Designer to meet these specifications, you need to

Select Bandpass from the Response Type list.
Verify that FIR Equiripple is selected as the Design Method.

Verify that Minimum order is selected as the Filter Order and that the Density Factor is set to
20.

Under Frequency Specifications, set the sampling frequency (Fs) and the passband (Fpassl,
Fpass2) and stopband (Fstop1, Fstop2) edges:

Units Hz
Fs 5000
Fstopl 500
Fpass1 750
Fpass2 1250
Fstop2 1500

Under Magnitude Specifications, set the stopband attenuation (Astopl, Astop2) and the
maximum passband ripple (Apass):

Units dB
Astopl 75
Apass 0.01
Astop2 75

Click Design Filter to design the new filter. When the new filter is designed, the magnitude
response of the filter is displayed.
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The resulting filter is an order-78 bandpass equiripple filter.

Applying a Filter to a Signal
When you apply a filter to a signal, you create a new signal in SPTool representing the filtered signal.
To apply the filter filt1 you just created to the signal noise,

1 In SPTool, select the signal noise[vector] from the Signals list and select the filter (named
filtl[design]) from the Filters list.
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<} SPTool: startup_spt M=l E3
File Edit ‘Window Help
Signals Filters Spectra
mtlb [wector] | |LSIp [design] - -
chirp [vectar] _I FZlp [imparted] _I chirpze [auto]
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MHew I Create I
Edit | Update |
Apply |
Click Apply under the Filters list.
I
Input Signal hoise
Fitter I(irt1
AR (nirect-Form FIR ]
Output Sighal Isig'l
QK | Cancel |

Leave the Algorithm as Direct-Form FIR.

Note You can apply one of two filtering algorithms to FIR filters. The default algorithm is specific
to the filter structure, which is shown in the Filter Designer Current Filter Info frame.
Alternately for FIR filters, FFT based FIR (fftfilt) uses the algorithm described in

fftfilt.

For IIR filters, the alternate algorithm is a zero-phase IIR that uses the algorithm described in

filtfilt.

Enter blnoise as the Output Signal name.
Click OK to close the Apply Filter dialog box.

The filter is applied to the selected signal, and the filtered signal blnoise[vector] is listed in

the Signals list in SPTool.

Analyzing a Signal

You can analyze and print signals using the Signal Browser. You can also play the signals if your
computer has audio output capabilities.
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9-16

For example, compare the signal noise on page 9-11 to the filtered signal blnoise on page 9-

14.

1

Shift+click on the noise and blnoise signals in the Signals list of SPTool to select both
signals.

Click View under the Signals list.

The Signal Browser is activated, and both signals are displayed in the display region. (The names
of both signals are shown above the display region.) Initially, the original noise signal covers up
the bandlimited blnoise signal.

Push the selection button ﬂ on the toolbar to select the blnoise signal.

The display area is updated. Now you can see the blnoise signal superimposed on top of the
noise signal. The signals are displayed in different colors in both the display region and the
panner. You can change the color of the selected signal using the Line Properties button on the

+ | Signal Browser [ O] =]
File Markers ‘Window Help

||& @] g pan] i ¢ moe |50 =i e 82

4
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Time
5
e R b
5|
Marker 1 H:|D.3332 Marker 2 H:|D.ssss d: 0.3334
. -0.091E56 —  y-07Ev2 dy: -0.63555

Playing a Signal

When you click Play in the Signal Browser toolbar, ﬂ the active signal is played on the computer's
audio hardware.

1

2

To hear a portion of the active (selected) signal

a  Use the vertical markers on page 9-30to select a portion of the signal you want to play.

Vertical markers are enabled by the M and ﬂ buttons.
b  Click Play.
To hear the other signal
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a  Select the signal using the selection button on the toolbar. You can also select the signal
directly in the display region.

b  Click Play again.

Printing a Signal

You can print from the Signal Browser using the Print button, @

You can use the line display buttons to maximize the visual contrast between the signals by setting
the line color for noise on page 9-11 to gray and the line color for blnoise on page 9-11 to white. Do
this before printing two signals together.

Note You can follow the same rules to print spectra, but you can't print filter responses directly from
SPTool.

Use the Signal Browser region in the Preferences dialog box in SPTool to suppress printing of both
the panner and the marker settings.

To print both signals, click Print in the Signal Browser toolbar.

Spectral Analysis in the Spectrum Viewer

You can analyze the frequency content of a signal using the Spectrum Viewer, which estimates and
displays a signal's power spectral density.

For example, to analyze and compare the spectra of noise and blnoise:
1 Create a power spectral density (PSD) object on page 9-17, spect1l, that is associated with the
signal noise, and a second PSD object, spect2, that is associated with the signal blnoise.

Open the Spectrum Viewer to analyze both of these spectra on page 9-17.
Print both spectra on page 9-17.

Creating a PSD Object From a Signal

1  Click on SPTool, or select Window > SPTool in any active open GUI. SPTool is now the active
window.
Select the noise[vector] on page 9-11 signal in the Signals list of SPTool.
Click Create in the Spectra list.
The Spectrum Viewer is activated, and a PSD (spectl) corresponding to the noise signal is
created in the Spectra list. The PSD is not computed or displayed yet.

4 Click Apply in the Spectrum Viewer to compute and display the PSD estimate spectl using the
default parameters.

The PSD of the noise signal is displayed in the display region. The identifying information for
the PSD's associated signal (noise) is displayed above the Parameters region.

The PSD estimate spectl deviates between 2 and 3 dB from its mean value, so the noise can be
considered to have a "flat" power spectral density.
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5 Follow steps 1 through 4 for the bandlimited noise signal blnoise on page 9-14 to create a second
PSD estimate spect?2.

The PSD estimate spect?2 is flat between 750 and 1250 Hz and has 75 dB less power in the
stopband regions of filt1.

Opening the Spectrum Viewer with Two Spectra

Reactivate SPTool again, as in step 1 above.
Shift+click on spectl and spect2 in the Spectra list to select them both.
Click View in the Spectra list to reactivate the Spectrum Viewer and display both spectra

together.
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Printing the Spectra

Before printing the two spectra together, use the color and line style selection button, ==, to
differentiate the two plots by line style, rather than by color.

To print both spectra:

Click Print Preview in the toolbar on the Spectrum Viewer.

2  From the Spectrum Viewer Print Preview window, drag the legend out of the display region so
that it doesn't obscure part of the plot.

3 Click Print in the Spectrum Viewer Print Preview window.
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Exporting Signals, Filters, and Spectra

In this section...

“Opening the Export Dialog Box” on page 9-19
“Exporting a Filter to the MATLAB Workspace” on page 9-19

Opening the Export Dialog Box

To save the filter Tilt1 you just created in this example, open the Export dialog box with filtl
preselected:

1 Select filtl in the SPTool Filters list.
2 Select File > Export.

The Export dialog box opens with filt1 preselected.

«) Export from SPTool o ] oA |

~ Export List

Signal: mtlb [vector] ;I
Sigmal: chirp [wector] : .
Zigmal: train [vector] [~ Export fiters as TF ohjects
Filter: LSlp [desigml

Filter: PZlp [imported]

Filter: FIPbp [design] .

T filtl [dezign] Export to disk.. |
Spectrum: mtlhse [autao]
Spectrum: chirpse [autc Export to workspace I

Spectrum: trainse [autc

Cancel I

Help I

! o™

Shiowe: IAII - I

Exporting a Filter to the MATLAB Workspace

To export the filter filtl to the MATLAB workspace:

1 Select filtl from the Export List and deselect all other items using Ctrl+click.
2  Click Export to Workspace.
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Accessing Filter Parameters
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In this section...

“Accessing Filter Parameters in a Saved Filter” on page 9-20

“Accessing Parameters in a Saved Spectrum” on page 9-20

Accessing Filter Parameters in a Saved Filter

The MATLAB structures created by SPTool have several associated fields, many of which are also
MATLAB structures. See the MATLAB documentation for general information about MATLAB
structures.

For example, after exporting on page 9-19 a filter filt1 to the MATLAB workspace, type
filtl

to display the fields of the MATLAB filter structure. The tf field of the structure contains information
that describes the filter.

The tf Field: Accessing Filter Coefficients

The tf field is a structure containing the transfer function representation of the filter. Use this field
to obtain the filter coefficients;

« filtl.tf.num contains the numerator coefficients.
« filtl.tf.den contains the denominator coefficients.

The vectors contained in these structures represent polynomials in descending powers of z. The
numerator and denominator polynomials are used to specify the transfer function

Bz) _ b(1)+b2)z~ 1+ +bnb+ 1)z ™
AR) g+ a2zt + - +ama+ Dz"

=
N

N—
Il

1l

where:

* b is a vector containing the coefficients from the tf.num field.
* ais avector containing the coefficients from the tf.den field.
* m is the numerator order.

* nisthe denominator order.

You can change the filter representation from the default transfer function to another form by using
the tf2ss or tf2zp functions.

Note The FDAspecs field of your filter contains internal information about Filter Designer and
should not be changed.

Accessing Parameters in a Saved Spectrum

The following structure fields describe the spectra saved by SPTool.



Accessing Filter Parameters

Field Description

P The spectral power vector.

f The spectral frequency vector.

confid A structure containing the confidence intervals data

» The confid. level field contains the chosen confidence level.

* The confid.Pc field contains the spectral power data for the
confidence intervals.

« The confid.enable field contains a 1 if confidence levels are
enabled for the power spectral density.

signallLabel The name of the signal from which the power spectral density was
generated.
Fs The associated signal's sample rate.

You can access the information in these fields as you do with every MATLAB structure.

For example, if you export an SPTool PSD estimate spectl to the workspace, type

spectl.P

to obtain the vector of associated power values.
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Importing Filters and Spectra

9-22

In this section...

“Similarities to Other Procedures” on page 9-22
“Importing Filters” on page 9-22

“Importing Spectra” on page 9-23

Similarities to Other Procedures

The procedures are very similar to those explained in

+ “Importing a Signal into SPTool” on page 9-11 for loading variables from the workspace
* “Loading Variables from the Disk” on page 9-25 for loading variables from your disk
Importing Filters

When you import filters, first select the appropriate filter form from the Form list. SPTool does not
currently support the import of filter objects.

-} Import to SPTool x|
Source — “Workspace Contents — r Import &g Im_
%' Fram "Warkspace <no zelection Farm: ITlansfer Function j
™ Fram Digk Transfer Function
¥ . State Space
MR TTE Hene Zeros, Poles, Gain
I - | I 2nd Order Sections
Browse... |
Sampling Frequency
EIESE
— Mame
[ | Cancel | Help | I filk1

For every filter you specify a variable name or a value for the filter's sampling frequency in the
Sampling Frequency field. Each filter form requires different variables.

Transfer Function
For Transfer Function, you specify the filter by its transfer function representation:

B(z) _ b(l)+ b(2)2'_1 + - +bm+1)z7™
AR)  g)+a@)z7t+ - +amn+ 1)z

=
N

N—
I
I

* The Numerator field specifies a variable name or value for the numerator coefficient vector b,
which contains m+1 coefficients in descending powers of z.

* The Denominator field specifies a variable name or value for the denominator coefficient vector
a, which contains n+1 coefficients in descending powers of z.
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State Space

For State Space, you specify the filter by its state-space representation:

X = Ax + Bu
y=Cx+Du

The A-Matrix, B-Matrix, C-Matrix, and D-Matrix fields specify a variable name or a value for each
matrix in this system.

Zeros, Poles, Gain

For Zeros, Poles, Gain, you specify the filter by its zero-pole-gain representation:

Z(2) k(z—Z(l))(z—z(Z))---(z z(m))
P(2) (z = p(1))(z = p(2))(z = p(n))

* The Zeros field specifies a variable name or value for the zeros vector z, which contains the
locations of m zeros.

=
N

N—
Il

Il

* The Poles field specifies a variable name or value for the zeros vector p, which contains the
locations of n poles.

* The Gain field specifies a variable name or value for the gain k.
Second Order Sections
For 2nd Order Sections you specify the filter by its second-order section representation:

L L b b -1 b -2

_ _ 0k T D1xkZ ~ + DkZ
H(Z)_ H Hk(Z)— 1 -1 )
k=1 k=1 L+aiz - +axz

The SOS Matrix field specifies a variable name or a value for the L-by-6 SOS matrix
bo1 b11 bo1 1 a11 apn
boz b12 bop 1 a1z ax
SOS = . - . . . .
bor bir bor 1 ajp ayr
whose rows contain the numerator and denominator coefficients by, and a;, of the second-order
sections of H(z).

Note If you import a filter that was not created in SPTool, you can only edit that filter using the Pole-
Zero Editor.

Importing Spectra

When you import a power spectral density (PSD), you specify:

* A variable name or a value for the PSD vector in the PSD field

* A variable name or a value for the frequency vector in the Freq. Vector field
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The PSD values in the PSD vector correspond to the frequencies contained in the Freq. Vector
vector; the two vectors must have the same length.

) Import to SPTool i
Source File Contents - Impart A ISpectlum ,I—

I PSD
I Freq. Wector

" From ‘Workspace

— Mame

(] 4 | Cancel Help I zpect]
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Loading Variables from the Disk

To import variables representing signals, filters, or spectra from a MAT-file on your disk;
1 Select the From Disk radio button and do either of the following:

* Type the name of the file you want to import into the MAT-file Name field and press either
the Tab or the Enter key on your keyboard.

* Select Browse, and then find and select the file you want to import using Select > File to
Open. Click OK to close that dialog.

In either case, all variables in the MAT-file you selected are displayed in the File Contents list.
2 Select the variables to be imported into SPTool.

You can now import one or more variables from the File Contents list into SPTool, as long as these
variables are scalars, vectors, or matrices.

9-25



9 sprool:A Signal Processing GUI Suite

Saving and Loading Sessions
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In this section...

“SPTool Sessions” on page 9-26
“Filter Formats” on page 9-26

SPTool Sessions

When you start SPTool, the default startup.spt session is loaded. To save your work in the startup
SPTool session, use File > Save Session or to specify a session name, use File > Save Session As.

To recall a previously saved session, use File > Open Session.

Filter Formats

When you start SPTool or open a session, the current filter design format preference is compared to
the filter formats in the session. See “Setting Preferences” on page 9-32.

* If the formats match, the session opens.
+ If the filter preference is Filter Designer, but the session contains Filter Designer filters, this
warning displays:

+) Convert filters to use FDATool? o ] oA |

Filterz in thiz sezsion were created with Filker Designer and are not
compatible with FOAT ool,

Select "Conwert if pou want to zet FOAT ool az the prefered filker design
toal and permanently canvert all filters in this session to an FDAT ool
format.
Mote: Corvverting to an FOAT ool format cannot be undore,
Select "o not uze FOAT ool bo continue uzing Filter Degigner.

Mote: Filter Degigner will be removed in a future release.

Do not use FDATool

Click Convert to convert the filters to Filter Designer format. Click Don't Use Filter Designer
to leave the filters in Filter Designer format and change the preference to Use Filter Designer.

» [If the filter preference is Use Filter Designer, but the session contains Filter Designer filters,
this warning displays:




Saving and Loading Sessions

H | Design filters using Filter Desig =101 x|

Filters in thiz session were created with FDAT ool and are not compatible
with Filter Degigner. Switching to Filker Designer will delete all filkers

it thiz sezsion,

Do vou want to use Filter Dezsigner and delete your current filkers?

Mate: Filter Dezsigner will be remaoved in a future release.

Yesl Mnl

Click Yes to remove the current filters. Click No to leave the filters in Filter Designer.
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Selecting Signals, Filters, and Spectra

9-28

All signals, filters, or spectra listed in SPTool exist as special MATLAB structures. You can bring data
representing signals, filters, or spectra into SPTool from the MATLAB workspace. In general, you can
select one or several items in a given list box. An item is selected when it is highlighted.

The Signals list shows all vector and array signals in the current SPTool session.
The Filters list shows all designed and imported filters in the current SPTool session.
The Spectra list shows all spectra in the current SPTool session.

You can select a single data object in a list, a range of data objects in a list, or multiple separate data
objects in a list. You can also have data ohjects simultaneously selected in different lists:
» To select a single item, click it. All other items in that list box become deselected.

* To add or remove a range of items, Shift+click on the items at the top and bottom of the section
of the list that you want to add. You can also drag your mouse pointer to select these items.

* To add a single data object to a selection or remove a single data object from a multiple selection,
Ctrl+click on the object.
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Editing Signals, Filters, or Spectra

You can edit selected items in SPTool by

1 Selecting the names of the signals, filters, or spectra you want to edit.
2 Selecting the appropriate Edit menu item:

* Duplicate to copy an item in an SPTool list

* Clear to delete an item in an SPTool list

* Name to rename an item in an SPTool list

* Sampling Frequency to modify the sampling frequency associated with either a signal (and
its associated spectra) or filter in an SPTool list

The pull-down menu next to each menu item shows the names of all selected items.

You can also edit the following signal characteristics by right-clicking in the display region of the
Signal Browser, the Filter Visualization Tool, or the Spectrum Viewer:

* The signal name

* The sampling frequency

* The line style properties

Note If you modify the sample rate associated with a signal's spectrum using the right-click menu on
the Spectrum Viewer display region, the sample rate of the associated signal is automatically
updated.
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You can use the markers on the Signal Browser on page 9-5 or the Spectrum Viewer on page 9-5 to
make measurements on either of the following:

* Asignal in the Signal Browser

* A power spectral density plotted in the Spectrum Viewer

The following marker buttons are included

BT S

Icon Description

Toggle markers on/off

Vertical markers

Horizontal markers

Vertical markers with tracking

Vertical markers with tracking and slope

=) ]| = | =) s

Display peaks (local maxima)

You can find peaks in a signal from the command line with findpeaks

l? Display valleys (local minima)

To make a measurement:

1  Select a line to measure (or play, if you are in the Signal Browser).
Select one of the marker buttons to apply a marker to the displayed signal.
3 Position a marker in the main display area by grabbing it with your mouse and dragging:
a  Select a marker setting. If you choose the Vertical, Track, or Slope buttons, you can drag a

marker to the right or left. If you choose the Horizontal button, you can drag a marker up
or down.

b  Move the mouse over the marker (1 or 2) that you want to drag.

The hand cursor with the marker number inside it €I/ is displayed when your mouse passes
over a marker.

¢ Drag the marker to where you want it on the signal

As you drag a marker, the bottom of the Signal Browser shows the current position of both
markers. Depending on which marker setting you select, some or all of the following fields are
displayed — x1, y1, x2, y2, dx, dy, m. These fields are also displayed when you print from the
Signal Browser, unless you suppress them.



Making Signal Measurements with Markers

You can also position a marker by typing its x1 and x2 or yl and y2 values in the region at the
bottom.
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In this section...

“Overview of Setting Preferences” on page 9-32
“Summary of Settable Preferences” on page 9-32

Overview of Setting Preferences

Use File > Preferences to customize displays and certain parameters for SPTool and its four
component GUIs. If you change any preferences, a dialog box displays when you close SPTool asking
if you want to save those changes. If you click Yes, the new settings are saved on disk and are used
when you restart SPTool from the MATLAB workspace.

Note You can set MATLAB preferences that affect the Filter Visualization Tool only from within
FVTool by selecting File > Preferences. You can set FVTool-specific preferences using Analysis >
Analysis Parameters.

When you first select Preferences, the Preferences dialog box opens with Markers selected by
default.

) Preferences for SPTool ﬂ

— Markers

Colars Marker Eolorl ot
Signal Browwser
Spectun Viewer Marker Style I 0 j
Filter Designer ;
Default Session Marker S|ze| g
plug-ingz
Imitial Type I track j
Help... | Facton Settings | Eevert Fanel | ok | Cancel |

Change any marker settings, if desired. To change settings for another category, click its name in the
category list to display its settings. Most of the fields are self-explanatory. Details of the Filter Design
options are described below.

Summary of Settable Preferences

In the Preferences regions, you can

* Select colors and markers for all displays.
* Select colors and line styles for displayed signals.

* Configure labels, and enable/disable markers, panner, and zoom in the Signal Browser on page 9-
5.



Setting Preferences

Configure display parameters, and enable/disable markers and zoom in the Spectrum Viewer on
page 9-9.

Enable/disable use of a default session file.
Export filters for use with Control System Toolbox software.
Enable/disable search for plug-ins at startup.
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» “List of Signal Processing Toolbox Functions that Support Code Generation” on page 10-2
* “Specifying Inputs in Code Generation from MATLAB” on page 10-9
* “Apply Lowpass Filter to Input Signal” on page 10-12
» “Zero-Phase Filtering” on page 10-14
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List of Signal Processing Toolbox Functions that Support Code
Generation

Code generation from MATLAB is a restricted subset of the MATLAB language that provides
optimizations for:

* Generating efficient, production-quality C/C++ code and MEX files for deployment in desktop and
embedded applications. For embedded targets, the subset restricts MATLAB semantics to meet
the memory and data type requirements of the target environments.

Depending on which feature you wish to use, there are additional required products. For a
comprehensive list, see “Installing Prerequisite Products” (MATLAB Coder).

Code generation from MATLAB supports Signal Processing Toolbox functions listed in the table. To
generate C code, you must have the MATLAB Coder™ software. If you have the Fixed-Point Designer
software, you can use fiaccel to generate MEX code for fixed-point applications.

To follow the examples in this documentation:

* To generate C/C++ code and MEX files with codegen, install the MATLAB Coder software, the
Signal Processing Toolbox, and a C compiler. For the Windows® platform, MATLAB supplies a
default C compiler. Run mex -setup at the MATLAB command prompt to set up the C compiler.

* Change to a folder where you have write permission.

An asterisk (*) indicates that the reference page has usage notes and limitations for C/C++ code

generation.
abs Absolute value and complex magnitude
alignsignals Align two signals by delaying earliest signal
angle Phase angle
bandpower* Band power
barthannwin Modified Bartlett-Hann window
bartlett Bartlett window
besselap* Bessel analog lowpass filter prototype
bilinear Bilinear transformation method for analog-to-digital filter conversion
binmask2sigroi Convert binary mask to matrix of ROI limits
bitrevorder Permute data into bit-reversed order
blackman Blackman window
blackmanharris Minimum four-term Blackman-Harris window
bohmanwin Bohman window
buttap Butterworth filter prototype
butter Butterworth filter design
buttord* Butterworth filter order and cutoff frequency
cceps Complex cepstral analysis
cconv Modulo-n circular convolution
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cfirpm* Complex and nonlinear-phase equiripple FIR filter design
cheblap* Chebyshev Type I analog lowpass filter prototype
cheblord* Chebyshev Type I filter order

cheb2ap* Chebyshev Type II analog lowpass filter prototype
cheb2ord* Chebyshev Type II filter order

chebwin Chebyshev window

cheby1* Chebyshev Type I filter design

cheby?2* Chebyshev Type II filter design

chirp Swept-frequency cosine

conv* Convolution and polynomial multiplication

conv?2 2-D convolution

convmtx Convolution matrix

corrcoef* Correlation coefficients

corrmtx Data matrix for autocorrelation matrix estimation
cov* Covariance

cpsd Cross power spectral density

cummax Cumulative maximum

cummin Cumulative minimum

cusum* Detect small changes in mean using cumulative sum
czt* Chirp Z-transform

db2pow Convert decibels to power

dct* Discrete cosine transform

deconv* Deconvolution and polynomial division

detrend* Remove polynomial trend

dftmtx Discrete Fourier transform matrix

diric Dirichlet or periodic sinc function

downsample Decrease sample rate by integer factor

dpss* Discrete prolate spheroidal (Slepian) sequences
dtw Distance between signals using dynamic time warping
edr Edit distance on real signals

ellip* Elliptic filter design

ellipap* Elliptic analog lowpass filter prototype
ellipord* Minimum order for elliptic filters

emd* Empirical mode decomposition

enbw Equivalent noise bandwidth

envelope* Signal envelope

envspectrum* Envelope spectrum for machinery diagnosis
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eqtflength Equalize lengths of transfer function's numerator and denominator
extendsigroi Extend signal regions of interest to left and right
extractsigroi* Extract signal regions of interest

falltime* Fall time of negative-going bilevel waveform transitions
fft* Fast Fourier transform

fft2* 2-D fast Fourier transform

fftfilt* FFT-based FIR filtering using overlap-add method
fftshift Shift zero-frequency component to center of spectrum
filloutliers* Detect and replace outliers in data

filter* 1-D digital filter

filter2 2-D digital filter

filtfilt* Zero-phase digital filtering

filtord Filter order

finddelay Estimate delay(s) between signals

findpeaks Find local maxima

findsignal Find signal location using similarity search

firl Window-based FIR filter design

fir2* Frequency sampling-based FIR filter design

fircls* Constrained-least-squares FIR multiband filter design
firclsl* Constrained-least-squares linear-phase FIR lowpass and highpass filter design
firls Least-squares linear-phase FIR filter design

firpm* Parks-McClellan optimal FIR filter design

firpmord* Parks-McClellan optimal FIR filter order estimation
flattopwin Flat top weighted window

freqspace Frequency spacing for frequency response

freqz* Frequency response of digital filter

fsst* Fourier synchrosqueezed transform

fwht Fast Walsh-Hadamard transform

gauspuls Gaussian-modulated sinusoidal RF pulse

gausswin Gaussian window

gmonopuls Gaussian monopulse

goertzel* Discrete Fourier transform with second-order Goertzel algorithm
hamming Hamming window

hann Hann (Hanning) window

hht* Hilbert-Huang transform

hilbert Discrete-time analytic signal using Hilbert transform
icceps Inverse complex cepstrum
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idct* Inverse discrete cosine transform

ifft* Inverse fast Fourier transform

ifft2* 2-D inverse fast Fourier transform

ifftshift Inverse zero-frequency shift

ifsst Inverse Fourier synchrosqueezed transform

ifwht Inverse Fast Walsh-Hadamard transform

instfreg* Estimate instantaneous frequency

interpl* 1-D data interpolation (table lookup)

intfilt* Interpolation FIR filter design

iscola Determine whether window-overlap combination is COLA compliant
isoutlier* Find outliers in data

istft* Inverse short-time Fourier transform

kaiser Kaiser window

kaiserord Kaiser window FIR filter design estimation parameters
kurtogram* Visualize spectral kurtosis

levinson* Levinson-Durbin recursion

1p2bp Transform lowpass analog filters to bandpass

1p2bs Transform lowpass analog filters to bandstop

1p2hp Transform lowpass analog filters to highpass

1p21lp Change cutoff frequency for lowpass analog filter
1sf2poly Convert line spectral frequencies to prediction filter coefficients
max* Maximum elements of an array

maxflat* Generalized digital Butterworth filter design

mean* Average or mean value of array

meanfreq Mean frequency

medfreq Median frequency

median* Median value of array

mergesigroi Merge signal regions of interest

min* Minimum elements of an array

movmad* Moving median absolute deviation

movmedian Moving median

mscohere Magnitude-squared coherence

nuttallwin Nuttall-defined minimum 4-term Blackman-Harris window
obw Occupied bandwidth

orderspectrum Average spectrum versus order for vibration signal
ordertrack* Track and extract order magnitudes from vibration signal
orderwaveform Extract time-domain order waveforms from vibration signal
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parzenwin Parzen (de la Vallée Poussin) window

pchip* Piecewise Cubic Hermite Interpolating Polynomial (PCHIP)
peak2peak Maximum-to-minimum difference

peak2rms Peak-magnitude-to-RMS ratio

pentropy* Spectral entropy of signal

periodogram Periodogram power spectral density estimate

pkurtosis* Spectral kurtosis from signal or spectrogram

pLlomb* Lomb-Scargle periodogram

poly2ac* Convert prediction filter polynomial to autocorrelation sequence
poly21lsf* Convert prediction filter coefficients to line spectral frequencies
poly2rc* Convert prediction filter polynomial to reflection coefficients
pow2db Convert power to decibels

powerbw Power bandwidth

pspectrum* Analyze signals in the frequency and time-frequency domains
pulstran* Pulse train

pwelch Welch's power spectral density estimate

rainflow* Rainflow counts for fatigue analysis

randn* Normally distributed random numbers

rc2ac* Convert reflection coefficients to autocorrelation sequence
rc2poly* Convert reflection coefficients to prediction filter polynomial
rceps Real cepstrum and minimum-phase reconstruction
rcosdesign* Raised cosine FIR pulse-shaping filter design

rectpuls Sampled aperiodic rectangle

rectwin Rectangular window

removesigroi Remove signal regions of interest

resample* Resample uniform or nonuniform data to new fixed rate
risetime* Rise time of positive-going bilevel waveform transitions
rlevinson* Reverse Levinson-Durbin recursion

rms Root-mean-square value

rpmfregmap Frequency-RPM map for order analysis

rpmordermap Order-RPM map for order analysis

rssqg* Root-sum-of-squares level

sawtooth Sawtooth or triangle wave

sfdr* Spurious free dynamic range

sgolay Savitzky-Golay filter design

sgolayfilt Savitzky-Golay filtering

shortensigroi Shorten signal regions of interest from left and right
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sigroi2binmask Convert matrix of ROI limits to binary mask

sin Sine of argument in radians

sinad* Signal to noise and distortion ratio

sinc Sinc function

smoothdata* Smooth noisy data

snr* Signal-to-noise ratio

sos2tf Convert digital filter second-order section data to transfer function form
sosfilt Second-order (biquadratic) IIR digital filtering

spectrogram* Spectrogram using short-time Fourier transform

spline* Cubic spline data interpolation

square Square wave

statelevels State-level estimation for bilevel waveform with histogram method
std* Standard deviation

stft Short-time Fourier transform

stftmag2sig Signal reconstruction from STFT magnitude

tachorpm* Extract RPM signal from tachometer pulses

taylorwin Taylor window

tf2ss Convert transfer function filter parameters to state-space form
tfestimate* Transfer function estimate

tfridge* Time-frequency ridges

thd* Total harmonic distortion

toi* Third-order intercept point

triang Triangular window

tripuls Sampled aperiodic triangle

tsa* Time-synchronous signal average

tukeywin Tukey (tapered cosine) window

unwrap* Shift phase angles

upfirdn Upsample, apply FIR filter, and downsample

upsample Increase sample rate by integer factor

var* Variance

vmd* Variational mode decomposition

wvd* Wigner-Ville distribution and smoothed pseudo Wigner-Ville distribution
xcorr* Cross-correlation

xcorr2 2-D cross-correlation

Xcov Cross-covariance

xspectrogram* Cross-spectrogram using short-time Fourier transforms

Xwvd* Cross Wigner-Ville distribution and cross smoothed pseudo Wigner-Ville distribution
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yulewalk* Recursive digital filter design

Zp2ss Convert zero-pole-gain filter parameters to state-space form

zp2tf Convert zero-pole-gain filter parameters to transfer function form

10-8



Specifying Inputs in Code Generation from MATLAB

Specifying Inputs in Code Generation from MATLAB

In this section...

“Defining Input Size and Type” on page 10-9
“Inputs must be Constants” on page 10-10

Defining Input Size and Type

When you use Signal Processing Toolbox functions for code generation, you must define the size and
type of the function inputs. One way to do this is with the -args compilation option. The size and
type of inputs must be defined because C is a statically typed language. To illustrate the need to
define input size and type, consider the simplest call to xcorr requiring two input arguments. The
following demonstrates the differences in the use of xcorr in MATLAB and in Code Generation from
MATLAB.

Cross correlate two white noise vectors in MATLAB:

X = randn(512,1); %real valued white noise
y = randn(512,1); %real valued white noise
[C,lags] = xcorr(x,y);

X_circ = randn(256,1)+1j*randn(256,1); %circular white noise
y circ = randn(256,1)+1j*randn(256,1); %circular white noise
[C1,lagsl] = xcorr(x circ,y circ);

xcorr does not require the size and type of the input arguments. xcorr obtains this information at
runtime. Contrast this behavior with a MEX-file created with codegen. Create the file myxcorr.min
a folder where you have read and write permission. Ensure that this folder is in the MATLAB search
path. Copy and paste the following two lines of code into myxcorr.m and save the file. The compiler
tag %#codegen must be included in the file.

function [C,Lags]=myxcorr(x,y) S%#codegen
[C,Lags]=xcorr(x,y);

Enter the following command at the MATLAB command prompt:
codegen myxcorr -args {zeros(512,1),zeros(512,1)} -o myxcorr

Run the MEX-file:

X = randn(512,1); %real valued white noise
y = randn(512,1); %real valued white noise
[C,Lags] = myxcorr(x,y);

Define two new inputs x1 and y1 by transposing x and y.

x1
yl

x'; %x1 is 1x512
y'; %yl is 1x512

Attempt to rerun the MEX-file with the transposed inputs.
[C,Lags] = myxcorr(x1l,yl); %Errors

The preceding program errors with the message ?7?? MATLAB expression 'x' is not of the
correct size: expected [512x1] found [1x512].
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10-10

The error results because the inputs are specified to be 512x1 real-valued column vectors at
compilation. For complex-valued inputs, you must specify that the input is complex valued. For
example:

codegen myxcorr -o ComplexXcorr ...
-args {complex(zeros(512,1)),complex(zeros(512,1))}

Run the MEX-file at the MATLAB command prompt with complex-valued inputs of the correct size:

X_Ccirc randn(512,1)+1j*randn(512,1); %circular white noise
y circ randn(512,1)+1j*randn(512,1); %circular white noise
[C,Lags] = ComplexXcorr(x_circ,y circ);

Attempting to run ComplexXcorr with real valued inputs results in the error: ??? MATLAB
expression 'x' is not of the correct complexness.

Inputs must be Constants

For a number of supported Signal Processing Toolbox functions, the inputs or a subset of the inputs
must be specified as constants at compilation time. Use coder. Type with the -args compilation
option, or enter the constants directly in the source code.

Specifying inputs as constants at compilation time results in significant advantages in the speed and
efficiency of the generated code. For example, storing filter coefficients or window function values as
vectors in the C source code improves performance by avoiding costly computation at runtime.
Because a primary purpose of Code Generation from MATLAB is to generate optimized C code for
desktop and embedded systems, emphasis is placed on providing the user with computational savings
at runtime whenever possible.

To illustrate the constant input requirement with ellip, create the file myLowpassFilter.min a
folder where you have read and write permission. Ensure that this folder is in the MATLAB search
path. Copy and paste the following lines of code into myLowpassFilter.m and save the file.

function output = myLowpassFilter(input,N,Wn) S#codegen

[B,A] = ellip(N,Wn, 'low"');
output = filter(B,A,input);

If you have the MATLAB Coder software, enter the following command at the MATLAB command
prompt:

codegen mylLowpassFilter -o myLowpassFilter ...
-args {zeros(512,1),coder.newtype('constant',5),coder.newtype('constant',0.1)} -report

Once the program compiles successfully, the following message appears in the command window:
Code generation successful: View report.

Click on View report. Click on the C code tab on the top left and open the target source file
myLowpassFilter.c. The source code includes the numerator and denominator filter coefficients.

Run the MEX-file without entering the constants:

output = myLowpassFilter(randn(512,1));

If you attempt to run the MEX-file by inputting the constants, you receive the error ??? Error
using ==> mylLowpassFilter 1 input required for entry-point 'myLowpassFilter'.



Specifying Inputs in Code Generation from MATLAB

You may also enter the constants in the MATLAB source code directly. Edit the myLowPassFilter.m
file and replace the MATLAB code with the lines:

function output = mylLowpassFilter(input) S#codegen

[B,A] = ellip(5,0.1, 'low');

output = filter(B,A,input);

Enter the following command at the MATLAB command prompt:

codegen myLowpassFilter -args {zeros(512,1)} -o myLowpassFilter

Run the MEX-file by entering the following at the MATLAB command prompt:

output = myLowpassFilter(randn(512,1));
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Apply Lowpass Filter to Input Signal

Assuming a sample rate of 20 kHz, create a fourth-order Butterworth filter with a 3-dB frequency of
2.5 kHz. Filter coefficients for butter must be constants for code generation.

type ButterFilt
function output data=ButterFilt(input data) S%#codegen
[b,a]l=butter(4,0.25);

output data=filter(b,a,input_data);
end

Use the Butterworth filter to lowpass-filter a noisy sine wave.

t
X

transpose(linspace(0,pi,10000));
sin(t) + 0.03*randn(numel(t),1);

Filter the noisy sine wave using the Butterworth filter. Plot the filtered signal.

fx = ButterFilt(x);
plot(fx)
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Run the codegen command to obtain the C source code ButterFilt. c and MEX file:
codegen ButterFilt -args {zeros(10000,1)} -o ButterFilt mex -report

Code generation successful: To view the report, open('codegen\mex\ButterFilt\html\report.mldatx'
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The C source code includes the five numerator and denominator coefficients of the fourth-order
Butterworth filter as static constants. Apply the filter using the MEX-file. Plot the filtered signal.

output data = ButterFilt mex(x);
hold on

plot(output data)

hold off
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Zero-Phase Filtering

Design a lowpass Butterworth filter with a 1 kHz 3-dB frequency to implement zero-phase filtering on
data sampled at a rate of 20 kHz.

type myZerophaseFilt.m

function output = myZerophaseFilt(input) S%#codegen

[B,A] = butter(20,0.314);
output = filtfilt(B,A,input);

end

Use codegen to create the MEX file for myZerophaseFilt.m.
codegen myZerophaseFilt -args {zeros(1,20001)} -o myZerophaseFilt mex -report

Code generation successful: To view the report, open('codegen\mex\myZerophaseFilt\html\report.ml

Generate a noisy sinusoid signal as input to the filter.

Fs = 20000;

t =0:1/Fs:1;

comp500Hz = cos(2*pi*500*t);

signal = comp500Hz + sin(2*pi*4000*t) + 0.2*randn(size(t));

Filter input data using both MATLAB® and MEX functions.

FilteredData = myZerophaseFilt(signal);
MexFilteredData = myZerophaseFilt mex(signal);

Plot the 500 Hz component and the filtered data.

tms = t*1000;

plot(tms, comp500Hz)

hold on
plot(tms,MexFilteredData)
plot(tms,FilteredData)
hold off

xlabel('Milliseconds')
ylabel('Amplitude")

axis ([0 25 -1.8 1.8])

legend('500 Hz component', 'MEX', 'MATLAB')
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Compute Modified Periodogram Using Generated C Code

10-16

Create a function periodogram data.m that returns the modified periodogram power spectral
density (PSD) estimate of an input signal using a window. The function specifies a number of discrete
Fourier transform points equal to the length of the input signal.

type periodogram data

function [pxx,f] = periodogram data(inputData,window)
s#codegen

nfft = length(inputData);

[pxx,f] = periodogram(inputData,window,nfft);

end

Use codegen (MATLAB Coder) to generate a MEX function.
* The %#codegen directive in the function indicates that the MATLAB® code is intended for code
generation.

* The -args option specifies example arguments that define the size, class, and complexity of the
inputs to the MEX-file. For this example, specify inputData as a 1024-by-1 double precision
random vector and window as a Hamming window of length 1024. In subsequent calls to the MEX
function, use 1024-sample input signals and windows.

» If you want the MEX function to have a different name, use the - o option.

+ Ifyou want to view a code generation report, add the - report option at the end of the codegen
command.

codegen periodogram data -args {randn(1024,1),hamming(1024)}

Code generation successful.

Compute the PSD estimate of a 1024-sample noisy sinusoid using the periodogram function and the
MEX function you generated. Specify a sinusoid normalized frequency of 211/5 rad/sample and a Hann
window. Plot the two estimates to verify they coincide.

N = 1024;

X = 2¥cos(2*pi/5*(0:N-1)") + randn(N,1);
periodogram(x,hann(N))

[pxMex, fMex] = periodogram data(x,hann(N));

hold on
plot(fMex/pi,pow2db(pxMex),"':"', 'Color',[0 0.4 0])
hold off

grid on

legend('periodogram', '"MEX function')



Compute Modified Periodogram Using Generated C Code
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11 Convolution and Correlation

Linear and Circular Convolution

11-2

This example shows how to establish an equivalence between linear and circular convolution.

Linear and circular convolution are fundamentally different operations. However, there are conditions
under which linear and circular convolution are equivalent. Establishing this equivalence has
important implications. For two vectors, x and y, the circular convolution is equal to the inverse
discrete Fourier transform (DFT) of the product of the vectors' DFTs. Knowing the conditions under
which linear and circular convolution are equivalent allows you to use the DFT to efficiently compute
linear convolutions.

The linear convolution of an N-point vector, X, and an L-point vector, y, has length N + L - 1.

For the circular convolution of x and y to be equivalent, you must pad the vectors with zeros to length
at least N + L - 1 before you take the DFT. After you invert the product of the DFTs, retain only the
first N + L - 1 elements.

Create two vectors, x and y, and compute the linear convolution of the two vectors.

[2 12 1];
[12 3];
lin = conv(x,y);

X
y
c
The output has length 4+3-1.

Pad both vectors with zeros to length 4+3-1. Obtain the DFT of both vectors, multiply the DFTs, and
obtain the inverse DFT of the product.

xpad x zeros(1l,6-length(x))];
ypad y zeros(1,6-length(y))];
ccirc = ifft(fft(xpad).*fft(ypad));

= [
= [

The circular convolution of the zero-padded vectors, xpad and ypad, is equivalent to the linear
convolution of x and y. You retain all the elements of ccirc because the output has length 4+3-1.

Plot the output of linear convolution and the inverse of the DFT product to show the equivalence.

subplot(2,1,1)

stem(clin, 'filled')

ylim([0 111])

title('Linear Convolution of x and y')

subplot(2,1,2)

stem(ccirc, 'filled")

ylim([0 11])

title('Circular Convolution of xpad and ypad')



Linear and Circular Convolution

Linear Convolution of x and y

10 L ] b

Circular Convolution of xpad and ypad

10 L ] b

Pad the vectors to length 12 and obtain the circular convolution using the inverse DFT of the product
of the DFTs. Retain only the first 4+3-1 elements to produce an equivalent result to linear
convolution.

N = length(x)+length(y)-1;

xpad = [x zeros(1l,12-length(x))];
ypad = [y zeros(1l,12-length(y))];
ccirc = ifft(fft(xpad).*fft(ypad));
ccirc = ccirc(1:N);

The Signal Processing Toolbox™ software has a function, cconv, that returns the circular convolution
of two vectors. You can obtain the linear convolution of x and y using circular convolution with the
following code.

ccirc2 = cconv(x,y,6);

cconyv internally uses the same DFT-based procedure illustrated in the previous example.
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Confidence Intervals for Sample Autocorrelation

11-4

This example shows how to create confidence intervals for the autocorrelation sequence of a white
noise process. Create a realization of a white noise process with length L = 1000 samples. Compute
the sample autocorrelation to lag 20. Plot the sample autocorrelation along with the approximate
95%-confidence intervals for a white noise process.

Create the white noise random vector. Set the random number generator to the default settings for
reproducible results. Obtain the normalized sampled autocorrelation to lag 20.

rng default

L = 1000;

X = randn(L,1);

[xc,lags] = xcorr(x,20, ' 'coeff');

Create the lower and upper 95% confidence bounds for the normal distribution N(0, 1/L), whose

standard deviation is 1/,/L. For a 95%-confidence interval, the critical value is /2 erf_l(O .95)=1.96
and the confidence interval is

A=0=% 1'26 .
vcrit = sqrt(2)*erfinv(0.95)
verit = 1.9600
lconf = -verit/sqrt(L);

upconf = vcrit/sqrt(L);

Plot the sample autocorrelation along with the 95%-confidence interval.

stem(lags,xc, 'filled")

hold on

plot(lags, [lconf;upconf]l*ones(size(lags)),'r")

hold off

ylim([lconf-0.03 1.05])

title('Sample Autocorrelation with 95% Confidence Intervals')



Confidence Intervals for Sample Autocorrelation

Sample Autocorrelation with 95% Confidence Intervals
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You see in the above figure that the only autocorrelation value outside of the 95%-confidence interval
occurs at lag 0 as expected for a white noise process. Based on this result, you can conclude that the
data are a realization of a white noise process.
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Residual Analysis with Autocorrelation

This example shows how to use autocorrelation with a confidence interval to analyze the residuals of
a least-squares fit to noisy data. The residuals are the differences between the fitted model and the
data. In a signal-plus-white noise model, if you have a good fit for the signal, the residuals should be
white noise.

Create a noisy data set consisting of a 1st-order polynomial (straight line) in additive white Gaussian
noise. The additive noise is a sequence of uncorrelated random variables following a N(0,1)
distribution. This means that all the random variables have mean zero and unit variance. Set the
random number generator to the default settings for reproducible results.

= -3:0.01:3;
ng default

&
L
N
3
—
M3
Cad

Use polyfit to find the least-squares line for the noisy data. Plot the original data along with the
least-squares fit.

coeffs = polyfit(x,y,1);
yfit = coeffs(2)+coeffs(1l)*x;

plot(x,y)

hold on
plot(x,yfit, 'linewidth',?2)
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Find the residuals. Obtain the autocorrelation sequence of the residuals to lag 50.

residuals
[xc,lags]

y - yfit;
xcorr(residuals, 50, 'coeff');

When you inspect the autocorrelation sequence, you want to determine whether or not there is
evidence of autocorrelation. In other words, you want to determine whether the sample
autocorrelation sequence looks like the autocorrelation sequence of white noise. If the
autocorrelation sequence of the residuals looks like the autocorrelation of a white noise process, you
are confident that none of the signal has escaped your fit and ended up in the residuals. In this
example, use a 99%-confidence interval. To construct the confidence interval, you need to know the
distribution of the sample autocorrelation values. You also need to find the critical values on the
appropriate distribution between which lie 0.99 of the probability. Because the distribution in this
case is Gaussian, you can use complementary inverse error function, erfcinv. The relationship
between this function and the inverse of the Gaussian cumulative distribution function is described
on the reference page for erfcinv.

Find the critical value for the 99%-confidence interval. Use the critical value to construct the lower
and upper confidence bounds.

conf99 = sqrt(2)*erfcinv(2*.01/2);
lconf = -conf99/sqrt(length(x));
upconf = conf99/sqrt(length(x));

Plot the autocorrelation sequence along with the 99%-confidence intervals.
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11-8

figure

stem(lags,xc, 'filled")

ylim([lconf-0.03 1.05])

hold on

plot(lags,lconf*ones(size(lags)),'r', 'linewidth',2)
plot(lags,upconf*ones(size(lags)),'r', 'linewidth',2)
title('Sample Autocorrelation with 99% Confidence Intervals')

Sample Autocorrelation with 99% Confidence Intervals

10 . -
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Except at zero lag, the sample autocorrelation values lie within the 99%-confidence bounds for the
autocorrelation of a white noise sequence. From this, you can conclude that the residuals are white
noise. More specifically, you cannot reject that the residuals are a realization of a white noise process.

Create a signal consisting of a sine wave plus noise. The data are sampled at 1 kHz. The frequency of
the sine wave is 100 Hz. Set the random number generator to the default settings for reproducible
results.

Fs = 1000;

t =0:1/Fs:1-1/Fs;

rng default

X = CO0S(2*pi*100*t)+randn(size(t));

Use the discrete Fourier transform (DFT) to obtain the least-squares fit to the sine wave at 100 Hz.
The least-squares estimate of the amplitude is 2 / N times the DFT coefficient corresponding to 100
Hz, where N is the length of the signal. The real part is the amplitude of a cosine at 100 Hz and the
imaginary part is the amplitude of a sine at 100 Hz. The least-squares fit is the sum of the cosine and
sine with the correct amplitude. In this example, DFT bin 101 corresponds to 100 Hz.



Residual Analysis with Autocorrelation

xdft
ampes
xfit

fft(x);
= 2/length(x)*xdft(101);
real (ampest)*cos(2*pi*100*t)+imag(ampest)*sin(2*pi*100*t);

[ ||

figure

plot(t,x)

hold on

plot(t,xfit, 'linewidth"',?2)
axis ([0 0.30 -4 4])
xlabel('Seconds")
ylabel('Amplitude")

Amplitude

1] 0.05 0.1 0.15 0.2 0.25 0.3
Seconds

Find the residuals and determine the sample autocorrelation sequence to lag 50.

x-xfit;
xcorr(residuals,50, 'coeff');

residuals
[xc,lags]

Plot the autocorrelation sequence with the 99%-confidence intervals.
figure

stem(lags,xc, 'filled")

ylim([lconf-0.03 1.05])

hold on

plot(lags,lconf*ones(size(lags)),'r', 'linewidth',2)
plot(lags,upconf*ones(size(lags)),'r', 'linewidth"',2)
title('Sample Autocorrelation with 99% Confidence Intervals')
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Sample Autocorrelation with 99% Confidence Intervals
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Again, you see that except at zero lag, the sample autocorrelation values lie within the 99%-
confidence bounds for the autocorrelation of a white noise sequence. From this, you can conclude
that the residuals are white noise. More specifically, you cannot reject that the residuals are a
realization of a white noise process.

Finally, add another sine wave with a frequency of 200 Hz and an amplitude of 3/4. Fit only the sine
wave at 100 Hz and find the sample autocorrelation of the residuals.

X = X+3/4*sin(2*pi*200*t);

xdft = fft(x);

ampest = 2/length(x)*xdft(101);

xfit = real(ampest)*cos(2*pi*100*t)+imag(ampest)*sin(2*pi*100*t);
residuals x-xfit;

[xc,lags] xcorr(residuals, 50, 'coeff');

Plot the sample autocorrelation along with the 99%-confidence intervals.
figure

stem(lags,xc, 'filled")

ylim([lconf-0.12 1.05])

hold on

plot(lags,lconf*ones(size(lags)),'r', 'linewidth',2)
plot(lags,upconf*ones(size(lags)),'r', 'linewidth"',2)
title('Sample Autocorrelation with 99% Confidence Intervals')



Residual Analysis with Autocorrelation

Sample Autocorrelation with 99% Confidence Intervals
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In this case, the autocorrelation values clearly exceed the 99%-confidence bounds for a white noise
autocorrelation at many lags. Here you can reject the hypothesis that the residuals are a white noise
sequence. The implication is that the model has not accounted for all the signal and therefore the
residuals consist of signal plus noise.
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Autocorrelation of Moving Average Process

11-12

This example shows how to introduce autocorrelation into a white noise process by filtering. When we
introduce autocorrelation into a random signal, we manipulate its frequency content. A moving
average filter attenuates the high-frequency components of the signal, effectively smoothing it.

Create the impulse response for a 3-point moving average filter. Filter an N(0,1) white noise sequence
with the filter. Set the random number generator to the default settings for reproducible results.

h = 1/3*ones(3,1);
rng default

X = randn(1000,1);
y = filter(h,1,x);

Obtain the biased sample autocorrelation out to 20 lags. Plot the sample autocorrelation along with
the theoretical autocorrelation.

[xc,lags] = xcorr(y,20, 'biased');

Xc = zeros(size(xc));
Xc(19:23) = [1 2 3 2 11/9*var(x);

stem(lags,xc, 'filled")
hold on
stem(lags,Xc,'.", 'linewidth"',2)

1g = legend('Sample autocorrelation', 'Theoretical autocorrelation');
lg.Location = 'NorthEast';
1g.Box = 'off"';



Autocorrelation of Moving Average Process
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The sample autocorrelation captures the general form of the theoretical autocorrelation, even though
the two sequences do not agree in detail.

In this case, it is clear that the filter has introduced significant autocorrelation only over lags [-2,2].
The absolute value of the sequence decays quickly to zero outside of that range.

To see that the frequency content has been affected, plot Welch estimates of the power spectral
densities of the original and filtered signals.

[pxx,wx] = pwelch(x);
[pyy,wyl = pwelch(y);
figure

plot(wx/pi,20*1ogl0O(pxx),wy/pi,20*1ogle(pyy))

1g = legend('Original sequence','Filtered sequence');
1g.Location = 'SouthWest';

xlabel('Normalized Frequency (\times\pi rad/sample)')
ylabel('Power/frequency (dB/rad/sample)')
title('Welch Power Spectral Density Estimate')

grid
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Welch Power Spectral Density Estimate
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The white noise has been "colored" by the moving average filter.

See Also

External Websites
Ellis, Dan. About Colored Noise. https://www.ee.columbia.edu/~dpwe/noise/
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Cross-Correlation of Two Moving Average Processes

Cross-Correlation of Two Moving Average Processes

This example shows how to find and plot the cross-correlation sequence between two moving average
processes. The example compares the sample cross-correlation with the theoretical cross-correlation.
Filter an N(0, 1) white noise input with two different moving average filters. Plot the sample and
theoretical cross-correlation sequences.

Create an N(0, 1) white noise sequence. Set the random number generator to the default settings for
reproducible results. Create two moving average filters. One filter has impulse response
6(n) + 6(n — 1). The other filter has impulse response 6(n) — 6(n — 1).

rng default

w = randn(100,1);
x = filter([1 1],1,w);
y = filter([1 -11,1,w);

Obtain the sample cross-correlation sequence up to lag 20. Plot the sample cross-correlation along
with the theoretical cross-correlation.

[xc,lags] = xcorr(x,y,20, " 'biased');
Xc = zeros(size(xc));

Xc(20)
Xc(22)

1;

stem(lags,xc, 'filled")
hold on
stem(lags,Xc,'."', 'linewidth"',2)

g = legend('Sample cross-correlation', 'Theoretical cross-correlation');
g.Location "NorthWest';

g.FontSize = 9;

gq.Box = 'off';
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The theoretical cross-correlation is —1 at lag —1, 1 at lag 1, and zero at all other lags. The sample
cross-correlation sequence approximates the theoretical cross-correlation.

As expected, there is not perfect agreement between the theoretical cross-correlation and sample
cross-correlation. The sample cross-correlation does accurately represent both the sign and
magnitude of the theoretical cross-correlation sequence values at lag —1 and lag 1.



Cross-Correlation of Delayed Signal in Noise

Cross-Correlation of Delayed Signal in Noise

This example shows how to use the cross-correlation sequence to detect the time delay in a noise-
corrupted sequence. The output sequence is a delayed version of the input sequence with additive
white Gaussian noise. Create two sequences. One sequence is a delayed version of the other. The

delay is 3 samples. Add N(0,0. 32) white noise to the delayed signal. Use the sample cross-correlation
sequence to detect the lag.

Create and plot the signals. Set the random number generator to the default settings for reproducible
results.

rng default

X
y

triang(20);
[zeros(3,1);x]+0.3*randn(length(x)+3,1);

subplot(2,1,1)

stem(x, 'filled")
axis([0 22 -1 2])
title('Input Sequence')

subplot(2,1,2)

stem(y, 'filled")

axis([0 22 -1 2])
title('Output Sequence')

2 Input Sequence

Loesrtt T 00000,

2 Qutput Sequence
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Obtain the sample cross-correlation sequence and use the maximum absolute value to estimate the
lag. Plot the sample cross-correlation sequence. The maximum cross correlation sequence value
occurs at lag 3, as expected.

[xc,lags] = xcorr(y,x);
[~,I] = max(abs(xc));

figure

stem(lags,xc, 'filled")

hold on

stem(lags(I),xc(I), 'filled")
hold off

legend(["Cross-correlation”,sprintf('Maximum at lag %d',lags(I))])

10 T T T T T T T T T

—® Cross-correlation
g9r e ® Maximum at lag 3| 7

RE—) Moas

-25 20 15  -10 -5 0 5 10 15 20 25

Confirm the result using the finddelay function.
finddelay(x,y)

ans = 3

See Also
finddelay | xcorr
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Cross-Correlation of Phase-Lagged Sine Wave

Cross-Correlation of Phase-Lagged Sine Wave

This example shows how to use the cross-correlation sequence to estimate the phase lag between two
sine waves. The theoretical cross-correlation sequence of two sine waves at the same frequency also
oscillates at that frequency. Because the sample cross-correlation sequence uses fewer and fewer
samples at larger lags, the sample cross-correlation sequence also oscillates at the same frequency,
but the amplitude decays as the lag increases.

Create two sine waves with frequencies of 211/10 rad/sample. The starting phase of one sine wave is

0, while the starting phase of the other sine wave is —m radians. Add N(0, 0. 252) white noise to the
sine wave with the phase lag of  radians. Set the random number generator to the default settings
for reproducible results.

rng default

t = 0:99;
X = €0s(2*pi*1/10%*t);
y = cos(2*pi*1/10*t-pi)+0.25*randn(size(t));

Obtain the sample cross-correlation sequence for two periods of the sine wave (10 samples). Plot the
cross-correlation sequence and mark the known lag between the two sine waves (5 samples).

[xc,lags] = xcorr(y,x,20, coeff');
stem(lags(21:end),xc(21l:end), ' filled")

hold on
plot([5 5],[-1 1])

ax = gca;
ax.XTick = 0:5:20;
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You see that the cross-correlation sequence peaks at lag 5 as expected and oscillates with a period of
10 samples.

See Also
Xcorr
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Multirate Signal Processing

* “Downsampling — Signal Phases” on page 12-2

* “Downsampling — Aliasing” on page 12-5

* “Filtering Before Downsampling” on page 12-9

* “Upsampling — Imaging Artifacts” on page 12-11

» “Filtering After Upsampling — Interpolation” on page 12-13
* “Simulate a Sample-and-Hold System” on page 12-15

* “Change Signal Sample Rate” on page 12-20
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Downsampling — Signal Phases

12-2

This example shows how to use downsample to obtain the phases of a signal. Downsampling a signal
by M can produce M unique phases. For example, if you have a discrete-time signal, x, with x(0) x(1)
x(2) x(3), ..., the M phases of x are x(nM + k) with k = 0,1, ..., M-1.

The M signals are referred to as the polyphase components of x.

Create a white noise vector and obtain the 3 polyphase components associated with downsampling by
3.

Reset the random number generator to the default settings to produce a repeatable result. Generate
a white noise random vector and obtain the 3 polyphase components associated with downsampling
by 3.

rng default

X = randn(36,1);

x0 downsample(x,3,0);
x1 downsample(x,3,1);
X2 downsample(x,3,2);

The polyphase components have length equal to 1/3 the original signal.

Upsample the polyphase components by 3 using upsample.

y0 = upsample(x0,3,0);
yl = upsample(x1,3,1);
y2 = upsample(x2,3,2);

Plot the result.

subplot(4,1,1)

stem(x, 'Marker', "none')
title('Original Signal')
ylim([-4 4])

subplot(4,1,2)

stem(y0, 'Marker', 'none")
ylabel('Phase 0')
ylim([-4 4])

subplot(4,1,3)

stem(yl, 'Marker', 'none")
ylabel('Phase 1')
ylim([-4 41])

subplot(4,1,4)

stem(y2, 'Marker', 'none")
ylabel('Phase 2')
ylim([-4 4])
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If you sum the upsampled polyphase components you obtain the original signal.

Create a discrete-time sinusoid and obtain the 2 polyphase components associated with
downsampling by 2.

Create a discrete-time sine wave with an angular frequency of 7/ rad/sample. Add a DC offset of 2
to the sine wave to help with visualization of the polyphase components. Downsample the sine wave
by 2 to obtain the even and odd polyphase components.

n = 0:127;

X = 2+cos(pi/4*n);

x0 = downsample(x,2,0);
x1 = downsample(x,2,1);

Upsample the two polyphase components.

upsample(x0,2,0);
upsample(x1,2,1);

yo
yl

Plot the upsampled polyphase components along with the original signal for comparison.
subplot(3,1,1)
stem(x, 'Marker', "'none")

ylim([0.5 3.5])
title('Original Signal')

subplot(3,1,2)
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stem(y0, 'Marker', 'none")
ylim([0.5 3.5])
ylabel('Phase 0')

subplot(3,1,3)

stem(yl, 'Marker', 'none")
ylim([0.5 3.5])
ylabel('Phase 1'")
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If you sum the two upsampled polyphase components (Phase 0 and Phase 1), you obtain the original
sine wave.

See Also
downsample | upsample
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Downsampling — Aliasing

This example shows how to avoid aliasing when downsampling a signal. If a discrete-time signal's
baseband spectral support is not limited to an interval of width 2/M radians, downsampling by M
results in aliasing. Aliasing is the distortion that occurs when overlapping copies of the signal's
spectrum are added together. The more the signal's baseband spectral support exceeds 2r/M
radians, the more severe the aliasing. Demonstrate aliasing in a signal downsampled by two. The
signal's baseband spectral support exceed i radians in width.

Create a signal with baseband spectral support equal to 31/2 radians. Use fir2 to design the signal.
Plot the signal's spectrum. The signal's baseband spectral support exceeds [ — /2, m/2].

f = [0 0.2500 0.5000 0.7500 1.0000];
a=[1.00 0.6667 0.3333 0 0];

nf = 512;

bl = fir2(nf-1,f,a);

Hx = fftshift(freqz(bl,1,nf, 'whole'));

omega = -pi:2*pi/nf:pi-2*pi/nf;
plot(omega/pi,abs(Hx))

grid

xlabel('\times\pi rad/sample")
ylabel('Magnitude')
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Downsample the signal by a factor of 2 and plot the downsampled signal's spectrum with the
spectrum of the original signal. In addition to an amplitude scaling of the spectrum, the superposition
of overlapping spectral replicas causes distortion of the original spectrum for |w| > m/2.

y = downsample(bl,2,0);
Hy = fftshift(freqz(y,1,nf, 'whole'));

hold on

plot(omega/pi,abs(Hy))

hold off

legend('Original', 'Downsampled')

text(2.5/pi*[-1 1]1,0.35*[1 1],{'\downarrow Aliasing', 'Aliasing \downarrow'},
'HorizontalAlignment', 'center"')
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Increase the baseband spectral support of the signal to [ — 71/8, 7r1/8] and downsample the signal by
2. Plot the original spectrum along with the spectrum of the downsampled signal. The increased
spectral width results in more pronounced aliasing in the spectrum of the downsampled signal
because more signal energy is outside [ — /2, 1/2].

f =10 0.2500 0.5000 0.7500 7/8 1.0000];
a = [1.00 0.7143 0.4286 0.1429 0 0];

b2 = fir2(nf-1,f,a);

Hx = fftshift(freqz(b2,1,nf, 'whole'));

plot(omega/pi,abs(Hx))
grid
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xlabel('\times\pi rad/sample')
ylabel('Magnitude")

y = downsample(b2,2,0);
Hy = fftshift(freqz(y,1,nf, 'whole'));

hold on

plot(omega/pi,abs(Hy))

hold off

legend('Original', 'Downsampled')
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Finally, construct a signal with baseband spectral support limited to [ — /2, m/2]. Downsample the
signal by a factor of 2 and plot the spectrum of the original and downsampled signals. The
downsampled signal is full band. The spectrum of the downsampled signal is a stretched and scaled
version of the original spectrum, but the shape is preserved because the spectral copies do not
overlap. There is no aliasing.

f = [0 0.250 0.500 0.7500 1];

a = [1.0000 0.5000 0 0 0];

b3 = fir2(nf-1,f,a);

Hx = fftshift(freqz(b3,1,nf, 'whole'));

plot(omega/pi,abs(Hx))

grid

xlabel('\times\pi rad/sample')
ylabel('Magnitude")
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y = downsample(b3,2,0);
Hy = fftshift(freqz(y,1,nf, 'whole'));

hold on

plot(omega/pi,abs(Hy))

hold off

legend('Original', 'Downsampled')
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See Also
downsample | fir2 | freqz
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Filtering Before Downsampling

Filtering Before Downsampling

This example shows how to filter before downsampling to mitigate the distortion caused by aliasing.
You can use decimate or resample to filter and downsample with one function. Alternatively, you
can lowpass filter your data and then use downsample. Create a signal with baseband spectral
support greater than r radians. Use decimate to filter the signal with a 10th-order Chebyshev type I
lowpass filter prior to downsampling.

Create the signal and plot the magnitude spectrum.

f = [0 0.2500 0.5000 0.7500 1.0000];
a = [1.00 0.6667 0.3333 0 0];
nf = 512;

b = fir2(nf-1,f,a);
Hx = fftshift(freqz(b,1,nf, whole'));

omega = -pi:2*pi/nf:pi-2*pi/nf;
plot(omega/pi,abs(Hx))

grid

xlabel('\times\pi rad/sample')
ylabel('Magnitude")
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Filter the signal with a 10th-order type I Chebyshev lowpass filter and downsample by 2. Plot the
magnitude spectra of the original signal along with the filtered and downsampled signal. The lowpass
filter reduces the amount of aliasing distortion outside the interval [ — /2, 1/2].
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12 wultirate Signal Processing

y = decimate(b,2,10);
Hy = fftshift(freqz(y,1,nf, 'whole'));

hold on
plot(omega/pi,abs(Hy))
legend('Original', 'Downsampled')
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See Also
decimate | fir2 | freqz
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Upsampling — Imaging Artifacts

Upsampling — Imaging Artifacts

This example shows how to upsample a signal and how upsampling can result in images. Upsampling
a signal contracts the spectrum. For example, upsampling a signal by 2 results in a contraction of the
spectrum by a factor of 2. Because the spectrum of a discrete-time signal is 2r-periodic, contraction
can cause replicas of the spectrum normally outside of the baseband to appear inside the interval

[ —m ol

Create a discrete-time signal whose baseband spectral support is [ — 1, 17]. Plot the magnitude

spectrum.
f = 1[0 0.250 0.500 0.7500 1];
a =[1.0000 0.5000 0 0 0];

nf = 512;
b = fir2(nf-1,f,a);
Hx = fftshift(freqz(b,1,nf, whole'));

omega = -pi:2*pi/nf:pi-2*pi/nf;
plot(omega/pi,abs(Hx))

grid

xlabel('\times\pi rad/sample')
ylabel('Magnitude")
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Upsample the signal by 2. Plot the spectrum of the upsampled signal. The contraction of the spectrum
has drawn subsequent periods of the spectrum into the interval [ — m, m].
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12 wultirate Signal Processing

y = upsample(b,2);
Hy = fftshift(freqz(y,1,nf, whole'));

hold on

plot(omega/pi,abs(Hy))
hold off

legend('Original', 'Upsampled')

text(0.65*[-1 1]1,0.45*[1 1], ["\leftarrow Imaging" "Imaging \rightarrow"],
'HorizontalAlignment', 'center')
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See Also
fir2 | freqz | upsample
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Filtering After Upsampling — Interpolation

Filtering After Upsampling — Interpolation

This example shows how to upsample a signal and apply a lowpass interpolation filter with interp.
Upsampling by L inserts L - 1 zeros between every element of the original signal. Upsampling can
create imaging artifacts. Lowpass filtering following upsampling can remove these imaging artifacts.
In the time domain, lowpass filtering interpolates the zeros inserted by upsampling.

Create a discrete-time signal whose baseband spectral support is [ — 11/2, 1/2]. Plot the magnitude
spectrum.

f
a

[0 0.250 0.500 0.7500 1];
[1.0000 0.5000 0 0 0];

nf = 512;
b = fir2(nf-1,f,a);
Hx = fftshift(freqz(b,1,nf, whole'));

omega = -pi:2*pi/nf:pi-2*pi/nf;
plot(omega/pi,abs(Hx))

grid

xLlabel('\times\pi rad/sample')
ylabel('Magnitude")
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Upsample the signal and apply a lowpass filter to remove the imaging artifacts. Plot the magnitude
spectrum. Upsampling still contracts the spectrum, but the imaging artifacts are removed by the
lowpass filter.
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12 wultirate Signal Processing

y = interp(b,2);
Hy = fftshift(freqz(y,1,nf, whole'));

hold on

plot(omega/pi,abs(Hy))

hold off

legend('Original', 'Upsampled')
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See Also
fir2 | freqz | interp
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Simulate a Sample-and-Hold System

Simulate a Sample-and-Hold System

This example shows several ways to simulate the output of a sample-and-hold system by upsampling
and filtering a signal.

Construct a sinusoidal signal. Specify a sample rate such that 16 samples correspond to exactly one
signal period. Draw a stem plot of the signal. Overlay a stairstep graph for sample-and-hold

visualization.
fs = 16;
t =0:1/fs:1-1/fs;
X = .9%sin(2*pi*t);
stem(t, x)
hold on
stairs(t,x)
hold off
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Upsample the signal by a factor of four. Plot the result alongside the original signal. upsample
increases the sample rate of the signal by adding zeros between the existing samples.

ups = 4;
fu = fs*ups;
tu=0:1/fu:1-1/fu;
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12 wultirate Signal Processing

y = upsample(x,ups);
stem(tu,y, '--x")
hold on

stairs(t,x)
hold off

0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1

Filter with a moving-average FIR filter to fill in the zeros with sample-and-hold values.

h = ones(ups,1);

z = filter(h,1,y);
stem(tu,z,'--.")
hold on
stairs(t,x)

hold off
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You can obtain the same behavior using the MATLAB® function interpl with nearest-neighbor
interpolation. In that case, you must shift the origin to line up the sequence.

zi = interpl(t,x,tu, 'nearest');

dl = floor(ups/2);
stem(tu(l+dl:end),zi(1l:end-dl),"'--.")
hold on

stairs(t,x)
hold off
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The function resample produces the same result when you set the last input argument to zero.
g = resample(x,ups,1,0);

stem(tu(l+dl:end),q(l:end-dl),"'--.")

hold on

stairs(t,x)
hold off
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See Also
resample | upsample
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Change Signal Sample Rate

This example shows how to change the sample rate of a signal. The example has two parts. Part one
changes the sample rate of a sinusoidal input from 44.1 kHz to 48 kHz. This workflow is common in
audio processing. The sample rate used on compact discs is 44.1 kHz, while the sample rate used on
digital audio tape is 48 kHz. Part two changes the sample rate of a recorded speech sample from
7418 Hz to 8192 Hz.

Create an input signal consisting of a sum of sine waves sampled at 44.1 kHz. The sine waves have
frequencies of 2, 4, and 8 kHz.

= 44.1e3;
0:1/Fs:1-1/Fs;
COS(2*pi*2000*t) + 1/2*sin(2*pi*4000*(t-pi/4)) + ...
1/4*cos (2*pi*8000*t) ;

Fs
t
X

To change the sample rate from 44.1 to 48 kHz, you have to determine a rational number (ratio of
integers), P/Q, such that P/Q times the original sample rate, 44100, is equal to 48000 within some
specified tolerance.

To determine these factors, use rat. Input the ratio of the new sample rate, 48000, to the original
sample rate, 44100.

[P,Q] = rat(48e3/Fs);
abs (P/Q*Fs-48000)

ans = 7.2760e-12

You see that P/Q*Fs only differs from the desired sample rate, 48000, on the order of 10712,

Use the numerator and denominator factors obtained with rat as inputs to resample to output a
waveform sampled at 48 kHz.

xnew = resample(x,P,Q);

If your computer can play audio, you can play the two waveforms. Set the volume to a comfortable
level before you play the signals. Execute the sound commands separately so that you can hear the
signal with the two different sample rates.

% sound(x,44100)
% sound(xnew,48000)

Change the sample rate of a speech sample from 7418 Hz to 8192 Hz. The speech signal is a
recording of a speaker saying "MATLAB®".

Load the speech sample.

load mtlb

Loading the file mt1b.mat brings the speech signal, mt1lb, and the sample rate, Fs, into the MATLAB
workspace.

Determine a rational approximation to the ratio of the new sample rate, 8192, to the original sample
rate. Use rat to determine the approximation.

[P,Q] = rat(8192/Fs);
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Resample the speech sample at the new sample rate. Plot the two signals.
mtlb new = resample(mtlb,P,Q);

subplot(2,1,1)
plot((0:length(mtlb)-1)/Fs,mtlb)
subplot(2,1,2)

plot((0:length(mtlb _new)-1)/(P/Q*Fs),mtlb _new)
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If your computer has audio output capability, you can play the two waveforms at their respective
sample rates for comparison. Set the volume on your computer to a comfortable listening level before
playing the sounds. Execute the sound commands separately to compare the speech samples at the
different sample rates.

% sound(mtlb,Fs)
% sound(mtlb _new,8192)

See Also
resample
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“Power Spectral Density Estimates Using FFT” on page 13-2
“Bias and Variability in the Periodogram” on page 13-9

“Cross Spectrum and Magnitude-Squared Coherence” on page 13-17
“Amplitude Estimation and Zero Padding” on page 13-20
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“Measure Mean Frequency, Power, Bandwidth” on page 13-38
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13 Spectral Analysis

Power Spectral Density Estimates Using FFT

13-2

This example shows how to obtain nonparametric power spectral density (PSD) estimates equivalent
to the periodogram using fft. The examples show you how to properly scale the output of fft for
even-length inputs, for normalized frequency and hertz, and for one- and two-sided PSD estimates.

Even-Length Input with Sample Rate

Obtain the periodogram for an even-length signal sampled at 1 kHz using both fft and
periodogram. Compare the results.

Create a signal consisting of a 100 Hz sine wave in N(0,1) additive noise. The sampling frequency is 1
kHz. The signal length is 1000 samples. Use the default settings of the random number generator for
reproducible results.

rng default
Fs = 1000;
t =0:1/Fs:1-1/Fs;

X = C0S(2*pi*100*t) + randn(size(t));

Obtain the periodogram using fft. The signal is real-valued and has even length. Because the signal
is real-valued, you only need power estimates for the positive or negative frequencies. In order to
conserve the total power, multiply all frequencies that occur in both sets — the positive and negative
frequencies — by a factor of 2. Zero frequency (DC) and the Nyquist frequency do not occur twice.
Plot the result.

N = length(x);
xdft = fft(x);

xdft = xdft(1:N/2+1);

psdx = (1/(Fs*N)) * abs(xdft)."2;
psdx(2:end-1) = 2*psdx(2:end-1);
freq = 0:Fs/length(x):Fs/2;

plot(freq,10*loglO(psdx))

grid on

title('Periodogram Using FFT')
xlabel('Frequency (Hz)"')
ylabel('Power/Frequency (dB/Hz)")
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Periodogram Using FFT

Fower/Frequency (dB/Hz)
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Compute and plot the periodogram using periodogram. Show that the two results are identical.

periodogram(x, rectwin(length(x)),length(x),Fs)
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Periodogram Power Spectral Density Estimate
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mxerr = max(psdx'-periodogram(x,rectwin(length(x)),length(x),Fs))
mxerr = 3.4694e-18

Input with Normalized Frequency

Use fft to produce a periodogram for an input using normalized frequency. Create a signal
consisting of a sine wave in N(0,1) additive noise. The sine wave has an angular frequency of 17/4 rad/
sample. Use the default settings of the random number generator for reproducible results.

rng default
n = 0:999;
X = cos(pi/4*n) + randn(size(n));

Obtain the periodogram using fft. The signal is real-valued and has even length. Because the signal
is real-valued, you only need power estimates for the positive or negative frequencies. In order to
conserve the total power, multiply all frequencies that occur in both sets — the positive and negative
frequencies — by a factor of 2. Zero frequency (DC) and the Nyquist frequency do not occur twice.
Plot the result.

N = length(x);

xdft = fft(x);

xdft = xdft(1:N/2+1);

psdx = (1/(2*pi*N)) * abs(xdft).”2;
psdx(2:end-1) = 2*psdx(2:end-1);
freq = 0:(2*pi)/N:pi;



Power Spectral Density Estimates Using FFT

plot(freq/pi,10*loglO(psdx))

grid on

title('Periodogram Using FFT")

xlabel('Normalized Frequency (\times\pi rad/sample)')
ylabel('Power/Frequency (dB/rad/sample)')

Periodogram Using FFT
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Compute and plot the periodogram using periodogram. Show that the two results are identical.

periodogram(x, rectwin(length(x)),length(x))
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Periodogram Power Spectral Density Estimate
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mxerr = max(psdx'-periodogram(x,rectwin(length(x)),length(x)))
mxerr = 1.4211e-14
Complex-Valued Input with Normalized Frequency

Use fft to produce a periodogram for a complex-valued input with normalized frequency. The signal
is a complex exponential with an angular frequency of /4 rad/sample in complex-valued N(0,1) noise.
Set the random number generator to the default settings for reproducible results.

rng default
n 0:999;
x = exp(1j*pi/4*n) + [1 1j]1*randn(2,length(n))/sqrt(2);

Use fft to obtain the periodogram. Because the input is complex-valued, obtain the periodogram
from [0, 2m) rad/sample. Plot the result.

N = length(x);

xdft = fft(x);
psdx = (1/(2*pi*N)) * abs(xdft)."2;
freq = 0:(2*pi)/N:2*pi-(2*pi)/N;

plot(freq/pi,10*loglO(psdx))

grid on

title('Periodogram Using FFT')

xlabel('Normalized Frequency (\times\pi rad/sample)')
ylabel('Power/Frequency (dB/rad/sample)')
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Periodogram Using FFT
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Use periodogram to obtain and plot the periodogram. Compare the PSD estimates.

periodogram(x, rectwin(length(x)),length(x), 'twosided")
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Periodogram Power Spectral Density Estimate
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mxerr = max(psdx'-periodogram(x,rectwin(length(x)),length(x), 'twosided'))

mxerr = 4.4409e-16

See Also

Apps
Signal Analyzer

Functions
fft | periodogram | pspectrum
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Bias and Variability in the Periodogram

This example shows how to reduce bias and variability in the periodogram. Using a window can
reduce the bias in the periodogram, and using windows with averaging can reduce variability.

Use wide-sense stationary autoregressive (AR) processes to show the effects of bias and variability in
the periodogram. AR processes present a convenient model because their PSDs have closed-form
expressions. Create an AR(2) model of the following form:

y(n)—=0.75y(n—-1)+ 0.5y(n - 2) = g(n),

where £(n) is a zero mean white noise sequence with some specified variance. In this example,
assume the variance and the sampling period to be 1. To simulate the preceding AR(2) process,
create an all-pole (IIR) filter. View the filter's magnitude response.

B2 = 1;
A2 = [1 -0.75 0.51;
fvtool(B2,A2)
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This process is bandpass. The dynamic range of the PSD is approximately 14.5 dB, as you can
determine with the following code.

[H2,W2] = freqz(B2,A2,1e3,1);
dr2 = max(20*logl@(abs(H2)))-min(20*1ogl0(abs(H2)))

dr2 = 14.4984
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By examining the placement of the poles, you see that this AR(2) process is stable

inside the unit circle.

fvtool(B2,A2, 'Analysis', 'polezero')
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Next, create an AR(4) process described by the following equation:

. The two poles are

y(n) —2.7607y(n — 1) + 3.8106y(n — 2) — 2.6535y(n — 3) + 0.9238y(n — 4) = &(n).

Use the following code to view